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Welcome

Welcome

Welcome to the mc²56 MKII Technical Manual.

About this Manual

This documentation covers the installation, configuration and service/maintenance of the mc²56 MKII. The

specification is valid for mc2 Version 5.10.2.x.

For more on operation, please see the "mc²56 MKII Operators Manual". All Lawo manuals are available from the
Download-Center at www.lawo.com (after Login).

Look out for the following which indicate:

Notes - points of clarification.

Tips - useful tips and short cuts.

Warnings

Alert you when an action should always be observed.

Software Updates

Lawo employ an ongoing development programme and offer free-of-charge software updates for all mc2/Nova
products. Releases can be downloaded from the Lawo website (after Login).

Utility Software Applications

The mxGUI installer is free to download from the Lawo website (after Login). Once installed, you can launch all
utility software applications including:

· mxGUI - for offline setup or remote operation of the console.

· AdminHD - to edit the system configuration.

· CFCard Creator - to create backup CF Cards for the control system and, in a console, the bay server(s).

· mxUpdater - to update the software of the mc2/Nova control system, or backup and restore user data.

Lawo User Registration

For access to the Download-Center and to receive regular product updates, please register at:

www.lawo.com/user-registration.

Additional Information

The "mc2_documentation" contains mechanical drawings, data sheets and further information on all system

components. This resource is included with the current mc2_56 software release, available from the Download-
Center at www.lawo.com (after Login).

We also recommend that you carefully observe the release notes delivered with your system. 

http://www.lawo.com
http://www.lawo.com/user-registration
http://www.lawo.com
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Important Safety Instructions

General Safety

Warning

Exposure to excessive sound pressure levels can lead to impaired hearing and cause damage to the ear.

Please read and observe ALL of the following notes:

· Check all of the hardware devices for transport damage. 

· Any devices showing signs of mechanical damage or damage from the spillage of liquids MUST NOT
be connected to the mains supply or disconnected from the mains immediately by pulling out the
power lead.

· All devices MUST be grounded. Grounding connectors are provided on all devices. In addition, all
low-voltage devices external to the system must also be grounded before operation.

· For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the device from
being grounded through Ethernet or other signal connections.

· Do NOT use the system at extreme temperatures - observe the temperature range and humidity
specified in the installation instructions.

· Do NOT expose devices to liquids which may drip or splash. 

· Do NOT place objects filled with liquids, such as vases, upon a device.

· Only service staff may replace batteries.

· CAUTION: Danger of explosion if battery is incorrectly replaced - Replace only with the same or
equivalent type.

Servicing of components inside a device MUST only be carried out by qualified service personnel according
to the following guidelines:

· Before removing parts of the casing, shields, etc. the device MUST be switched off and disconnected
from all mains.

· Before opening a device, the power supply capacitor MUST be discharged with a suitable resistor.

· Components that carry heavy electrical loads, such as power transistors and resistors, should NOT
be touched until cool to avoid burns.

Servicing unprotected powered devices may only be carried out by qualified service personnel at their own
risk. The following instructions MUST be observed:

· NEVER touch bare wires or circuitry.

· Use insulated tools ONLY.

· DO NOT touch metal semi-conductor casings as they can bear high voltages.

Eye Safety

Warning

This equipment may use Class 1 Laser products which emit invisible laser radiation that may lead to eye
injury.

· NEVER look directly into optical components or optical fibre cables.

· Fit protection caps to close any unused optical components.

· Connect all optical fibre cables BEFORE turning on the equipment.
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Defective Parts/Modules

Warning

mc²56 MKII contains no user-serviceable parts. Therefore DO NOT open the devices other than to perform
the procedures described in this manual.

In the event of a hardware defect, please send the system component to your local service representative
together with a detailed description of the fault. We would like to remind you to please check carefully
whether the failure is caused by erroneous configuration, operation or connection before sending parts for
repair. Please contact our service department before sending parts for repair.

First Aid (in the case of electric shock)

Warning

DO NOT touch the person or his/her clothing before power is turned off, otherwise you risk sustaining an
electric shock yourself.

Separate the person as quickly as possible from the electric power source as follows:

· Switch off the equipment.

· Unplug or disconnect the mains cable.

· Move the person away from the power source by using dry insulating material (such as wood or
plastic).

If the person is unconscious:

· Check their pulse and reanimate if their respiration is poor.

· Lay the body down and turn it to one side. Call for a doctor immediately.

Having sustained an electric shock, ALWAYS consult a doctor.
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Chapter 1: Technical Overview

Chapter 1: Technical Overview

This chapter introduces the technical components of the mc²56 MKII system:

· Hardware Components

· RAVENNA Interfaces

· Redundancy

· Sample Rate & System Clock

· Networking I/O Resources

· IP-SHARE Gain Compensation

· Configuration

· System Options
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Hardware Components

The mc²56 MKII consists of three principal components:

· Console control surface - with integrated power supplies and local I/O connections.

· Nova73 – with Router Modules, DSP boards and AES, MADI, RAVENNA or DANTE I/O. Available in two
sizes: Nova73 HD (10RU) or Nova73 Compact (7RU).

· DALLIS or Compact I/O – offering further I/O breakout options. DALLIS frames can be fitted with a
choice of I/O cards and connect to the Nova73 via MADI or RAVENNA. The Compact I/O is a 5RU
stagebox with a fixed amount of I/O; it connects to the Nova73 via RAVENNA Link.

The exact hardware specification defines how many analogue and digital connections are available for external
equipment, and how much DSP processing is available for input channels, monitor return channels, groups, sums
and auxiliary sends.

From Version 5.4 onwards, two identical control surfaces can connect to the same Nova73 in order to mirror
each other - for example, in a theatre you can install one surface in the auditorium and the other in a
separate control room to facilitate mixing from two different locations. The surfaces MUST be from the same

console family (either mc256 OR mc266), but different frame sizes are possible. For more details, see
Installing a Mirror Desk.
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Console Control Surface

The mc²56 MKII control surface is constructed in 16-fader sections, with frame sizes scaling from 16 faders up to
80 faders. you can add 16-fader extenders to expand the number of fader strips.

A range of console options offer wide (studio) or narrow (OB) side panels, table-top or stand mounting, overbridge
metering, etc.

Control surface power is provided by internal power supplies, with n+1 redundancy and two mains connections for
phase redundancy. PSU status can be monitored from the console GUI.

All application software and user data is handled by the control system, located on the Router Module MKII within
the Nova73. The surface connects to the Nova73 via TCP/IP Ethernet; if a redundant Router Module is fitted, then
main and backup connections can be installed.

The control surface also houses a local I/O board, for monitoring, metering, talkback and headphones. This is
available in two versions, connecting to the Nova73 via either MADI or RAVENNA.

As the control system is integrated within the Nova73, the control surface can be powered off without loss of
user data or audio!
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Nova73

The Nova73 forms the "heart" of the system, and is available in two sizes - Nova73 HD (10RU) or Nova73
Compact (7RU):

Nova73 HD (10RU) Nova73 Compact (7RU)

In each case, the front of the frame houses the:

· Router Modules MKII - two central slots are available for a main and redundant Router Module. The
Router Module MKII (980/33) contains the summing matrix AND control system. The summing matrix

offers a 8k2 capacity* router at 48kHz (or 4k2 capacity at 96kHz). The control system runs on an
embedded Linux operating system, and stores both the application software and user data. Connections
are made via the two TCP/IP Ethernet ports:

o ETHERNET A – connects to the control surface.

o ETHERNET B – connects to the Lawo system network (to other Lawo devices; third-party controllers;

computers running configuration, maintenance or remote control software).

· DSP and I/O Modules - 16* slots are available for plug-in DSP or I/O modules. Up to 8* DSP boards can
be fitted supporting a range of DSP configurations; I/O options include AES/EBU, MADI, RAVENNA and
DANTE, see Nova73 Module Options. All modules are hot-pluggable enabling them to be be replaced
without affecting other aspects of the system. Further breakout formats are realised by connecting to 
DALLIS I/O or Compact I/O stageboxes.

· Power Supply Units - two slots are available for main and redundant power supplies.

The rear of the frame houses the:

· Sync ports - accepting Wordclock, AES/EBU (AES3-id) or Video Black Burst (PAL or NTSC).

· Alarm and control contacts - including a global alarm; prepare cold start; force redundant Router Module
takeover.

· AES connector panels - for front-mounted AES3 I/O modules.

· 5* Cooling Fans - hot-pluggable and easily accessible.

* The figures above are for the Nova73 HD. For more details on the Compact core, see the Nova73 Compact
Appendix.
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DALLIS I/O

Front View

Rear View

The I/O capabilities of the system are expanded by adding DALLIS unit(s). Each can be either 3RU (shown
above) or 6RU in height, and may be remote from the rest of the system.

The front of the frame houses the:

· DALLIS Master Boards - two central slots are provided for a main and redundant master board. A choice
of board types provide connection to/from the Nova via MADI or RAVENNA, see DALLIS Interface
Options.

The type of DALLIS master board, and hence the connection, determines the maximum number of audio
channels to/from the Nova: up to 60 (MADI) or 128 (RAVENNA).

· DALLIS I/O cards - 18 slots are available for a range of I/O breakout options (Mic/Line, Line, AES, SDI,
GPIO, etc.), see DALLIS Interface Options.

All cards are hot plug-able, with the exception of Phantom Power.

The rear of the frame provides access to:

· Main and redundant power supplies 

· Alarm and control contacts - including a local DALLIS alarm.
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Compact I/O

Front View

As an alternative to DALLIS I/O, the Compact I/O is a 5RU stagebox with a fixed amount of I/O that connects to
the Nova via RAVENNA technology. 

Each unit provides 32 mic/line in, 32 line out, 8 AES in, 8 AES out, 8 GPIO and 1 MADI port, and is fitted with
dual redundant power supplies. Each stagebox is delivered as a self-contained unit and comes with the required
RAVENNA network cable.

From Version 5.10.0 software onwards, the Compact I/O can connect via either RAVENNA Link or RAVENNA
Net - the type of connection is defined in the AdminHD configuration. Note that it is important to connect to the
correct port. Connections are made using standard CAT 5/6/7 Gigabit Ethernet, RJ45 connectors, crossed or
straight (1:1) cable, up to 80m. A network cable is delivered with the Compact I/O.

Using RAVENNA Link

RAVENNA Link connections must be directly wired. Providing the correct RAVENNA port is connected (to match
the AdminHD configuration), the interface is self-configuring. Thus, once you have connected the ports (e.g. from
the Nova to Compact I/O), no further network configuration is necessary.

Warning

To guarantee low latency, reliability and easy setup, do NOT connect any other network equipment between
RAVENNA Link connections. 

Using RAVENNA Net

RAVENNA Net connections must be made via the streaming network (i.e. to the RAVENNA network switch). This
will ensure that the network's PTP clock signal (essential for RAVENNA streaming) is available to the streaming
port. In this instance, you must make sure that the correct RAVENNA role names are configured (within
AdminHD and each partnering device) and, in the case of any virtual devices, that the streaming IP address is

also defined. For full details, please refer to the "RAVENNA for mc2/Nova User Guide".

Warning

RAVENNA streaming requires proper configuration and management of the data network. The network must
use a suitable architecture; all components must support multicast (as opposed to unicast); a proper Quality
of Service (QoS) must be configured; and so on. Please DO NOT attempt to connect RAVENNA interfaces
using an unknown or unqualifying IP network. If you do so, correct streaming operation cannot be
guaranteed.

For more details, see RAVENNA Interfaces.
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Local I/O

The mc256 MKII control surface includes an integrated local I/O board. This provides dedicated connections for
local devices such as monitoring, metering, talkback and headphones.

All local I/O connections are accessed from the control surface rear panel:

The local I/O provides:

· 16 Line In - wired to 2 x DSub (female). 

Note that Line In 16 can be fed from the integrated talkback mic preamp, according to the jumper switch
positions set for the Local I/O.

· 16 Line Out:

o Line Out 1-8 - wired to 8 x XLR (male). By default, these outputs are routed from the CRM 1 monitor

output.

o Line Out 9-16 - wired to 1 x DSub (male).

· 8 AES3 In - wired to 2 x DSub (female). 

· 8 AES3 Out:

o AES3 Out 1-4 - wired to 4 x XLR (male).

o AES3 Out 5-8 - wired to 1 x DSub (male).

Note that AES IN 5-8 and AES OUT 5-8 connect to the RTW meter, if either of the TM 7 or TM 9 Overbridge
options are fitted.

· 8 GPIO - wired to 2 x DSub.

· 2 Stereo Headphones - wired to the headphone 1 & 2 connectors on the console's front buffer.

· 1 MADI or 1 RAVENNA - the local I/O board is available in two versions, connecting to the Nova73 via
either MADI or RAVENNA (see Local I/O Connection). You will need to reserve one MADI, or one
RAVENNA, port within the Nova73 for this connection.

Please see Local I/O Wiring for more details on wiring, pin-outs and jumper switch options.
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RAVENNA Interfaces

RAVENNA is implemented throughout the Lawo product range. In mc2/Nova systems, it can be used to replace
MADI as the audio interconnect between the Nova routing matrix and DALLIS stageboxes. Or, to distribute
signals to other RAVENNA-compatible devices.

In this example two different types of RAVENNA are in use:

· RAVENNA Net (IP Layer 3) - for connections to remote DALLIS and other RAVENNA-compatible devices.

· RAVENNA Link 1.0 - a proprietary implementation of RAVENNA used for directly-wired connections (up
to 80m).

RAVENNA "Links" (Link 1.0) are recommended for local point-to-point connections such as those from the
console's Local IO and DALLIS units to the system Core (e.g. Nova73). This is because, once they are defined by
AdminHD, the Links are self-configuring and have no impact on the streaming network's bandwidth or
configuration. RAVENNA Links must be directly wired; connection via a network switch is not permitted.

RAVENNA "Net" (IP Layer 3) offers more flexibility as signals are distributed via the IP network. Each streaming
port can be configured as a DALLIS, Virtual Devices or Tie-line port supporting up to 128 bi-directional channels.
DALLIS ports may connect to a single 128-channel, or two 64-channel DALLIS frames, making RAVENNA more
flexible and port-efficient than its MADI equivalent. Virtual Device ports support up to 16 x 8-channel devices
including Lawo's A__line and LCU (Lawo Commentary Unit), and Neumann's DMI-8. RAVENNA Tie-Lines should
be configured to support streaming to/from other RAVENNA-compatible devices. Synchronization of the
RAVENNA streaming network requires a PTP master clock source. This can be achieved by using one of the
RAVENNA nodes as PTP master or by installing a third-party PTP Grandmaster device.

For more information on installing, connecting and configuring a RAVENNA network, please see the separate

"RAVENNA for mc2/Nova User Guide" and "RAVENNA Networking Guide".
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Redundancy

One of the strengths of the mc²56 MKII is its ability to withstand component failures, and every component is
designed with fault tolerance in mind:

· Star2 Technology

· Link & Port Redundancy

· Nova73 & DALLIS Power

· Redundant DSP

· Control System

· Redundant Router Module and Control System

· Control Surface Power

· Control Surface Internal Wiring
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Star2 Technology

All components within the system utilise Lawo’s Star2 technology:

· Point-to-point connections – with point-to-point connections, a fault only affects that part of the system,
unlike a TDM bus architecture where a fault may disrupt everything connected to the bus! 

· Dual star topology – with redundant Router Modules fitted to the Nova73, and redundant Master Boards
in every DALLIS, then components connect in a dual ‘star’ mode. This protects signal paths from any
single point-of-failure. See Link & Port Redundancy.

· Hot-swappable Modules/Cards – every plug-in module or card can be hot-swapped without affecting the
rest of the system enabling online maintenance of the system.

· Redundant Power Supply Units – both Nova73 and DALLIS units can be fitted with dual redundant
power supplies, which can be isolated and exchanged from the front or rear. See Nova73 & DALLIS
power.

· Passive backplanes – the frame backplanes are entirely passive. With no active components, this
increases reliability.
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Link & Port Redundancy

For crucial interconnections between say a DALLIS and mc2/Nova I/O Module, you can specify either link, or link
and port, redundancy:

· Link Redundancy – two physical connections (MADI or RAVENNA) are made from the DALLIS master

board to the mc2/Nova module. If the active link fails, then the redundant link ensures an automatic
recovery. 

· Link & Port Redundancy - two master boards are fitted to each DALLIS, and connect to different

mc2/Nova ports (preferably on a different module). Port redundancy provides automatic recovery from a:

o Failure of the active physical link (MADI or RAVENNA).

o Malfunction of the active DALLIS master board.

o Malfunction of the mc2/Nova module.

To specify link redundancy:

· MADI - order a double-port Nova73 module and DALLIS master board for each connection.

· RAVENNA - install both the copper and fibre optic connections from the RAVENNA module / master
board.

To specify link & port redundancy:

· MADI or RAVENNA - order two master boards per DALLIS plus enough single-port Nova I/O modules to
support the connections. AdminHD configures which ports provide redundancy.
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Nova73 & DALLIS Power

Nova73 HD front view Nova73 Compact front view

DALLIS internal view of PSUs

The Nova73 HD, Nova73 Compact and DALLIS provide two slots for dual redundant power supplies, see Nova73
power and DALLIS power. Their status can be monitored from the console GUI using the Signal Settings display.
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Redundant DSP

Within the Nova73 a DSP board can be reserved to provide redundant processing (indicated by the STANDBY
LED).

In the unlikely event of a failure, the system automatically switches all DSP resources and settings from the faulty
board to the spare; the faulty board can then be safely removed and replaced.

This option is enabled from the console GUI using the DSP Configurations display, and is saved within the
production.
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Control System

The control system resides on the Router Module MKII (980/33). 

It runs on an embedded Linux operating system for speed and increased
reliability, and stores both the application software and user data.

The Router Module MKII (980/33) contains a backup power unit
which provides up to 3 seconds of backup power to deal with short
interruptions to mains (AC) power.

Warm Start & Cold Start

Following switch-off, power is provided to the control system for a further 18 seconds. During this time, all current
settings are saved to flash memory; this is known as the system's warm start data.

By default, the warm start data is loaded at the end of boot-up. This means that the console comes back exactly
as it was when you last shut down, ensuring fast recovery of all previous settings following a loss of power.

Alternatively, you can perform a cold start if you suspect a problem with the warm start data.

Data Recovery

Two flash cards are used to store the application software (System Flashcard) and user data (Data Flashcard)
separately. You can create a backup copy of the flashcards so that they can be replaced if necessary.

During operation, any errors generated by the control system are stored in the message logfile. This can be
copied to USB via the File display, or monitored remotely via the Web Browser Interface.
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Redundant Router Module and Control System

By fitting a second Router Module to the Nova73, the system can provide redundancy for the
routing matrix and control system.

In order to provide redundancy, your Nova73 must be fitted with two Router Modules MKII; 
Ethernet A and Ethernet B connections from both the main and redundant modules are
required:
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Automatic Takeover

If the main Router Module fails, then the redundant module automatically takes over. This ensures a seamless
recovery without any interruption to operation. 

Note that a brief interruption to audio will occur while routes are reconfigured.

The redundant control system is automatically activated if, internally, a loss of connection is noticed by the
redundant system. This could be due to a software failure, hardware error or reboot of the main control system. 

If the Ethernet connection between the control surface and Router Module fails, then an automatic takeover does
not occur, as the failure could be deliberate (for example, if you disconnect the cable).

Instead the operator is presented with an error message:

1. Click on the message and a confirmation pop-up appears:

2. Select Yes to switch to the redundant control system or No to cancel.

Selecting Yes causes an interruption to the audio.

If you select No, then you MUST fix the problem with the connection before you will regain control of the audio.
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Manual Takeover

You can force a manual takeover at any time, using the Redundancy takeover option in the
System Settings display:

1. Select the Global topic followed by the Redundancy takeover option - a
confirmation dialogue box appears:

2. Select Yes to confirm or No to cancel the operation. Selecting Yes switches to the
redundant control system.

Alternatively, press the Module Takeover button on the front of the redundant Router Module.

A manual takeover can also be forced using the ROUTER TAKEOVER contact, connected to GPI 1 on the
Nova73 rear panel, see Nova73 Alarm & Control Contacts.
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Control Surface Power

Control surface power is provided by internal power supplies. Depending on the frame size, either one or two PSU
blocks are fitted to each frame. Each block is equipped with two power supplies running in parallel. Both share
the current load; if one fails, then the second is powerful enough to handle the required load alone.

Power Supply Desk Alarm

From Version 4.8 software onwards, the Central GUI offers status monitoring for all PSU blocks fitted to the
control surface.

The status of each PSU block is represented by a symbol which appears at the bottom right of every console
display:

The number of symbols relates to the number of PSU blocks within the control surface and whether any extender
bays with their own PSU are fitted. PSU blocks are represented from left to right, and each block consists of two
supplies running in parallel. 

The symbols indicate:

· Green Circle – the PSU block is working fine.

· Yellow triangle with an exclamation mark – the PSU block is working fine, but there was a fault in
the past which has now been cleared. Click on the icon to reset it.

· Red circle with an exclamation mark – there is a fault.

Hover over the symbol to reveal more information:

Our example shows the status for Bay 1 - the first bay on the left of the console.

Note that within the text on the GUI, bays are counted from BAY 1 upwards. However, internally bays are
addressed from 0. This means that BAY 1 on the GUI relates to an internal Bay Server address of 0, BAY 2
to an internal address of 1, and so on.
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Control Surface Internal Wiring

Within each channel and central bay, individual panels and displays connect to an Ethernet Bay Server. (Control
surface panels via USB; displays via LVDS for high resolution graphics and USB for touch control).

Each Bay Server then connects to an Ethernet switch, mounted inside the control surface frame. The network
connection from the switch appears on the rear panel as ETHERNET A. 

By fitting a redundant Router Module to the Nova73, a second Ethernet A connection can be installed for
automatic redundancy.

Internally, point-to-point connections provide fault tolerance, and allow any bay or panel to be isolated from the
rest of the console.

Control surface panels and displays are hot-pluggable making them easy to service.
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Sample Rate & System Clock

Internal Sample Rate

The system can operate at a choice of internal sampling rates including 96kHz, 88.2kHz, 48kHz and 44.1kHz. 

The maximum sample rate (96kHz or 48kHz) is set by the AdminHD configuration and cannot be modified from
the console GUI. (AdminHD: the maximum sample rate is defined when you select the type of Nova core). 

Having configured the maximum rate, use the Sample rate option, in the System Settings display, to change
from 48kHz to 44.1kHz, or from 96kHz to 88.2kHz, 48kHz or 44.1kHz.

System Clock (Sync Reference)

The Nova73 offers a fully redundant clock source structure with two independent sync inputs, the ability to lock to
sync from an incoming multi-channel signal, and an internal sync generator.

External sync connections are located on the Nova rear panel.

The sync signal priorities are defined using the Wordclock options in the System Settings display.
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Networking I/O Resources

The mc²56 MKII is just one member of the mc2/Nova family of products which share the same hardware and
software. The Nova73 and DALLIS system is available in its own right as a stand alone routing matrix. Multiple
systems can be networked to provide sharing of sources and destinations:

In the example above, mics are physically connected, via a DALLIS, to each system. Signals are transferred
between systems via ‘Netlinks’, providing the ability to share any mic input. 

Each ‘Netlink’ is an audio connection which can be MADI, RAVENNA, AES or analogue audio, and signals are
dynamically allocated as each operator makes routes from the Signal List display.

Any number of sources can be distributed depending on the physical limitations of your network. Please consult
your system specification for details.

On any system within the network, you can view which sources are distributed from the % column on the Signal

List display:

·  indicates that a source is connected locally to this console, and is ‘Shared’ (made available) to other
consoles within the network.

·  indicates that a source is ‘Imported’. In other words, it is not connected locally to this console.

All Lawo products have a consistent software release numbering system to indicate compatibility. In each
case, the first three digits of the software version must match. 

So, for example, a mc266 console running version 5.10.0.2 can be networked to another mc2/Nova system

running 5.10.0.x.  You can check the software version of your mc2 system from the Global Options in the
System Settings display.

From Version 5.4 onwards, a warning icon appears in the Status Bar if the networked connection fails.



mc²56 MKII Technical ManualV5.10.2/128

Chapter 1: Technical Overview
IP-SHARE

IP-SHARE

From Version 5.10.0 onwards, all mc2/Nova systems support a feature known as IP-SHARETM. This can be
configured within a RAVENNA (IP Layer 3) network and allows up to eight consoles to set an independent gain
value for the same DALLIS mic/line input. The DALLIS Mastercard communicates with all networked consoles

and the IP-SHARETM algorithm sets the optimum analog gain for all consoles. Furthermore, the algorithm ensures
that the corresponding gain compensation is applied to the digital gain stages of all consoles, when the analog
gain of the preamp is being adjusted:

IP-SHARETM is only available for RAVENNA Net and for DALLIS fitted with 941/53 or 941/55 Mic/Line cards.
(Other Mic/Line cards and I/O systems do not support the feature.)

Up to eight consoles can have access to the same gain parameter (using their own "virtual" gain values).

Each console MUST use a separate RAVENNA Service IP Network range.

Only the "master" console can access the DALLIS outputs (and any inputs which are not shared).

When using RAVENNA port redundancy with a Gain Compensation DALLIS, there is no automatic
redundancy takeover. Instead, you will need to switch to the redundant RAVENNA port "manually" (e.g via a
Central User Button or external control system).

Gain compensation is enabled for qualifying inputs using AdminHD. 

Once configured, each console can request an input gain value. The DALLIS receives all the requested gains,
selects the most suitable and adjusts the analog gain stage accordingly (usually to the smallest requested value).
This is then compensated by the digital gain stage of the DALLIS (back to 0dB). Each console then adds its own
gain, automatically, to return to the originally requested gain value. Note that this is handled by the I/O DSP
which means that I/O DSP cannot be used for other applications when Gain Compensation is enabled.

For more details on configuration, please see the "RAVENNA for mc2 User Guide".
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Configuration

The mc²56 MKII can be customised by operators, technicians or Lawo personnel as follows:

Custom Functions

Functions such as user buttons can be re-assigned from the console GUI using the Custom Functions display:

Custom functions are stored at a lower level to productions. This means that any changes will affect all users.

AdminHD

At a lower level (not accessible from the GUI) are a number of files which configure the system’s hardware and
define settings such as the sampling frequency, and the organisation of signals within the Directories and
Subdirectories of the Signal List display. The AdminHD configuration is an essential part of the system. If a
hardware component is not defined within the configuration, then it will not be visible to you even if it is powered
and connected. In other words, the configuration is always the ‘master’ of the system, regardless of what physical
components are added or removed.

The configuration is not designed to be changed by an operator, but can be edited by your systems engineer
using a software application called AdminHD. For example, if a DALLIS or Compact I/O stagebox is hired in for a
production, then the unit must be added to the configuration and uploaded to the system before the signals and
parameters become available to the operator.

TCL Functions

At a lower level than AdminHD, a number of other options can be factory-configured using TCL (Tool Command
Language). TCL functions can only be programmed by Lawo personnel, and are designed to provide some
flexibility at the specification stage. TCL allows the logical interlinking of GPIs, soft keys and events. For
example, tally states, automated input allocation and fader starts can all be programmed using this protocol.
Console monitoring is also handled by the TCL protocol.
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System Options

The principle system components offer a number of options which define the layout of the control surface, the
modules fitted to the Nova73 and the cards fitted to each DALLIS. For details see Control Surface Options,
Nova73 Module Options, DALLIS Interface Options and the Compact I/O.

In addition, the following features can be installed, or configured:

· mxGUI - a Lawo software programme which runs on an external computer to provide offline setup or

remote operation of any mc2 system. mxGUI is covered in the "mc²56 MKII Operators Manual".

· AdminHD - a Lawo software programme which runs on an external computer to provide system
configuration. See AdminHD.

· Audio Follow Video (AFV) - the console supports up to 128 external events to open and close any
channel or main fader. AFV events are factory-configured, and received via TCP/IP Ethernet or GPIO. For
more details, please contact your local Lawo representative or email support@lawo.com.

· General Purpose Channels (GPCs) - the console supports up to 256 GPCs which can be used to
remotely control parameters within an external device via MIDI. The assignment of GPC objects to MIDI
program changes and controller values is factory-configured. For more details, please contact your local
Lawo representative or email support@lawo.com.

· Waves MultiRack SoundGrid Plug-in Server - from Version 5.6.0 onwards, the Waves MultiRack

SoundGrid system can be integrated into any mc2 console. This provides control of Waves plug-ins

directly from the console's Central GUI, and stores and recalls plug-in settings with mc2 snapshots and

productions. Please refer to the separate “Waves Plugin Server for mc2 User Guide” for more details.

· Lawo Plug-in Server - for details about Lawo's own plug-in server (available prior to release 5.6.0),
please see the "Plugin Server Technical Documentation".

· Remote MNOPL - Lawo’s Remote MNOPL protocol is a freely available Ethernet (TCP/IP) protocol
providing control of virtually any system parameter from an external device. A typical application is to
provide third-party matrix control from external systems such as VSM, Evertz, Quartz, BFE, Pharos and
others. See AdminHD: mapping tables.

· ROSS Audio Protocol (RAP) - from Version 5.4, native support for the ROSS Audio Protocol (RAP) is
included. This offers remote control from external devices such as vision mixers, etc.

· Ember+ - is a non-proprietary TCP/IP control protocol, supported by a range of devices including Lawo's
radio and production consoles. Ember+ allows devices to remotely control parameters within the mc²56
MKII, or the mc²56 MKII to control parameters within an external device. More details can be found at 
https://code.google.com/p/ember-plus/feeds

· Remote Desktop - any of the console’s TFT displays (Channel or Central GUI) can be switched to a
remote server in order to view and control other applications. The server running the desktop must be
connected to the Lawo system network. The remote desktop function is programmed from the console
GUI, using the Custom Functions display.

· Lawo Remote App - is a free App which allows you to adjust fader strip parameters, recall snapshots
and control user-defined functions remotely from an iOS device. The Lawo Remote App is covered in the
"mc²56 MKII Operators Manual". For details on configuring the wireless network access point, see the
“TD_AccessPoint.iApp” guide.

· Machine Control - the optional Recording Com Kit provides Sony 9pin, LTC and MIDI connections to an
external playback device. The operation of machine control is covered in the "mc²56 MKII Operators
Manual".

· Networked Resources - for more information on configuring 'Netlinks' to share audio resources between
systems, please contact your local Lawo representative or email support@lawo.com.

· Web Browser Interface - the control system includes an integrated web server, allowing status
information to be monitored from an external computer, see the Web Browser Interface.

· Dial-up Router - this option can be installed to provide remote 'dial-up' maintenance from the Lawo
service department. For more details, please contact your local Lawo representative or email
support@lawo.com.

mailto:support@lawo.com
mailto:support@lawo.com
https://code.google.com/p/ember-plus/feeds
mailto:support@lawo.com
mailto:support@lawo.com
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Chapter 2: Installation

This chapter deals with installing the hardware components, connecting up the system and powering on:

· Installing the Nova73

· Installing the DALLIS Unit(s)

· Installing the Compact I/O

· Installing the Control Surface

· System Connections

· Powering On & Checking the System

· System Settings

The "mc2_documentation" contains mechanical drawings, data sheets and further information on all system

components. This resource is included with the current mc2_56 software release, available from the Download-
Center at www.lawo.com (after Login).

http://www.lawo.com
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Installing the Nova73

Both the Nova73 HD and Nova73 Compact core are designed to be mounted in a 19” rack.

All plug-in connectors are located at the front or rear of the unit. Therefore, when using 19’’ racks with front doors
please leave enough room for the cables.

Cables plugged into the front of the unit can be ducted backwards underneath the unit for distribution within the
rack.

Warning

Use the rack-rails supplied to mount the Nova73. The 19” frame MUST NOT carry the complete weight of the
unit.

Dimensions and Weight

Frame: Nova73 HD Nova73 Compact

Width 19”

483mm (front plate)

440mm (chassis)

Height 10RU 7RU

Cable Duct 1RU below the frame is required for cable ducting and ventilation.

Depth (including rear
connectors and system
locking devices)

510mm 489mm

Weight 16.25 Kg (one PSU fitted)

Each PSU weighs 4.25 Kg

14.5 Kg (two PSUs fitted)

Each PSU weighs 2.86 Kg

Ambient Conditions/Air Conditioning

Proper operation of the Nova73 can only be guaranteed at an ambient temperature between 10° C and 35° C and
a relative humidity between 15% and 85% (not condensing).

When the Nova73 is out of action, it can be stored at a temperature between 0° C and 40° C and a relative
humidity between 10% and 85% (not condensing).

The Nova73 is cooled actively by built-in fans. The housing of the Nova73 is perforated at the top and at the
bottom to guide air flow in and out of the unit; the air stream is guided from bottom front to top rear. Ensure that
the cooling air stream is guided to cool the unit efficiently.

The air-flow rate depends on the mounted components. To calculate the air conditioning required, assume a
maximal air-flow rate of approximately 200 m³/h.

The life cycle of a fan is typically 70.000 operating hours (at a maximum ambient temperature of 40° C). For
details on how to change a fan, see Nova73 fan replacement.

Warning

Take care that no devices or cables obstruct the flow of air thereby hindering cooling.
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Nova73 HD Frame (980/02)

Frame 980/02, front view 

Frame 980/02, side view 
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Nova73 Compact Frame (980/06)

Frame 980/06, front view 

Frame 980/06, side view 
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Grounding

Although operator protection is guaranteed (the Nova73 is connected via the IEC Power Connectors to the ground
of the power supply system) it is best to establish an additional ground for EMC reasons. 

1. Fasten the grounding cable to the CASE grounding bolt (M4 x 8) on the Nova73 rear panel using a Torx
driver:

Warning

The Nova73 must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the device from being
grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces should be connected to a field ground.
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Power

Nova73 HD front view Nova73 Compact front view

The front of the Nova73 frame offers two slots for the installation of power supply units. On the Nova73 HD, the
second PSU is optional. The Nova73 Compact is always installed with two supplies.

To operate the Nova73, one PSU is sufficient. When a second PSU is fitted for redundancy, the load is shared
between the two supplies.

The PSUs are hot pluggable. For details on how to change a PSU, see Nova73 PSU replacement.

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied with the system.

When running with two mains supplies (PSU 1 and PSU 2), make sure that both circuits lie on the same
ground potential. Otherwise, an internal bridge of two ground wires will lead to a ground loop!

For air conditioning reasons, both PSU slots MUST be occupied when the Nova73 is operational:

· Nova73 HD: if only one PSU is installed, then please fill the empty slot with a dummy plate (Type
980/21). 

· Nova73 Compact: leave both PSUs in the frame until a replacement can be fitted.
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Power Consumption

The power consumption of the Nova73 varies from a minimum of 60W to a maximum of 1000W, depending on the
voltage and the amount of modules and PSUs fitted.

Electrical Voltage

Nova73 HD Frame PSU Specification

980-25 (1000W Power Supply) Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 13,5 A

Output: 48 VDC / 23 A

980-22 (600W Power Supply) Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 8,2 A

Output: 48 VDC / 13 A

980-21 (Dummy Plate) n/a

Nova73 Compact Frame

980-27 (500W Power Supply) Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 5,5 A

Output: 48 VDC / 10,5 A
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Plug-in Modules and Connector Panels

Normally the Nova73 is delivered with the plug-in modules and rear connector panels fitted within the chassis.
However, if you need to fit additional cards or re-arrange the layout, follow these instructions.
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AES3 Rear Connector Panels

Ø  Nova73 HD

Optionally, the Nova73 HD can be fitted with D-Sub and/or BNC AES3 rear connector panels. These provide
connections for any front-mounted AES3 modules (of type 981/02 or 981/04). The two panel types can be mixed
allowing up to 8 rear connector panels:

· D-Sub, 8HP (980/14) - AES3, balanced 110 Ω

· BNC, 16HP (980/15) - AES3-id, unbalanced 75 Ω

See Nova73 Rear Connector Panels for pin-out information.

The position of the rear connector panels determines the slot numbers which MUST be used for front-
mounted AES3 modules. Therefore, it is important to fit the rear panels BEFORE mounting any plug-in
modules.

1. Establish the first free slot (seen from the right) at the rear of the frame.

2. Remove the existing dummy plate if fitted.

Note that dummy plates are 8HP wide. If you want to mount a connector panel with a width of 16HP you will need
to remove two dummy plates.

3. Position the connector panel so that the inscription is legible!

4. Fasten the connector panel with its 4 screws.

5. Repeat for every connector panel/dummy plate.

Warning

Where no connector panels are required please cover the rear of the frame with dummy plates of the
type 980/13.
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Ø  Nova73 Compact

The Nova73 Compact comes with rear-mounted AES3 connectors as standard. These provide balanced 110 Ω D-
Sub connections for up to two front-mounted AES3 modules (of type 981/02 or 981/04). Note that the AES3
modules MUST be fitted to slots 2 and 6 at the front of the core.

See Nova73 Rear Connector Panels for pin-out information.
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Front Module Slots

The diagrams above show the front module slots available within the Nova73:

· Slot A – fit the main Router Module here.

· Slot B – reserved for a redundant Router Module. 

· Slots 1-16* – available for DSP or I/O modules. (*10 slots are available for DSP or I/O modules in the
Nova73 Compact core).

See Nova73 Module Options for details on all plug-in modules.

Note that the Nova73 will only work once slot A is fitted with a Router Module. When fitting a redundant Router
Module, it must be of the same type fitted to slot A.

Note that the system logfile counts slots from 0 upwards (e.g. physical slot 1 = slot 0 in the logfile).

To ensure efficient cooling, you should spread the modules evenly within the Nova73.

Not every I/O or DSP module can be used in every slot so it is best to check your configuration within 
AdminHD before fitting the physical modules.



mc²56 MKII Technical ManualV5.10.2/142

Chapter 2: Installation
Installing the Nova73

AES3 Modules

In the Nova73 HD, modules of type 981/02 or 981/04 AES3 should be mounted so that they are right-aligned to
the rear connector panel position (looking from the front of the frame). For example, if the 1st and 2nd rear
connector panels (working from right to left) are D-Sub and the 3rd is BNC, then the AES modules must be front-
mounted in slot 2 (D-Sub1), slot 4 (D-Sub2) and slot 8 (BNC).

In the Nova73 Compact core, AES3 modules MUST be mounted in slots 2 and 6.

If a module has been fitted incorrectly, then you can see its AES3 LOCK 1 LED blink.

DSP Modules

DSP modules of type 983/03 or 983/04 should be mounted from right to left filling up the odd slots - 15, 13, 11, 9,
7, 5, 3, 1 in the Nova73 HD or 9, 7, 5, 3, 1 in the Nova73 Compact core.

The logical numbering of the DSP boards follows the mounting order described above (DSP board 1 in slot 15,
DSP board 2 in slot 13, etc.):
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Mounting the Front Modules

Warning

The Nova73 plug-in modules carry highly sensitive electronic components, and therefore should only be
handled by authorized personnel, and with the utmost care. 

ALWAYS observe the following procedures:

1. Discharge yourself before touching a plug-in module.

2. Wear conductive safety-shoes and grounding wristbands to reduce the risk of electrostatic charging.

3. DO NOT bend the modules.

4. Make sure that all rear connector panels are mounted before inserting the respective plug-in module.

5. To remove an existing module, unfasten the front panel screws, release the locking catches (as shown
below) and pull out the module.

Some modules include DIP switches to set certain features. Therefore, check the DIP switch settings before
inserting a replacement! Further information can be found in the data sheet, available in the
"mc2_Nova73_documentation" guide.

6. When fitting a module, make sure that it glides smoothly into the top and bottom guide-rails:

When fitted correctly, it will lock  into place.

7. ALWAYS fasten the front panel screws in order to fix the module in place. This protects the operator from
contact with live parts; protects the module from being pulled out unintentionally; and reduces the emission of
electro-magnetic radiation.

Tighten the screws carefully to a maximum torque of 0.25 Nm; we recommend using a dynamometric screwdriver.

8. When you have fitted all the plug-in modules for your system, close any empty slots with dummy plates.
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Installing the DALLIS Unit(s)

Each DALLIS is designed to be mounted in a 19” rack and comes in a choice of frame heights: 3RU or 6RU.

All plug-in connectors, with the exception of power and alarm, are located at the front of the unit. Therefore, when
using 19’’ racks with front doors please leave enough room for the cables. 

Cables plugged into the front of the unit can be ducted backwards underneath the unit for distribution within the
rack.

Warning

Use the rack-rails supplied to mount the DALLIS. The 19” frame MUST NOT carry the complete weight of the
unit.

Dimensions and Weight

DALLIS: 3RU Frame 6RU Frame

Width 19”

483mm (front plate)

440mm (body)

19”

483mm (front plate)

440mm (body)

Height 132.5mm 265mm

Cable Duct 1RU below the frame is required for
cable ducting and ventilation.

1RU below the frame is required for
cable ducting and ventilation.

Depth (of unit) 433mm 433mm

Weight (without cards) 7.15 Kg 11 Kg

Ambient Conditions/Air Conditioning

The DALLIS requires a constant air stream with a maximum exhaust air temperature of 32° C. Thus installation in
a 19” rack is recommended.

The housing of the DALLIS is perforated at the top and at the bottom to guide air flow in and out of the unit.
Ensure that the cooling air stream is guided to cool the unit efficiently.

To calculate the air conditioning required, assume a power consumption of 200 Watts.

Warning

ALWAYS leave 1 RU below the DALLIS frame for ventilation and cable ducting. Take care that no devices or
cables obstruct the flow of air thereby hindering cooling.

ALWAYS observe the minimum distances at the front and rear of the unit to allow for ventilation and cable
ducting.
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Minimum Distances for DALLIS Installation
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3RU Frame (940/30)

Frame 940/30, front view

Frame 940/30, rear view

Frame 940/30, side view
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6RU Frame (940/60)

Frame 940/60, front view

Frame 940/60, side view



mc²56 MKII Technical ManualV5.10.2/148

Chapter 2: Installation
Installing the DALLIS Unit(s)

Grounding

Although operator protection is guaranteed (the DALLIS is connected via the IEC Power Connectors to the ground
of the power supply system) it is best to establish an additional ground for EMC reasons. 

1. Fasten the grounding cable to the M4 CASE grounding bolt on the rear panel:

Warning

The DALLIS must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the device from being
grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces should be connected to a field ground.

For connecting microphones, guide the ground connection from the DALLIS to the microphone directly via the
cable shielding, otherwise phantom power cannot be transferred. Take care that the shielding does not lie on the
field ground. This way you will prevent interference and loss of signal quality.
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Power

DALLIS rear view DALLIS internal view

Depending on your system specification, each DALLIS can be delivered with single or dual redundant power
supply units (PSUs). 

When a redundant PSU is fitted (type 940/16), the load is shared between the two supplies. 

The PSUs are hot pluggable. For details on how to change a PSU, see DALLIS PSU replacement.

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied with the system.

When running with two mains supplies (PSU 1 and PSU 2), make sure that both circuits lie on the same
ground potential. Otherwise, an internal bridge of two ground wires will lead to a ground loop!

Power Consumption

The power consumption of the DALLIS varies from a minimum of 70W to a maximum of 180W, depending on the
amount and type of I/O cards fitted, and whether there are dual power supplies.

Electrical Voltage

3RU frame, PSU specification:

· Input: 100-240 VAC (PFC)/ 48-62 Hz/ 1.6-2 A

· Output: 12 VDC / 8.3-11 A

6RU frame, PSU specification:

· Input: 100-240 VAC (PFC)/ 48-62 Hz/ max. 2A

· Output: 12 VDC / 11 A
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Plug-in Cards

Normally the DALLIS is delivered with the plug-in I/O cards and master boards fitted within the chassis. However,
if you need to fit additional plug-in cards or re-arrange the layout, follow these instructions.
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Equipping the 3RU Frame

18 single width DALLIS I/O card slots are available within the 3RU frame. Double width I/O cards (8GU) occupy
two slots; single width I/O cards (4GU) occupy one slot.

· Slot M1 – fit the main master board here.

· Slot M2 – reserved for a redundant master board.

· Slots 1-18 – available for I/O cards.

See DALLIS Interface Options for details.

Note that the DALLIS will only work once slot M1 is fitted with a master board. When fitting a redundant master
board, it must be of the same type fitted to slot M1.

Note that the system logfile counts slots from 0 upwards (e.g. physical slot 1 = slot 0 in the logfile).

Not every interface card can be used in every slot. As a general rule, if an interface card is permitted within 
AdminHD, then it can be fitted to your system. Please also refer to the DALLIS I/O Card Compatibility table.

The type of DALLIS master board, and hence the connection, determines the maximum number of audio
channels to/from the Nova: up to 60 (MADI) or 128 (RAVENNA).
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Equipping the 6RU Frame

18 double width DALLIS I/O card slots, plus a single width slot reserved for Phantom Power, are available within
the 6RU frame. Double width I/O cards (8GU) occupy the whole slot; single width I/O cards (4GU) must be fitted
on the left of the slot and a dummy plate fitted to the right to close the gap.

· Slot M1 – fit the main master board here.

· Slot M2 – reserved for a redundant master board.

· Slots 1-18 – available for I/O cards.

· Slot 19 – reserved for Phantom Power. If specified, fit the Phantom Power card (947/10) here.

See DALLIS Interface Options for details.

Note that the DALLIS will only work once slot M1 is fitted with a master board. When fitting a redundant master
board, it must be of the same type fitted to slot M1.

Note that the system logfile counts slots from 0 upwards (e.g. physical slot 1 = slot 0 in the logfile).

Not every interface card can be used in every slot. As a general rule, if an interface card is permitted within 
AdminHD, then it can be fitted to your system. Please also refer to the DALLIS I/O Card Compatibility table.

The type of DALLIS master board, and hence the connection, determines the maximum number of audio
channels to/from the Nova: up to 60 (MADI) or 128 (RAVENNA).
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Mounting the Cards

Warning

To avoid any unpleasant clicks or pops, the system resets when a Phantom Power card is replaced.
Therefore, you should only replace a Phantom Power card when off air!

The DALLIS plug-in cards carry highly sensitive electronic components, and therefore should only be handled
by authorized personnel, and with the utmost care. 

ALWAYS observe the following procedures:

1. Discharge yourself before touching a plug-in card.

2. Wear conductive safety-shoes and grounding wristbands to reduce the risk of electrostatic charging.

3. DO NOT bend the cards.

4. To remove an existing card, unfasten the front panel screws and pull out the card.

Note that some DALLIS I/O cards include DIP switches to set certain features of the cards. Therefore, when
replacing cards, check the DIP switch settings before inserting the new card! Further information can be found in
the data sheet, available in the "mc2_Nova73_documentation" guide.

Note also that the DALLIS master board provides a switch to set whether the board performs a cold or warm start
when powered on. For details please consult the relevant data sheet.

5. When fitting a new card, make sure that it glides smoothly into the top and bottom guide-rails. 

When fitted correctly, it will lock  into place.

6. ALWAYS fasten the front panel screws in order to fix the card in place. This protects the operator from
contact with live parts; protects the card from being pulled out unintentionally; and reduces the emission of
electro-magnetic radiation.

7. When you have fitted all the plug-in cards for your system, close any empty slots with dummy plates (For
single width slots use part number 940/31, and for double width slots use 940/33. Use part number 940/32 to
blank the second master board slot).
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Installing the Compact I/O

The Compact I/O is designed to be mobile with two lifting handles mounted on the front of the chassis. All plug-in
connectors are located on the front panel, with power connectors at the rear. When installing, please leave
enough room for the cables.

Temperature and Cooling

The unit is convection cooled and therefore is ideal for installation within noise critical environments. Proper
operation can only be guaranteed at an ambient temperature between 10°C and 35°C and a relative humidity
between 15% and 85% (not condensing). 

Warning

Take care that no devices or cables obstruct the flow of air thereby hindering cooling.

Power

The Compact I/O is delivered with dual redundant power supply units (PSUs); the load is shared between the two
supplies. 

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied with the system.

When running with two mains supplies (PSU 1 and PSU 2), make sure that both circuits lie on the same
ground potential. Otherwise, an internal bridge of two ground wires will lead to a ground loop!
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Installing the Control Surface

The console control surface consists of the:

· Frame (available in a range of pre-determined sizes).

· Stand (optional).

· Console Keyboard (English or German) - a floating keyboard which can be connected to any USB port.

· Removable Script tray (optional).

The frame is designed for table-top mounting onto a cross bar (not supplied). Note that no separate OB mounting
kit is required, as mounting threads are integrated into the frame. Alternatively, the control surface can be
delivered with the optional stand.

All plug-in connectors are located on the rear panel. Therefore, when installing, please leave enough room for the
cables.

Extenders require their own power and grounding connection, and connect to the main control surface frame via
Ethernet.

Please see control surface options for details on customisation options.

The "mc2_documentation" contains mechanical drawings, data sheets and further information on all system

components. This resource is included with the current mc2_56 software release, available from the Download-
Center at www.lawo.com (after Login).

http://www.lawo.com
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Ambient Conditions/Air Conditioning

Proper operation of the control surface can only be guaranteed at an ambient temperature between 10° C and 35°
C and a relative humidity between 15% and 85% (not condensing).

To keep the control surface cool in extreme environments, the front panel is fitted with low noise fans. A sensor
within the console activates the cooling fans if the temperature rises above 30° C. 

At temperatures below 30° C the cooling fans are switched off permitting installation within noise critical
environments. When relying on convection cooling, ensure that the unit’s ventilation holes are not blocked to allow
air circulation.

Warning

ALWAYS observe the minimum distances around the console frame to allow for ventilation and cable
ducting.

Take care that no devices or cables obstruct the flow of air thereby hindering cooling.
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Dimensions and Weight

16+16C Studio Profile 16+16C Studio Overhead

Frame Size Part Number Studio Version OB Version

16C 959-09 Width:

Weight:

809mm

32.4kg

731mm

32.4kg

16+16C 959-10 Width:

Weight:

1319mm

47.3kg

1241mm

47.3kg

16+16C +16 959-11 Width:

Weight:

1829mm

62.6kg

1751mm

62.6kg

32+16C+16 959-12 Width:

Weight:

2339mm

80.6kg

2261mm

80.6kg

32+16C+32 959-13 Width:

Weight:

2849mm

96.3kg

2771mm

96.3kg

Extender (16-fader) 959-22 Width:

Weight:

601mm

23.1kg

523mm

23.1kg
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Minimum Distances & OB Van Mounting

Mechanical data for the Studio and OB version of the 16+16C frame are included here. You can find similar data
for other frame variations in the “mc2_Nova73_documentation” guide.

16+16C Studio Frame Installation
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16+16C OB Van Frame Installation
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Grounding

Although operator protection is guaranteed (the control surface is connected via the Power Connectors to the
ground of the power supply system) it is best to establish an additional ground for EMC reasons.

1. Fasten the grounding cable to the CASE grounding bolt (M5 x 12) on the rear panel using a Torx T25
driver:

Warning

The control surface must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the device from being
grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces (connected to the Local I/O) should be connected to a field ground.
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Power

Control surface power is provided by internal power supplies, and the power consumption is dependent on the
number of panels fitted to the surface.

Depending on the frame size, either one or two PSU blocks are fitted to each frame. Each block is equipped with
two power supplies running in parallel. Both share the current load; if one fails, then the second is powerful
enough to handle the required load alone.

Each of the supplies connects to the mains via its own terminal. Therefore, it is possible to realise phase
redundancy if each terminal is connected to a different phase (see below).

Larger frames require two PSU blocks, and any frame extenders also require their own supply. 

The status of all PSU blocks can be monitored from the console GUI.

For details on how to change a PSU, see Control Surface PSU replacement.

Mains Connections

For each PSU block, two mains connectors (MAINS 1 & MAINS 2) are located on the rear of the frame. Only one
mains connection is essential for operation; the second provides redundancy. 

It is recommended that MAINS 1 and MAINS 2 be run from separate phases of the mains supply, and that the
same two phases are used for all parts of the desk. It is also recommended that all power connections are
controlled from a common mains switch.

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied with the system.

Make sure that ALL circuits lie on the same ground potential. Otherwise, an internal bridge of two ground
wires will lead to a ground loop!

To unplug the MAINS cables, press the red button to unlock the IEC connector.
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Power Consumption

The maximum power consumption, per mains connection, for a fully loaded frame is:

· Current (max): 1.4 A to 3.4 A (depending on the voltage)

· Power (max): 340 Watts

A control surface with fewer panels requires less current and power.

Due to the power supply inrush current, no more than three PSU blocks should be used per 16 A circuit breaker.

Frame Spec & (Part Number) No. of PSU blocks per phase

16C (959-09) 1

16 + 16C (959-10) 1

16 + 16C + 16 (959-11) 1

32 + 16C + 16 (959-12) 2

32 + 16C + 32 (959-13) 2

16 Fader Extender (959-22) 1

Electrical Voltage

The specification for each PSU block is:

· Input: 100-240 VAC (PFC)/ 47–63 Hz

· Output: 13 VDC / 18 A (max)/ 234 Watts (max)
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Console Keyboard Language

The console keyboard is available in either English or German. The correct language should be selected from the 
System Settings display (via the Global -> System options).
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System Connections

The control system resides on the Router Module MKII (980/33) within the Nova73. Therefore, the following
essential connections are required to boot and test the system:

· Ethernet A - connects the control surface to the Nova73 Router Module.

· Control Surface Power - mains connections to the control surface frame.

· Nova73 Power - mains connections to the Nova73.

All other connections, including those to/from DALLIS and Compact I/O units, can be made as and when
required.

you can connect your external I/O to the:

· Nova73 - see Nova73 Module Options.

· DALLIS - see DALLIS Interface Options.

· Compact I/O - see Compact I/O.

· Local I/O (in the control surface) - see Local I/O.
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Ethernet A

This port connects the console control surface to the control system on the Nova73 Router Module MKII (980/33).

Connections are made via TCP/IP Ethernet. Only one connection (to the active Router Module) is essential for
operation; the second is required if a redundant Router Module is fitted:

Use a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors):

1. Connect either of the control surface ETH A ports (on the rear connector panel) to the first Nova73 Router
Module.

· On the control surface, you can use either port (ROUTER 1 or ROUTER 2).

· On the Nova73, make sure you connect to ETHERNET A (and not ETHERNET B).

Control Surface Rear Nova73 Router Module MKII Front

2. If a redundant Router Module is fitted to the Nova73, then run a second network cable from the spare
control surface port (ROUTER 1 or ROUTER 2) to the redundant Router Module (ETHERNET A).

This second connection is essential to support control system redundancy.

3. You can now power on to boot and check the system, or continue with the rest of the system wiring.
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Ethernet B (System Network)

The ETHERNET B port, on the Nova73 Router Module MKII (980/33), connects the control system to the rest of
the Lawo system network. This connection supports various applications including:

· Remote control from Lawo's mxGUI software.

· Remote configuration from Lawo's AdminHD software.

· Remote control from a third-party device via Lawo's Remote MNOPL.

· Diagnostics and maintenance from the Web Browser Interface, Telnet session, etc.

· Control connections to other Lawo systems to support audio networking.

· Remote maintenance, from Lawo's service department, via the dial-up router.

Connections are made via TCP/IP Ethernet.

A single device can connect directly. However, more commonly, a network switch is installed to support a wider
system network.
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Network Connection

Direct Connection

1. Using a crossed network cable (STP-CAT 5 with RJ45 connectors), connect to the ETHERNET B port on
the active Router Module MKII:

Connection via a Network Switch (recommended)

1. Using a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors), connect to the network switch.

2. Connect the network switch to the ETHERNET B port on the Router Module MKII. (If a redundant Router
Module is fitted, then run a second network connection. This ensures continued operation should a control
system takeover occur).

Warning

You must use a network switch and NOT a hub.

Keep the Lawo network separate from other network traffic within the installation.

For more information on installing a suitable network switch, please contact your local Lawo representative or

email support@lawo.com. Depending on the number of network connections, one mc2/Nova system can support
up to 16 clients.

mailto:support@lawo.com
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TCP/IP Configuration

To establish communication, you will need to configure the TCP/IP settings for your computer’s network interface
card. The following screenshots demonstrate how to do so on a computer running Windows 7 and Mac OS X:

IP Address

The IP address of your computer’s network interface card must be unique, and set within the same range as that
of the mc²56 MKII control system. You can check the IP address of your control system from the Central GUI
(using the System Settings display, see IP Address Primary). For example, if your Lawo system's IP address =
192.168.102.56, then set your computer's IP address to 192.168.102.101. In a networked installation, it is likely
that you will be connecting via an Ethernet switch, so please consult your network administrator for further details.

Check the address carefully. If there is an IP conflict, then the console will not operate correctly.

Subnet Mask

The Subnet Mask should be identical to that of the system. The default Subnet Mask is 255.255.255.0.

Checking Network Communication

Open your browser software, and enter the IP address of the mc²56 MKII control system into the URL field - the
Web Browser Interface home page should appear.
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Wiring from the Control Surface

Main Frame (Rear Connector Panel)

The principle connections come from the main control surface frame:

· MAINS 1 & MAINS 2 - see control surface power. Only one mains connection is essential for operation;
the second provides redundancy. 

· CASE - see control surface grounding.

· ROUTER 1 & ROUTER 2 (ETH A) - see Ethernet A. Only one connection (to the active Router Module) is
essential for operation; the second connection is required if a redundant Router Module is fitted.

· ETH Extension x 2 (ETH A) - connect to extender frames.

· MADI & RAVENNA - one of these ports connects the local I/O board to the Nova73. The connection type
is pre-determined by the version of the Local I/O board, so check your system specification for details.

· TBK, LINE, AES & GPIO - audio and GPIO breakouts for the local I/O, see Local I/O and Local I/O
Wiring.
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Extender Frames

Extenders require their own power and grounding connection, and connect to the main control surface frame via
Ethernet:

Use a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors) to connect the extender to one of the ETH
Extension ports on the main frame. If more than two extenders are fitted, then a Fast Ethernet switch is supplied.

If you are adding a new extender, then you can need to adjust the Bay Server address settings.

Main Frame (Front)

Note that a number of "user" connections are also available at the front of the console:

· USB x 2 - on the Overbridge, to connect the console keyboard or a data memory stick.

· XLR x 1 - on the Overbridge. This is the talkback mic connector.

· Stereo Headphones x 2 - in the arm rest. The default monitoring configuration sets HP 1 to follow the
CRM 1 monitor source selector, and HP 2 to follow CRM 2. Note that on larger frames, two additional 
phones connectors (HP 3 & 4) operate in parallel with HP 1 & 2.

· Ethernet x 1 - in the arm rest. Another network port for connecting an mxGUI or AdminHD/service
computer.
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Wiring from the Nova73

The Nova73 HD (shown below) and Nova73 Compact core provide identical connections:

Nova73HD Front View Nova73HD Rear View

Front Connections:

· PSU 1 & PSU 2 - see Nova73 power. Only one PSU is essential for operation; the second provides
redundancy. 

· Router Module(s) MKII:

o ETHERNET A – connect to the control surface. 

o ETHERNET B – connect to the Lawo system network.

If two Router Modules are fitted, then run Ethernet A and Ethernet B connections from both the main and
redundant Router Modules.

· MADI, RAVENNA or DANTE - connect to external I/O devices including DALLIS (via MADI or RAVENNA);
Compact I/O (via RAVENNA); and Virtual Devices (via RAVENNA). See Nova73 Module Options and
Defining the I/O Ports. One MADI or RAVENNA port must be reserved for the local I/O.

Rear Connections:

· SYNCHRONISATION Ports - see External Sync. If a sync reference is not connected, or invalid, then the
system automatically switches to internal sync.

· GPI 1 & 2, Global ALARM - see Nova73 Alarm & Control Contacts.

· AES Breakout Connectors - see Nova73 rear connector panels.
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Wiring from DALLIS Unit(s)

Front View (3U frame)

Rear View (3U frame)

Front Connections:

· DALLIS Master Board(s):

o MADI or RAVENNA - connect to the Nova73, see DALLIS Interface Options. If two master boards are

fitted, then you can configure Link & Port Redundancy.

o CTRL, WCLK, SYNC - on some master boards, you will find additional connections for a control

computer and local sync. Please refer to the relevant data sheet, available in the
"mc2_Nova73_documentation" guide. Note that external sync for the mc²56 MKII should be made
to/from the Nova73.

· DALLIS I/O Cards - audio and GPIO breakouts, see DALLIS Interface Options.

Rear Connections:

· PSU 1 & PSU 2 - see DALLIS power. Only one PSU is essential for operation; the second provides
redundancy.

· ALARM & FORCE M2 - see DALLIS Alarm & Control Contacts.
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Nova73 to DALLIS Interconnects

The type of master board determines how each DALLIS unit connects to the Nova73. There are two possible
options: MADI or RAVENNA.

MADI

· AES10, multi-channel digital audio interface.

· Connections are either multi-mode or single-mode fibre, depending on the master board type; duplex-SC
connectors:

o Multi-mode fibre: 62.5 / 125 µ m, 1300nm

o Single-mode fibre: 9 / 125 µ m, 1300nm

· Up to 64-channels at 48kHz, or 32-channels at 96kHz, per port.

A minimum of 4-channels are used to transport Port DSP resources to/from the DALLIS. This leaves up to
60-channels at 48kHz, or 28-channels at 96kHz, for plug-in I/O.

RAVENNA

See RAVENNA Interfaces.
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Nova73 to Compact I/O Interconnects

From Version 5.10.0 software onwards, the Compact I/O can connect via either RAVENNA Link or RAVENNA
Net - the type of connection is defined in the AdminHD configuration. Note that it is important to connect to the
correct port. Connections are made using standard CAT 5/6/7 Gigabit Ethernet, RJ45 connectors, crossed or
straight (1:1) cable, up to 80m. A network cable is delivered with the Compact I/O.

Using RAVENNA Link

RAVENNA Link connections must be directly wired. Providing the correct RAVENNA port is connected (to match
the AdminHD configuration), the interface is self-configuring. Thus, once you have connected the ports (e.g. from
the Nova to Compact I/O), no further network configuration is necessary.

Warning

To guarantee low latency, reliability and easy setup, do NOT connect any other network equipment between
RAVENNA Link connections. 

Using RAVENNA Net

RAVENNA Net connections must be made via the streaming network (i.e. to the RAVENNA network switch). This
will ensure that the network's PTP clock signal (essential for RAVENNA streaming) is available to the streaming
port. In this instance, you must make sure that the correct RAVENNA role names are configured (within
AdminHD and each partnering device) and, in the case of any virtual devices, that the streaming IP address is

also defined. For full details, please refer to the "RAVENNA for mc2/Nova User Guide".

Warning

RAVENNA streaming requires proper configuration and management of the data network. The network must
use a suitable architecture; all components must support multicast (as opposed to unicast); a proper Quality
of Service (QoS) must be configured; and so on. Please DO NOT attempt to connect RAVENNA interfaces
using an unknown or unqualifying IP network. If you do so, correct streaming operation cannot be
guaranteed.

For more details, see RAVENNA Interfaces.
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External Sync

All external sync connections should be made to and from the Nova73 rear connector panel:

· INPUT 1 & INPUT 2 - accept Wordclock, Video Black Burst (PAL or NTSC) or AES 3-id.

When running the system referenced to Wordclock, the frequency of the sync source MUST match the
internal operating sample rate of the system.

The Nova73 supports only one video format at a time. Thus, if both inputs are supplied with Video Black
Burst, only signals of the same type can be used (either PAL or NTSC).

· THRU 1 & THRU 2 - provide an output of the sync signals connected to INPUT 1 & INPUT 2. Note that
the THRU ports provide a "looped-through" signal, and do NOT follow the system clock selection.

Warning

If no further components are connected to the THRU ports, then it is essential to terminate each port using a
75 Ω resistor. Terminating resistors, designed as BNC connectors are included in the delivery.

· WCLK OUT - provides an output of the current system clock. This output follows the system clock
selection.

The sync signal priorities are defined using the Wordclock options in the System Settings display.

A star-like clock distribution, via a distribution amplifier, offers better signal quality and should be preferred to
that of passive daisy chaining.
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Nova73 Alarm & Control Contacts

Three alarm connectors appear on the Nova73 rear panel:

· GPI 1 & GPI 2 - two 25-pin D-Sub connectors carrying various input and output signals.

· GLOBAL ALARM - one BNC carrying the global alarm.

GPI 1 GPI 2

On both D-Sub connectors, you can pick up a short-circuit proof voltage feed (+5V, max 150mA).
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GPI Inputs

The GPI inputs are opto-couplers; accept voltages of 3V..20V; draw a typical current of 8 mA; and are floating and
galvanically isolated.

Ø  GPI 1

· GENERAL PURPOSE IN 1 & 2 – used for project-specific applications, please check your system
specification for details.

· ROUTER TAKEOVER (IN) – use this input to force a takeover to the redundant Router Module. The
takeover is triggered by a positive edge at the input.

· PREPARE COLDSTART (IN) – when turning on the Nova73, supply a voltage at this input to force a cold
start.

Ø  GPI 2

· ALARM IN 1 to 4 - can be used to monitor peripheral equipment such as devices from other
manufacturers. The inputs MUST be factory-configured. Each alarm is triggered by an applied voltage.
When the input is open or grounded, the alarm is cancelled. Within the AdminHD configuration, you can
assign a text error message for each input, and define whether the input activates the global alarm.
Predefined standards are:

o ALARM 1 IN = failure of the external clock supply (activates the global alarm).

o ALARM 2 IN = failure of the external power supply (activates the global alarm).

o ALARM 3 IN = failure of the external I/O system (activates the global alarm).

o ALARM 4 IN = the external device exceeds its operating temperature (activates the global alarm).
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GPI Outputs

The GPI outputs are relays; output a maximum of 30V / 500 mA; and are floating and galvanically isolated.

Ø  GPI 1:

· 2nd ROUTER ACTIVE – this contact reports the activation of the redundant Router Module (closed
status).

· GENERAL PURPOSE OUT 1 & 2 – used for project-specific applications, please check your system
specification for details.

Ø  GPI 2:

· CTRL LIFE-WATCH – this is a project-specific contact which can be used to report the loss of a
connection to another control system. For more details, please contact your local Lawo representative or
email support@lawo.com.

· PSU ALARM – this contact reports the failure of either of the Nova73 PSUs (closed status).

· GLOBAL ALARM – this contact signals that the global alarm is active (closed status).

mailto:support@lawo.com
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Global Alarm

The global alarm can be output by both the GLOBAL ALARM BNC and GPI 2 D-Sub connectors.

The global alarm status can also be monitored from the Web Browser Interface.

Global alarm errors are stored on the control system in the alarm.log system logfile.

The global alarm can be disabled by the AdminHD configuration (see Parameters: Core -> System Settings).

When enabled, the global alarm is triggered when any of the following conditions are satisfied: 

Within the Nova73:

· Malfunction of a Router module.

· High temperature on a Router module – triggered if the temperature exceeds 45° C.

· Too high or too low a voltage to a Router module.

· Malfunction of an I/O module in the Nova73.

· Malfunction of a PSU.

· Malfunction of a fan.

· Active external control input – the global alarm can be triggered by a control input from an external device
(e.g. via GPI).

· Internal sync (optional) - the global alarm can be triggerd if the system switches to internal sync (see
Parameters: Core -> Data).

From an I/O Port (e.g. DALLIS or external device):

· If the port is not supplied with a valid signal.

· Malfunction of a DALLIS master board.

· Malfunction of a DALLIS I/O card.

· Malfunction of a DALLIS PSU.



mc²56 MKII Technical ManualV5.10.2/180

Chapter 2: Installation
System Connections

DALLIS Alarm & Control Contacts

Three alarm connectors appear on the DALLIS rear panel:

· ALARM FORCE M2 -15-pin D-Sub carrying the DALLIS local alarm and other signals.

· FORCE M2 - BNC for the FORCE M2 control signal.

· ALARM - BNC carrying the DALLIS local alarm.

ALARM FORCE M2 D-Sub ALARM FORCE M2 Block Diagram
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ALARM FORCE M2

The following contacts are accessible via the ALARM FORCE M2 (15-pin D-Sub) connector:

· Force second masterboard M2 (Pins 14&15) – use this input to force a redundant Master Board
takeover (if two master boards are fitted to the DALLIS). The takeover is triggered by a positive edge at
the input.

· Alarm (Pins 7&8) – this contact signals that the DALLIS local alarm is active (closed status).

· Alarm Inverted (Pins 5&13) – as above, but the status is inverted.

· PSU 1 (Pins 3&11; Pins 2&10) – these contacts report the failure of PSU 1 (closed status).

· PSU 2 (Pins 1&9) – this contact reports the failure of PSU 2, if fitted (closed status).

The two BNC connectors provide:

· FORCE M2 – use this input to force a redundant Master Board takeover (as above).

· ALARM – outputs the DALLIS local alarm.
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DALLIS Local Alarm

A local alarm for the DALLIS unit can be output by both the ALARM BNC and ALARM FORCE M2 D-Sub
connectors.

Note that some of the alarm conditions vary for DALLIS fitted with the RAVENNA master board (947/21); the
differences are highlighted in the second table below.

Local Alarm Output States for DALLIS fitted with 947/03, 947/13, 947/05, 947/07 and 947/15

Condition ALARM (BNC / D-Sub Pin 7&8) ALARM Inverted (D-Sub Pin
5&13)

No power closed open

1 card in left slot, booting closed open

1 card in left slot, no error present open closed

1 card in left slot, error present closed open

2 cards, booting closed open

2 cards, left no error, right no error open closed

2 cards, left error, right no error closed open

2 cards, left no error, right error closed open

2 cards, left error, right  error closed open

Local Alarm Output States for DALLIS fitted with 947/21

Condition ALARM (BNC / D-Sub Pin 7&8) ALARM Inverted (D-Sub Pin
5&13)

No power closed open

1 card in left slot, booting closed open

1 card in left slot, no error present closed open

1 card in left slot, error present open closed

2 cards, booting closed open

2 cards, left no error, right no error closed open

2 cards, left error, right no error closed open

2 cards, left no error, right error closed open

2 cards, left error, right  error open closed
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Powering On & Checking the System

For details on how to power on, see System Shutdown and Restart.

Once the system has booted, you can check that the status of all Nova73 and DALLIS components by looking at
the console’s Signal Settings display. If all modules and DALLIS units are installed and operating correctly, then
they appear in grey:

If any components are not installed or connected, then a red/white cross in the System tree, and a red highlighted
card, shows the location of the problem. See Diagnosing System Errors.

You can also check the status LEDs on each unit’s front panel:

The ACTIVE LED on each Nova73 module, or DALLIS card, should blink in time with all other ACTIVE LEDs (at
1Hz). This shows that the card is synchronous to the rest of the system. If an LED is out of sync, then check that
the card is fitted correctly, and if the symptom persists, replace the card.

See also trouble-shooting for a list of example problems and fault-finding tips.
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Diagnosing System Errors

In the event of a component failure, a hazard warning flag appears in the title bar of the console GUI. Hover over
the warning triangle to view the last ten alarm messages. Messages in red indicate active alarms; messages in
yellow are resolved.

To interrogate further:

1. Press the SIGNAL button, located on the SCREEN CONTROL panel, to view the Signal Settings
display.

A red/white cross in the System tree, and a red highlighted card, show the location the problem.

2. If the fault is hidden within the System tree, follow the red warning flags and open each branch of the tree
to find the problem – in our example, a DALLIS card.

3. Open the DALLIS card further, and you will see grey/white crosses beside Signal In 1, Signal In 2, etc.
These show that the AES signals are no longer available:

3. Check and replace the card if necessary. 

Once all components are connected and work ing correctly, the red/white crosses disappear from the System
Settings display and the hazard warning flag in the title bar is cleared.
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System Settings

At this stage, you can also want to adjust the following System Settings from the console GUI:

· Wordclock Options - sample rate and system clock priorities.

· Level Options - reference level and headroom.

All System Settings are stored and recalled with productions. Therefore, any changes should be saved for
recall at a later date.
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Wordclock Options

This topic defines the system's sample rate and sync reference.

Sample Rate

The Max Sample Rate field is for display purposes only, and shows the highest sample rate available. Note that
the option to run at higher (96kHz or 88.2kHz) or lower (48kHz or 44.1kHz) sample rates is made within the 
AdminHD configuration and cannot be modified from the console. 

Higher sample rates use twice as much DSP resource as lower sample rates; this is reflected in the DSP
Configurations display. Higher sample rates also affect the crosspoint capacity of the routing matrix (8k² at
48kHz, or 4k² at 96kHz).

The Sample Rate option will change the operating frequency of the console. If the system is configured to run at
lower sample rates (by AdminHD), then you can select either 48kHz or 44.1kHz operation. If the system is
configured to run at higher sample rates, then you can select 96kHz, 88.2kHz, 48kHz or 44.1kHz operation. 

Warning

It is NOT recommended to change the sample rate unless you wish to use an external Wordclock reference
signal. If this is the case, then the frequency of the sync source MUST match the Sample Rate option. 

You should mute your loudspeakers when changing the Sample Rate option.

If your system includes RAVENNA Net devices, such as Lawo's A__line, then the sample rate of these
devices must be changed manually using the RAVENNA Web GUI.

Sync Source

The Nova73 offers a fully redundant clock source structure with the ability to lock to sync from an incoming MADI
or RAVENNA signal, one of the two external sync inputs or its own internal sync generator.

The Active Source field is for display purposes only, and shows the active synchronization source.

Information about each external sync source is shown in the lower part of the display; if a signal is not present or
invalid, then you will see N/A:

· Multichannel  – sync from an incoming MADI or RAVENNA port. The port must be defined using
AdminHD. For RAVENNA, this is either the "listening" port which will receive PTP clock from the network,
or the "transmitting" port if the Nova73 is operating as a PTP Master.

· Sync Port 1 – connected to the Nova73 rear panel (Wordclock, Video Black Burst or AES3-id).

· Sync Port 2 – connected to the Nova73 rear panel (Wordclock, Video Black Burst or AES3-id).
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The active sync source is selected automatically as follows: Multichannel - Sync Port 1 - Sync Port 2 -
Internal. In each case, the status of the sync source and the Ignore ... check boxes are taken into account.

For example, with a valid sync signal connected to all inputs and no Ignore ... check boxes selected, the system
will lock to the Multichannel sync port. If multichannel sync is lost or the signal is invalid, then the system
automatically switches to Sync Port 1. Similarly, if sync is lost on this port, then the system switches to Sync
Port 2. Finally, if sync is lost on all external ports, then the system switches to Internal. An automatic return
mode means that the system will switch back to Sync Port 2, 1 or Multichannel once a valid signal is detected.

To ignore an external sync source, enable its Ignore ... check box. For example, to skip the multichannel sync
source in the sequence, enable the Ignore Multichannel Input check box.

If the Error if Internal Sync check box is enabled, then an alarm will be triggered when the system switches to
internal sync. The alarm triggers the on-screen Warning flag and illuminates the red LED on the front panel of the
Nova73 Router Module.
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Level Options

This topic can be used to change the system's reference level, headroom or overload threshold. The levels affect
the maximum analogue level from your system according to the following equation:

· Maximum Analogue Level = Reference Level + Headroom

The system supports a maximum analogue level = +24dB, and a minimum analogue level = +12dBu.

Warning

Changing the Reference Level or Headroom options move the internal 0dB operating point for the system
and therefore will change the behaviour of any level dependent settings such as dynamics processing and
metering. Therefore, it is not advisable to alter these levels once dynamics processing has been set.

For systems fitted with fixed level analogue I/O cards:

· The Headroom and Reference Level cannot be altered independently. For example, with a
+15dBu fixed analogue I/O card and +9dB Headroom, the Reference Level must be +6dBu.

· The Maximum Analogue Level of the whole system is defined by the DALLIS card with the lowest
GDA (General Device Address) - this is the card with the lowest address fitted to the DALLIS frame
connected to the lowest port number of the first Nova73. (If a different fixed level analogue card is
fitted elsewhere within the system, then a warning appears in the log file; however, the card with the
lowest GDA still wins.)

Reference Level

Sets the reference level of your analogue interfaces in dBu. Reference level can be set from 0dBu to +24dBu,
depending on the Headroom.

Headroom

Sets the operating headroom to the external world; this is the difference between the analogue reference level and
digital full scale (0dBFS). Headroom can be set from 0dB to +20dB depending on the Reference level.

Note that the internal Headroom is more then 380dB which means, if you route from input to group to group to
sum, you can overdrive the level more then 380dB before clipping!
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Overload Threshold

Sets the overload threshold of your system relative to digital full scale. It can be set from -6dBFS to -0.5dBFS or
switched off.

Note that OVR is only indicated if you meter signals input to or output from the routing matrix. Internally, the
system headroom exceeds 380dB!

The diagram below shows the normal operating levels for DIN scale operation in Germany:

However, if you intend to work with the dBFS digital meter scale option, or an external AES meter, then you
should set the Reference Level equal to your maximum analogue level (e.g. +15dBu) and Headroom to 0dB as
shown below:

This ensures that the dBFS metering on the Channel display matches any external AES metering you may
have. But be aware that the internal 0dB operating level now equals 0dBFS. This means that you are responsible
for your own headroom. For example, if you still want a headroom of +9dB, then you will need to set your limiter
threshold points to -9dB, etc.
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Chapter 3: AdminHD

This chapter covers AdminHD, the Lawo software programme which runs on an external computer to provide

remote configuration of any mc2/Nova system.

Topics include:

· Overview

· AdminHD and mxGUI

· Compatibility

· Computer System Requirements

· Software Installation

· Connecting to the Lawo Control System 

· Configuration Files

· Operating Principles

· Core Configuration: First Steps

· Core Configuration: Defining the System

· Core Configuration: Editing Parameters

· Signal List Configuration

· Online Operation

· System Diagnostics

· Documenting the Configuration

· Core Configuration: Parameters

· mxDSP Configuration

· The Main Menus

· Preferences
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Overview

AdminHD is the Lawo software application used to configure all mc2/Nova systems.

It is responsible for generating the config.tcl and gui_config.tcl configuration files, which are read by the control
system at boot-up following a cold start. These files define the system components, and the console GUI's
Signal List display:

System Configuration Signal List Editor

The configuration files created by AdminHD are an essential part of the system. If a hardware component is not
defined within these files, then it will not be visible to the user even if it is powered and connected. In other words,
the configuration is always the ‘master’ of the system, regardless of what physical components are added or
removed. This brings a number of advantages:

· The configuration is always controlled by AdminHD. 

· You can configure components which may not be permanently connected (e.g. Stageboxes) so that
routes can be made to/from these devices without relying on a physical hardware connection.

· You can easily test changes to the configuration offline. If a component or parameter is not available
within the AdminHD software, then it is ‘illegal’. This allows you to prepare configuration updates offline,
and upload them to the system with confidence.

· AdminHD can connect to the control system of mxGUI. This allows you to open mxGUI using a pre-
prepared configuration in order to create user settings ahead of an event.
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AdminHD and mxGUI

mxGUI can run online to remotely control a real system. It emulates the GUI displays of the mc2 consoles,
providing control of virtually any user parameter. For more details on mxGUI, please refer to the "mc²56 MKII
Operators Manual".

Both programmes can run offline on your computer. This allows you to prepare a complete system ahead of an
event as follows:

1. Use AdminHD to define the Core configuration (config.tcl) and Signal List (gui_config.tcl).

2. Upload the configuration files from AdminHD to the mxGUI local control system on your computer.

3. Use mxGUI to prepare and save user settings (by saving a production). 

4. Once connected to the final system, you can use mxGUI to transfer both the configuration and
production(s) from your computer to the Lawo control system.
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Compatibility

AdminHD can configure, or connect to, any mc2/Nova system. When new hardware options or software features
are released, then a new version of AdminHD is also issued.

All Lawo products have a consistent software release numbering system to indicate compatibility. In each
case, the first three digits of the software version must match. 

So, to prepare a configuration or connect to a mc2 console running 5.10.2.0, you need to run AdminHD
5.10.2.x. 

You can check the software version of your mc2 system from the Global Options in the System Settings
display, and the version of AdminHD from the Info main menu.

Note that:

· Configurations saved by an earlier version of AdminHD can be opened in a later release. However,
configurations saved by a newer release are not backwards compatible.

· From Version 5.6.0 onwards, there is one AdminHD release which supports all mc2 and Nova systems.
(The separate AdminHD for Mixing Consoles and AdminHD for Nova73 & DSHS releases have been
merged.)
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Computer System Requirements

To install and run the AdminHD software, your computer MUST meet or exceed the following system
requirements:

Windows PC:

· Hardware: 500MHz.

· Operating System: Windows 7, 8, 8.1 or 10 (32-bit and 64-bit)

· RAM: 2GB.

· Hard Disc: minimum 200 MB free space.

· Operation: Keyboard and mouse.

· Interface: Ethernet 10/100Mbit.

MAC:

· Hardware: 500MHz.

· Operating System: MAC OS X 10.6 (Snow Leopard) or higher.

· RAM: 2GB.

· Hard Disc: minimum 200 MB free space.

· Operation: Keyboard and mouse.

· Interface: Ethernet 10/100Mbit.
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Software Installation

AdminHD is a free of charge application which does not require a software licence. The AdminHD installer is
packaged with the software release for your product which can be downloaded from the Lawo website at 
www.lawo.com (after Login).

Take care to download the correct version - the first three digits of the release must match that of your mc2/Nova
system. (You can check the software version of your console/router from the "Global Options" in the System
Settings display.)

You can install multiple versions of AdminHD on the same computer; there is no need to uninstall older
versions. This is particularly useful when working with systems running different releases of software.

1. Copy the AdminHD_Release_X-X-X-X.zip onto your computer and unpack the file.

2. Double-click on the relevant installer. 

AdminHD is delivered in a compressed format, so it can take a few seconds before you see the ‘Setup Wizard’:

When running Windows 7, you may be prompted to allow changes to your User Account; select Yes to
continue.

3. Follow the Wizard's instructions accepting the default options provided.

4. When you reach the 'Summary' window, check the options and click Install.

The software is installed onto your computer; this will take a few minutes. By default, files are installed in the
location: ‘C:\Program Files\Lawo/AdminHD X.XX’. where X.XX is the release version.

5. When the installation is complete, a confirmation window will appear.

6. Click on Finish to exit the ‘Setup Wizard’.

If you have any problems with the software installation, please contact your local Lawo representative or email
support@lawo.com.

http://www.lawo.com
mailto:support@lawo.com
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Additional Notes for MAC OS X Installation

If you are running MAC OS X 10.8.x.x (Mountain Lion), then you can see the following error message after
double-clicking on the "install.exe" file:

This error can appear if your "Gatekeeper.app" does not allow installation from downloads which are not from the
MAC App Store. To change this setting:

1. Select "System Preferences -> Security & Privacy" and set the "Allow applications downloaded
from:" as follows: 

2. Then retry opening the AdminHD "install.exe" file.
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Uninstall & Update

Uninstalling AdminHD

On Windows 7, use the “Uninstall a program” option within the Control Panel to uninstall AdminHD.

On MAC OS X, remove the programme from your "Applications" folder.

Updating AdminHD

To update to a newer version of AdminHD, simply run the installer; there is no need to uninstall older versions.
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Connecting to the Lawo Control System

In order to transfer configuration data, or run AdminHD online, you will need a valid network connection between
your computer and the mc²56 MKII control system.

1. Connect your computer to the Lawo system network.

2. Configure the TCP/IP settings on your computer's network interface card.

The control system location may vary, see Control System Locations.

You can open an existing AdminHD file, or create a new configuration, without this connection. However, it is
a good idea to configure the network now, so that you are ready to transfer data later.
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Checking the Network Communication

If this is the first time you have connected to the mc²56 MKII control system, then start AdminHD, create a new
session and then download the online configuration from the remote system:

If the connection is successful, then the 'Core Browser' updates to display the hardware components for your
system.

If the connection fails, then nothing appears in the 'Core Browser', and the ‘Remote Log’ reports that the
connection has timed out:

· Check the network connection and TCP/IP settings of your computer's network interface card. 

· Check that AdminHD is compatible with the mc²56 MKII system (the first three digits of the software
versions must match.)

· See also the trouble-shooting tips to resolve the problem.

Alternatively, if you have an existing AdminHD file, with the correct system IP address, then switch online to test
the network communication.
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Configuration Files

The diagram below illustrates how configuration data is stored on the mc²56 MKII control system, and which files
can be edited and saved on your AdminHD computer:
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Control System Cold Start Files

The following configuration files are stored on the mc²56 MKII control system, and are read after a cold start:

· config.tcl – this file, known as the Core configuration, defines the:

o Nova and DALLIS components.

o System-wide parameters such as sample rate, reference levels and sync options.

o Signal parameters such as the HLSD address, name, default label, I/O settings, silence detects and

mapping tables.

· gui_config.tcl – this file, known as the Signal List configuration, defines the Directories, Subdirectories
and signal organisation within the GUI’s Signal List display.

· custom.tcl – this file defines customer-specific functions.

· userconfig.tcl – this file defines the user monitoring functions in the mc2 console series.

· Custom_template_instances – this folder stores the custom functions programmed from the GUI’s
Custom Functions display. Each function is stored as a separate .tcl file.

The table below summarises which files can be edited by AdminHD and which must be factory-configured. Also,
whether files can be accessed by mxGUI and how they are named within mxGUI's File Transfer display:

Control System Filename

Edit in

AdminHD

File Transfer to 

mxGUI Appears in mxGUI as:

config.tcl ü ü Core Configuration

gui_config.tcl ü ü Signal List Configuration

custom.tcl û û n/a

userconfig.tcl û û n/a

Custom_template_instances û ü Custom_template_instances

Factory-configured files such as the custom.tcl and userconfig.tcl must be edited by Lawo personnel. If
you require further assistance to modify these aspects of the configuration, please contact your local Lawo
representative or email support@lawo.com.

mailto:support@lawo.com


mc²56 MKII Technical ManualV5.10.2/1102

Chapter 3: AdminHD
Configuration Files

AdminHD Files (on your computer)

AdminHD cannot edit the config.tcl and gui_config.tcl files directly. Instead, it downloads the online
configuration (running in memory) from the mc²56 MKII, and saves it locally onto your computer as a .csv or .slx
file. These file types can then be opened, edited and saved by any AdminHD computer.

Once editing is complete, you can choose to either update the online configuration (in temporary memory) or
export and upload new versions of the cold start .tcl files (recommended for permanent changes).

Organising Your Files

The following files are created by AdminHD and stored locally on your computer:

· config.csv - created when you save the AdminHD configuration. This is a .csv file which can be opened
by AdminHD or imported into a 3rd party editor such as MS Excel.

You can give this file any name as long as it keeps the .csv suffix. It is a good idea to keep "config" in the name
to distinguish it from other .csv files.

· signallist.slx - created when you save a Signal List from the ‘Signal List Editor’. This is a .slx file which
can only be opened by AdminHD.

You can give this file any name as long as it keeps the .slx suffix.

· config.tcl and gui_config.tcl - are the cold start configuration files exported from AdminHD. They are
stored locally on your computer, in preparation for an upload to the mc²56 MKII control system.

DO NOT rename these files, or edit them using an application other than AdminHD. Otherwise, they cannot be
read by the control system! If you wish to keep copies of ‘older’ versions, store them in a sub folder or change
the filename.

· systemlist.csv - can be exported to produce a parts list for the hardware defined within your configuration.
It is a .csv file which can be opened by a 3rd party editor, such as MS Excel, in order to print or view the
data.

· config.bfe - exported for use with a BFE controller system. For more details, please contact your local
Lawo representative or email support@lawo.com.

· remote.log - created when you save the contents of the ‘Remote Log’ window as a text file.

· system_log_message.log - can be downloaded from the  mc²56 MKII control system. 

Create a backup folder to store copies of the current configuration files before you begin editing.

When using both AdminHD and mxGUI, you could create a master folder for the system, with separate sub
folders for AdminHD and mxGUI.

mailto:support@lawo.com
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Operating Principles

This section covers the basic operating principles of AdminHD:

· Starting AdminHD

· The Main Operating Window

· Online/Offline Status

· The Main Toolbar

· The Sub Windows

· ‘Core Browser’

· 'Hardware Panel’

· ‘Parameter Box’

· 'Remote Log'

If you'd like some data to work with, then create a new session and download the online configuration from
the mc²56 MKII to your computer (recommended). Or, open an existing config.csv file.

If neither of these options are possible, create a new session and build a simple Core configuration from
scratch.
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Starting AdminHD

1. Start the programme, by selecting AdminHD from the START menu (Windows) or Applications folder
(MAC):

It is important to choose the correct software version (the first three digits must match the software running
on your remote system). If not, AdminHD will not be able to connect to the mc²56 MKII. Or, the system may
not read your configuration data. See Compatibility for details.

AdminHD starts up and opens the last configuration file (config.csv) you were working on:

The following dialogue pop-up appears if there is a mismatch between the AdminHD software version and the
configuration file you are trying to open:

· Select Yes to convert the configuration file to the newer AdminHD release.

· Select No to leave the file unchanged, and open AdminHD without any configuration data.

The ‘Core Browser’ and ‘Remote Log’ sub windows can open automatically (according to the Extras ->
Preferences -> Startup menu).

If this is the first time you have started AdminHD, or a file could not be loaded, then AdminHD opens with a
completely empty operating window.
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The Main Operating Window

1 Headline Displays the file path of the open file (e.g. Studio1_config.csv). If no filename
appears, then this is a new AdminHD session. If the filename is followed by an
asterisk (*), then changes have been made since the last save.

On the right you can close the programme or minimise/maximise AdminHD in the
usual manner.

2 Main Menus Access to the File, Remote, Extras, Window and Info main menus.

3 Main Toolbar Fast access to common functions.

4 Sub Windows This is the main operating area in which you can open a mixture of sub windows. In
our example, only the 'Core Browser' is open.

5 Status Bar Displays the AdminHD mode (e.g. mc2 console) and online/offline status.
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Online/Offline Status

AdminHD starts up in offline mode; the online/offline status is shown in the status bar at the bottom of the
display:

Offline

When running offline, you can:

· Download configuration data (from the online system to your computer).

· Edit the configuration data, locally on your computer in AdminHD.

· Export and upload cold start configuration files (from your computer to the mc²56 MKII control system).

Note that to download and upload data, you will need a valid network connection between your AdminHD
computer and the mc²56 MKII control system.

Online

You should switch to online mode if you wish to:

· Monitor the system status.

· Update the online configuration (in memory).
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The Main Toolbar

The first six buttons provides fast access to common functions:

1 Open Opens an existing AdminHD file (config.csv).

2 Save Saves the current AdminHD configuration as a config.csv file.

3 Download Downloads configuration data from the online control system into AdminHD.

4 Upload Uploads the AdminHD configuration to the online system (available in online mode
only).

5 Online Enables (or disables) the online connection to the remote control system.

6 Preferences Opens the AdminHD Preferences window.

The remaining buttons show or hide the sub windows. 



mc²56 MKII Technical ManualV5.10.2/1108

Chapter 3: AdminHD
Operating Principles

The Sub Windows

The following sub windows can be opened from the main toolbar, the Window menu, or by using a keyboard
shortcut:

Toolbar Window menu & Keyboard Shortcuts

7 Core Browser Displays the Core configuration hardware as a system tree. You can navigate
around the system, and add or remove components. When running online,
components are colour-coded to provide diagnostics.

8 Parameter Box Used to adjust parameters for the selected component or signal.

9 Hardware Panel Provides a graphical representation of the system. Works in conjunction with
the 'Core Browser' to add or remove system components. When running online,
components are colour-coded to provide diagnostics.

10 Signal List Editor Creates the Signal List configuration used in the GUI’s Signal List display.

11 Remote Log Logs all the messages generated by AdminHD and, when online, the mc²56
MKII control system.

Some selections may be unavailable (greyed out). For example, the 'Hardware Panel' can only be selected
once a valid system component is selected.

The ‘Core Browser’ and ‘Remote Log’ can open automatically (according to the Extras -> Preferences ->
Startup menu).
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Arranging the Sub Windows

The sub windows are rarely used in isolation, and should be combined according to the application. For example,
while editing a configuration, you can open the 'Core Browser', 'Hardware Panel', 'Parameter Box' and 'Remote
Log':

Sub windows can be closed, minimised, resized or moved as follows:

1. Click on  to close a window.

2. Click on  to minimise a window.

Minimised windows are reduced to a button, for example:

Click on the button - e.g. Core 1 - to restore the window to its original size and position.

3. To change the size of a window, point to the relevant margin or corner, and drag left/right or up/down
accordingly.

4. To move a window, place the mouse pointer over the title bar of the window. Then drag and drop the
window to its new position.

The ‘Core Browser’ cannot be minimized or moved.

The ‘Hardware Panel’ cannot be resized.
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'Core Browser'

The ‘Core Browser’ displays the Core configuration using a hierarchical system tree. It can be used to navigate
around the system, add or remove components, and monitor their status (when online).

1. Click on  from the main toolbar to show the ‘Core Browser’.

Or select Window -> Core browser (from the main menus) or press CTRL + SHIFT + B (on your computer
keyboard).

The System tree appears as you last left it. When running online, components are colour-coded to provide
diagnostics:

2. Click on the + or – signs to open or close a branch of the system tree. Or, use the arrow keys on your
computer keyboard:

· Up/Down - navigate up/down.

· Left/Right - open/close the selected branch.

3. Hover over an individual signal (e.g. Signal In 1) to display its parameters.

4. Right-click on a component to reveal its configuration options.

Signal Parameters Summary Right-click Options
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The System

The System structure is hierarchical and is arranged as follows:

System Each configuration consists of a single System containing all the
hardware components for your installation.

Core Within the System, you define the Core.

Modules Next, you fit the Core with Modules. 

In our example, Core 1 is fitted with two MADI Modules, and
three DSP Modules. 

Standard components, such as the Router module, main PSU
and Redundant PSU are added automatically when you define
the Core.

Ports Each Module can then be opened to view its I/O Ports:

In the case of a MADI or RAVENNA module, the ports offer a
range options (for example, to connect to a DALLIS or operate as
Tie-Lines).

Cards Each DALLIS can then be fitted with Cards. In our example, you
can see the MIC, AES3 and LINE cards fitted to the DALLIS
connected to Module 2, Port 1.

Signals At the lowest level of the system tree are the signals themselves
– in our example, Card 1 has been opened to reveal the four
mic/line input signals (Signal In 1 to 4).
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The Core Browser Toolbar

At the top of the 'Core Browser' are a number of useful functions. 

The first two buttons help with system navigation:

1 Collapse all Hides all sub nodes within the selected branch.

2 Expand all Shows all sub nodes within the selected branch.

The next four buttons can be used when editing the Core configuration:

3 Copy Copies the selected component and its sub entries.

4 Cut Cuts the selected component and its sub entries

5 Paste Pastes the copied component, with sub entries, to the selected branch of the system. 

6 Delete Deletes the selected component and its sub entries

The last button can help identify system components:

7 Alias Displays your device alias names rather than the Lawo system names.
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‘Hardware Panel’

The ‘Hardware Panel’ provides a graphical representation of the system. It works in conjunction with the 'Core
Browser' to define the Core configuration and monitor system status (when online).

1. Open the 'Core Browser' and select a component other than the System - e.g. Core 1.

2. Click on  from the main toolbar to show the ‘Hardware Panel’.

Or select Window -> Hardware Panel (from the main menus) or press CTRL + SHIFT + F (on your computer
keyboard).

A pictorial representation of the selected component appears. (When running online, components are colour-
coded to provide diagnostics.)

The ‘Hardware Panel’ cannot be opened if System is selected (as there is no valid hardware component to
display!) In addition, the ‘Hardware Panel’ will close automatically if you select System in the 'Core Browser'.

3. Click on a module in the 'Hardware Panel', and the system tree selection (in the ‘Core Browser') follows. 

4. Similarly, select a different component in the ‘Core Browser', and the 'Hardware Panel' updates.
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5. Right-click on a Module slot (within the Core), or a Card slot (within a DALLIS), to reveal its configuration
options:

Core Module Options DALLIS Card Options
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‘Parameter Box’

The ‘Parameter Box’ is used to adjust settings for the selected component or signal. It works in conjunction with
the 'Core Browser' and 'Hardware Panel' to define the Core configuration.

1. Open the 'Core Browser' and double-click on a component or signal - for example, Signal In 1.

Alternatively, select the component or signal, and click on  from the main toolbar to show the ‘Parameter
Box’.

Or select Window -> Parameter box (from the main menus) or press CTRL + SHIFT + P (on your computer
keyboard).

Once the 'Parameter Box' is open, if you make a different selection (in the ‘Core Browser' or 'Hardware
Panel'), then the 'Parameter Box' follows.

2. Use the tabs to select a page - e.g. Signal, DSP, Map.

· White parameter fields (e.g. Signal name, Signal label, Group) can be edited.

· Grey parameter fields are usually for information purposes and cannot be modified.

· Check boxes can selected or deselected.
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'Remote Log'

The 'Remote Log' lists all the messages generated by AdminHD and by the mc²56 MKII control system (when
online). It is a good idea to open this window when transferring data to or from a system, or running online.

1. Click on  from the main toolbar to show the ‘Remote Log’.

Or select Window -> Remote log (from the main menus) or press CTRL + SHIFT + L (on your computer
keyboard).

The log displays all errors and queries since AdminHD was started:

2. Scroll up the list to view the log history.

The ‘Remote Log’ stores all messages while AdminHD is running. If you exit AdminHD and re-open it, then the
previous log is lost.

To save the log contents:

3. Right-click anywhere within the window, and select Export content.. (or select File -> Export File ->
Remote Log):

A File -> Save dialogue box appears.

4. Choose a folder, enter a filename and click Save.

The log is stored as a plain text file and can be opened by any common text editor.

You can specify a default directory for your logfiles from the Extras -> Preferences -> Directories menu.

To clear the log contents:

5. Right-click anywhere within the window, and select Clear content.. 

The existing contents of the ‘Remote Log’ are cleared.
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Core Configuration: First Steps

This section deals with how to edit and update the Core configuration. The best approach is as follows:

1. Create a new AdminHD session and, if possible, download the online configuration from the mc²56 MKII
control system.

Alternatively, if you can't connect to the mc²56 MKII, open an existing config.csv file. This can be a file which
you saved earlier or requested from your configuration engineer.

If you have neither a network connection or an existing config.csv file, then you will need to create a new
session and build a configuration from scratch. Note that this method can be time consuming, and is not
recommended for minor changes to an existing system!

2. Save the configuration as a config.csv file - this allows you to open it later, or move it to another
AdminHD computer.

3. Define the new system components and edit their parameters using the 'Core Browser', 'Hardware Panel'
and 'Parameter Box'.

4. Check the configuration for programming errors.

5. Backup the system's existing cold start files.

6. Export the configuration as a cold start config.tcl file - this puts the data into a format which can be read
by the control system.

7. Upload the cold start config.tcl from your computer to the mc²56 MKII control system.

8. Cold start the mc²56 MKII to see your changes take affect.

As an alternative to exporting and uploading the config.tcl file, AdminHD can update the online configuration
(in temporary memory). However, this is not recommended for permanent changes to a configuration.

Workflow Suggestions:

Both the config.csv and config.tcl files can be transferred between computers. This allows you to download and
save the configuration (as a config.csv) on a networked AdminHD computer; open it on your personal AdminHD
computer (for editing); export the config.tcl and transfer this back to the networked computer (for upload to the
control system).

If you are also editing the Signal List configuration, then download and save both sets of data (config.csv and
signallist.slx) while you are connected to the control system. Once editing is complete, export both cold start
files (config.tcl and gui_config.tcl), and upload them to the control system. You can then perform a single cold
start to action all your changes.
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File -> New

This menu option creates a new empty AdminHD session. It should be used before downloading data into a new
session, or to build a new configuration from scratch.

1. Select File -> New from the main menus, and choose the system you wish to configure:

Mixing Consoles:

· mc2 console - choose this option for a mc256 or 66 mixing console.

· mc236 console or mc236 console (96kHz) - choose one of these options for a mc236 mixing console*.

Matrix:

· Nova73 HD - choose this option for a Nova73 HD routing matrix.

· Nova37 or Nova37 (96kHz) - choose one of these options for a Nova37 routing matrix*.

· MicroCore or MicroCore (96kHz) - choose one of these options for a mc2 MicroCore*. 

* If you are building a new configuration from scratch for a mc236, Nova37 or MicroCore, take care to choose the
correct option for the maximum sampling rate (either 48kHz or 96kHz), as you cannot change this option later.

Note that the maximum sampling rate for a mc2 console or Nova73 HD configuration is defined later when you
add the system Core.

2. If you have not closed your previous AdminHD session, then the following dialogue box appears - select
Yes to save the configuration (as a .csv file) before proceeding, or No to continue without saving:

The new configuration opens.
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If you selected mc2 console or Nova73 HD, then you will see the entry System in the ‘Core Browser’ and
confirmation of the system type in the status bar.

If you selected one of the mc236 console, Nova37 or MicroCore options, then the standard configuration for that
system appears - for example:
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Downloading the Online Configuration

The best way to ensure that you are working with your system's latest configuration data, is to download the
online configuration, from the mc²56 MKII control system.

To perform a successful download, you will need a valid network connection between your computer and the
control system.

We recommend running AdminHD offline, to avoid accidentally clicking the Upload button.

Open the 'Remote Log' to monitor the progress of the download. 

1. When you download the online configuration, you will download the current data stored in memory.
Therefore, to make sure this data is identical to the cold start configuration, reset the system by performing a
cold start.

2. Once the system has cold started, open a new AdminHD session (File -> New). 

This step ensures that you will be asked for the IP address of the Remote connection below. If you miss this
step, then AdminHD will attempt to connect to the IP address configured in your current session.

3. Then click on  from the main toolbar (Download all data from remote HD).

Or select Remote -> Download all data from remote HD (from the main menus) or press CTRL + D (on your
computer keyboard).

The following pop-up appears requesting an IP address for the Remote connection:
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4. Enter the IP address of your control system.

If a single Router Module is fitted, then enter the main IP address only.

If main and redundant Router Modules are fitted, tick both boxes and enter both IPs; the redundant IP
address is always 1 above the main IP address.

Router Module Redundancy

You can connect AdminHD to mxGUI by entering mxGUI's virtual IP address (192.168.56.101).

5. Then click on Connect.

AdminHD downloads the online configuration data from the remote system; the 'Remote Log' shows the progress.

When the download is complete, any open windows such as the ‘Core Browser’ update to show the new
configuration:

If there is a problem with the download, then:

· Check the network connection and TCP/IP settings of your computer's network interface card. 

· Check that AdminHD is compatible with the mc²56 MKII system.

· See the trouble-shooting tips.
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Opening a Saved Configuration

To open an existing config.csv file:

1. Click on  from the main toolbar.

Or select File -> Open (from the main menus) or press CTRL + O (on your computer keyboard):

Use File -> Open recent to select a recent configuration.

2. Select your file and click Open.

If the file was saved in an older version of AdminHD, then you will be asked to convert it.

The file opens, and the path and file name appear at the top of the display:

You can decide whether the 'Core Browser' appears automatically from the Extras -> Preferences -> Startup
menu.

If there is a problem opening the file, then check:

· Is the file an AdminHD .csv ?

· Was the file saved by a newer release of AdminHD?

Configurations saved by an earlier version of AdminHD can be opened in a later release. However,
configurations saved by a newer release are not backwards compatible.
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Saving the Configuration

Having downloaded or opened an existing configuration, it is a good idea to save the data as an AdminHD
config.csv file. This creates a copy, in AdminHD format, which can be opened later, or moved to another
computer.

1. Select either File -> Save, or File -> Save As from the main menus:

· File -> Save overwrites the current file name (if one exists).

· File -> Save As asks for a new file name:

2. Select a path and enter a suitable file name. 

You can use any name as long as it keeps the .csv suffix, but it is a good idea to keep the word "config" in
the name to distinguish it from other .csv files. See Organising Your Files.

You can also specify a default directory for your config files from the Extras -> Preferences -> Directories
menu.

3. Click Save to save the configuration onto your computer’s hard disk.

4. From here on, you can quickly update the file by clicking on  (from the main toolbar) or pressing
CTRL + S.

If you are making a lot of configuration changes, use File -> Save As to save different versions during the
programming. This will allow you to revert to an earlier version, if there is an error in your programming.
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Editing the Configuration

You can edit the Core configuration using the 'Core Browser', 'Hardware Panel' and 'Parameter Box' windows. The
details are covered later in this chapter, please see:

· Defining the System - to add or remove components, or modify the System structure.

· Editing Parameters - to adjust system or signal parameters.

Nova73 HD - Defining the Modules Nova73 HD - Editing Signal Parameters
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Checking the Configuration

Having completed your AdminHD configuration, it is a good idea to check it for programming errors. This will avoid
any problems later when you upload to the system.

1. Select Extras -> Check Configuration from the main menus, or press CTRL + K on your computer
keyboard:

AdminHD analyses the configuration to check for the following errors:

· Signal HLSD Conflicts – if two signals have the same HLSD (Lawo system address).

· HLSD Syntax – if there is an invalid HLSD in the configuration.

· Signal Name Conflicts – if two signals have the same name.

· Mapping Table Address Conflicts – if you have assigned the same mapping table address to different
signals.

The result of the check is displayed within the status bar of the display:

If an error is reported, then try retracing your steps by opening an earlier version of the config.csv.
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Backing up the Cold Start Files

Before uploading new data, it is a good idea to backup the system's cold start configuration files.

To perform a successful download, you will need a valid network connection between your computer and the
control system.

1. Select Remote -> Download file from the main menus, and click on a file option:

· Core cold start config (config.tcl) – the cold start Core configuration.

· GUI cold start config (gui_config.tcl) – the cold start Signal List configuration.

· System log messages - the control system log file.

2. You are asked to specify a folder location and name for the file - in our example, we have chosen the
Studio 2 folder created earlier, and have renamed the file as BACKUP_config.tcl, see Organising Your Files.

3. Click Save.

AdminHD downloads the file from the remote system; the 'Remote Log' shows the progress.

4. Repeat for each file you wish to backup.
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Upload Options

The Core configuration can be uploaded to the mc²56 MKII in one of two ways:

For permanent changes, you should upload a new version of the cold start config.tcl file. This file will be stored
on the mc²56 MKII control system, and read following a cold start. Note that this method requires three stages:

· Export the configuration as a config.tcl file.

· Upload the config.tcl file from your computer to the mc²56 MKII control system.

· Cold start the mc²56 MKII.

For temporary changes, or for installations where a cold start is not possible, you should upload your data to the 
online configuration. This updates the online system without requiring a restart; AdminHD must be running online
to use this method.

The next few sections work through both options.

Before uploading new data, it is a good idea to backup the system's cold start configuration files.
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Exporting the Cold Start config.tcl

This operation exports the Core configuration from AdminHD, and puts it into a format which can be read by the
mc²56 MKII control system - the config.tcl.

1. Select File -> Export file -> Core cold start config (config.tcl) from the main menus:

2. You are asked to specify a folder location for the file - in our example, we have chosen the Studio 2
folder created earlier, see Organising Your Files.

Do NOT rename the file; it must be named config.tcl in order to be read by the control system.

You can specify a default directory for your Coldstart config files from the Extras -> Preferences ->
Directories menu.

3. Click Save - the configuration is exported from AdminHD and saved on your computer.
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Uploading the Cold Start config.tcl

Having exported the config.tcl file, it can now be uploaded to the mc²56 MKII control system.

You can use this operation to upload any config.tcl file. For example, a backup file, or a file prepared on
another AdminHD computer.

To perform a successful upload, you will need a valid network connection between your computer and the
control system.

AdminHD can remain offline to upload cold start configuration files.

If you have a redundant Router Module, then you will need to disable the redundant control system BEFORE
uploading the config.tcl file, see Upgrading the Configuration in a Redundant System.

1. Select Remote -> Upload file -> Core cold start config (config.tcl) from the main menus:

2. Then select the config.tcl file you wish to upload:

3. Click Open - the file is uploaded to the remote system's cold start data; the 'Remote Log' shows the
progress:

If there is a problem with the upload, then:

· Check the network connection and TCP/IP settings of your computer's network interface card. 

· See the trouble-shooting tips.

4. Cold start the mc²56 MKII to see your changes take affect.
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If there is a problem reading the new configuration after the cold start:

· Check that you have uploaded the correct config.tcl file - the file MUST be named config.tcl and MUST
have been created using a compatible version of AdminHD.

When uploading a config.tcl to mxGUI, you should treat the mxGUI control system like any real mc2 or
Nova. In other words, upload the file (as above), and then cold start mxGUI.
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Uploading Data to the Online Configuration

For temporary changes to the Core configuration, or for installations where a cold start is not possible, you should
upload your data to the online configuration. This updates the online system without requiring a restart and can be
useful for testing, or updating systems where a cold start is not possible (for example, if 24 hour continuous
operation is required).

The online configuration is stored in the system's warm start data (at shutdown), and recalled following a normal
restart (warm start). Providing you do not cold start the system, any changes made will remain intact.

Only the Core configuration can be modified in this manner (you cannot update the Signal List or
Console Configuration).

Warm start data is temporary. Therefore, this method is NOT recommended for permanent changes to the
configuration. If the control system is 'cold started', then it reads the config.tcl file, and any changes to the
online configuration will be reset.

To upload your current AdminHD session to the online configuration:

1. Enable online mode, by clicking on  from the main toolbar (Online to remote system).

AdminHD now connects to the remote system and compares the online configuration to the one open in
AdminHD. When the analysis is complete, an 'Upload summary' appears:

This list allows you to review the changes which you are about to make BEFORE you continue with the upload.

2. Read through the list and click on Upload to continue (or Cancel to abort the upload).

The 'Remote Log' shows the progress of the upload; after a successful upload, the system immediately updates.
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Core Configuration: Defining the System

This section looks at adding or removing components to/from the Core configuration - for example to add a new
DALLIS or plug-in card.

To change parameters for existing components or signals, skip straight to Editing Parameters.

The same principles apply whether you are updating an existing configuration or building a new system from
scratch. The system is hierarchical, and therefore components must be added in the following order. Note that

steps 1 and 2 do not apply to the mc236, Nova37 or mc2 MicroCore, as both the Core and its modules are
predefined when you start a New configuration.

1. Define the Core.

2. Fit modules to the Core.

3. Define the I/O ports: for example, to configure a DALLIS, Compact I/O, Virtual Device or Tie-Lines.

4. Fit cards to a DALLIS.

5. Define other options such as Link and Port redundancy, and Port DSP resources.

You should open both the 'Core Browser' and 'Hardware Panel' to perform these tasks.

Warning

It is vital that the configuration matches your intended physical installation. Otherwise components may not
operate correctly. Therefore, it is useful to have the specification details (part numbers and options) to hand.
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Defining the Core

The first step when configuring a new mc2 console or Nova73 system is to add the Core. 

Note that for mc236, Nova37 or mc2 Micro Core systems, the Core is predefined when you setup the system
(using File -> New). 

1. Select the System entry in the ‘Core Browser’ and right-click. A list of drop-down options appears:

2. Select an option to define the type of Core:

· HD Core (48kHz) or (96kHz) - adds a Nova73 HD fitted with the Router Module MKII (980/33), operating
at a maximum sampling rate of either 48kHz or 96kHz.

· Compact Core (48kHz) or (96kHz) - added a Nova73 Compact fitted with the Router Module MKII
(980/33), operating at a maximum sampling rate of either 48kHz or 96kHz.

The selected Core is added to the System tree, along with its standard components: Router module, PSU and
Redundant PSU, and Resources.

Nova73 HD Nova73 Compact

You can decide whether the 'Hardware Panel' appears automatically from the Extras -> Preferences -> Common
menu.
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If you want to change the Core, then you will need to delete it and make a new selection:

3. Select Core 1 in the 'Core Browser', right-click and select Delete:

You are asked to confirm - Yes or No.

4. Select Yes to remove the Core, and all of its sub components, from the configuration. You can now return
to step 1 to make a new selection.

Warning

Once you have defined the Core, you CANNOT change the type later. So take care to select the correct
option before continuing!
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Fitting Modules to the Core

Next, fit your I/O and DSP modules to the Core, using the ’Hardware Panel’ as follows.

Note that for mc236, Nova37 or mc2 Micro Core systems, the I/O and DSP modules are predefined when you
setup the system (using File -> New). 

1. Right-click on a module slot - e.g. Slot 4 - and select a drop-down option:

Nova73 HD Nova73 Compact

The available options depend on the selected slot; you cannot configure an illegal option (they are "greyed out"). 

To fit channel DSP modules (983/03 or 04), you must work from right to left across the core - for example,
assign slot 15 first, then slot 13, slot 11, and so on.

Once assigned, the fitted modules appear within the ‘Hardware Panel’ and ‘Core Browser’.

2. To remove a module right-click on the 'Hardware Panel' slot and select Empty.  Or, go to the 'Core
Browser', right-click on the module and select Delete:

3. Select Yes to remove the Module, and all of its sub components, from the configuration.
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4. For the Nova73 HD, you can right-click on the second PSU to add or remove the redundant power supply:

Warning

Take care to fit each module so that it matches the exact slot position, and part number, of your physical
installation. Otherwise, the module may not operate correctly.



mc²56 MKII Technical Manual V5.10.2/1 137

Chapter 3: AdminHD
Core Configuration: Defining the System

Fitting a Redundant Router Module

On a mc2 console or Nova73 system, you can add a redundant Router Module:

1. Right-click on the redundant Router Module slot and select available:

The module is added to the 'Hardware Panel' and 'Core Browser':

Note that the type of Router Module is automatically configured (to match that of the existing module).

You can also add or remove a redundant Router Module from the ‘Core Browser’, or 'Parameter Box':

'Core Browser' 'Parameter Box'
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Defining the I/O Ports

Each I/O module can now be opened within the ‘Core Browser’ to view its ports.

In the case of an AES3 module, the port is predefined and can be opened to access the AES input and output
signals.

In the case of a MADI, RAVENNA or DANTE module, the ports require further configuration. For example, a MADI
port can connect to a DALLIS, operate as Tie-Lines to/from an external device, connect to the Lawo Plugin
Server, etc.

1. Select the Port in the ‘Core Browser’ and right-click:

The drop-down options vary depending on the module type (MADI, RAVENNA or DANTE) and the AdminHD mode
and software release. They are covered in more detail on the next page. 

2. Select an option - for example, a DALLIS. The selection is added to the 'Core Browser':

If you want to change the function of a port, then you will need to delete the current assignment - for example,
right-click on a DALLIS in the 'Core Browser' and select Delete:

You are asked to confirm - select Yes to remove the assignment, and all of its sub components, from the
configuration. You can now return to step 1 to make a new selection.
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I/O Port Options

MADI

For a MADI port, you can choose:

· DALLIS - adds either a 3RU or 6RU DALLIS frame with 60 or 52 audio channels + DSP resources.

· Tie-Line - adds a number of tie-line channels for connecting to and from an external MADI device. You
can choose either 64 audio channels only, or 56 audio channels + DSP resources.

· Local I/O - adds a connection to the Local I/O frame (used in mc256 systems) + DSP resources.

· Plugin Server - a special connection for the optional Lawo Plugin Server.

RAVENNA

For a RAVENNA port, the options define both the type of connection - RAVENNA Net [RV] or RAVENNA Link
[RVL] - and the port's function - DALLIS, Tie-Line, etc.

Note that, from Version 5.8.2 onwards, a single 981/61 module can support a mixture of RAVENNA Net and
RAVENNA Link ports. This is known as RAVENNA "mixed mode" and is indicated by the [MX] port suffix in the
'Core Browser'. Once an [MX] port is defined, the suffix updates to either [RV] or [RVL] to indicate the type of
connection.

For each RAVENNA MX port, you can choose:

· DALLIS 3RU RV + virtual port - adds a single 3RU DALLIS frame with 64 audio channels, plus a virtual
port which can be configured for a second 64-channel DALLIS frame. Both devices must connect via
RAVENNA Net (RV). See DALLIS Virtual Ports.

· RAVENNA Link - the following options must connect via RAVENNA Link (RVL):

o DALLIS - adds either a 3RU or 6RU DALLIS frame with 128 audio channels.

o Tie-Line - adds 128 tie-line channels for connections to and from an external RAVENNA Link device.

o Local I/O - adds a connection to the Local I/O frame (used in mc256 systems).

o Compact I/O - adds a connection to the Compact I/O stagebox.

· RAVENNA - the following options must connect via RAVENNA Net (RV):

o DALLIS - adds a 3RU DALLIS frame with 128 audio channels.
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o Tie-Line - adds 128 tie-line channels for connections to and from RAVENNA streaming devices (e.g.

Lawo sapphire; crystal; R?LAY; third-party devices).

o Local I/O - adds a connection to the Local I/O frame (used in mc256 systems).

o Compact I/O - adds a connection to the Compact I/O stagebox.

o Virtual Devices - adds 16 x 8-channel Virtual Device slots (for Lawo's A__line or other supported

devices). See Virtual Device Ports.

Take care to choose the correct type of connection IF your device supports both RAVENNA Net and
RAVENNA Link.

Note that there are no DSP resources for RAVENNA I/O ports.

DANTE

For a DANTE port, there is only one option:

· Tie-Line - adds 64 tie-line channels for connecting to and from an external DANTE device.
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I/O Port Definitions

Port -> DALLIS

For a DALLIS port, the DALLIS master board is configured automatically (according to the connection type: MADI
or RAVENNA):

You can now populate the frame, see Fitting Cards to a DALLIS, and configure its DSP resources (if available).

Port -> Tie-Line

For a Tie-Line port, the MADI, RAVENNA or DANTE signals are added to the Port:

You can now edit the individual signal parameters, see Editing Parameters.
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Port -> Plugin Server

This option configures a special 64-channel connection for the optional Lawo Plugin Server:

Note that this is NOT the Waves MultiRack SoundGrid Plugin Server supported from V5.6 onwards. To
configure the Waves Plugin system, you should configure a normal MADI Tie-Line. Please see the separate

"Waves Plugin Server for mc2 User Guide" for details.

Port -> Local I/O

This option configures the Local I/O resources, supported by the mc256 MKII:

The signals appear in a similar manner to DALLIS plug-in cards. However, you cannot change the Local I/O
card arrangement, as this is determined by the physical board fitted to the control surface!
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Port -> Compact I/O

This option configures a Compact I/O stagebox:

As for the Local I/O, you cannot change the I/O card arrangement, as this is determined by the physical
boards fitted to the stagebox!
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DALLIS Virtual Ports (RV only)

A single 981/61 RAVENNA Net port can connect to either one 128-channel or two 64-channel DALLIS frames. To
configure the latter:

1. Right-click on the RAVENNA streaming port and select the DALLIS 3RU RV + 1 x virtual port ->
Define DALLIS 3RU (64/64 channels):

This adds the first 64-channel DALLIS frame plus a new virtual port (Port 5 RV Virtual):

2. Right-click on the virtual port to add the second DALLIS frame:

You can now add the DALLIS I/O cards to each frame in the usual manner.
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Virtual Devices (RV only)

A single 981/61 RAVENNA Net port can connect (virtually) to up to 16 devices. To configure the connection(s):

1. Right-click on the RAVENNA streaming port and select the RAVENNA -> Define Virtual Devices
(128/128 channels) option:

A Virtual Devices port, supporting 16 x 8-channel virtual slots, is added to the configuration.

2. Right-click on the Virtual Devices port, and select a device from the Slot x options:

For the A_mic8, A_dig8, DMI-8 or LCU, you can now select the device within the 'Core Browser' and use its
'Parameter Box' to prepare the 8-channel streaming connection. Note that, in addition to streaming audio,

parameters within a virtual device can be controlled from the mc2/Nova system - for example, to adjust the mic

gain within an A__mic8 from an mc2 console. The available parameters and their method of control is explained
fully in the mc2/Nova Operators Manual.

Alternatively, choose the Tie Line option to prepare a generic 8-channel streaming connection. This can be used
to stream audio only, without parameter control, to and from any RAVENNA-compatible node on the network.

3. Repeat to configure the remaining virtual slots. 

Note that you can use any the 16 virtual slots in any order, as it is the RAVENNA streaming port IP address and
role name that makes the virtual connection to the system.
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Fitting Cards to a DALLIS

Cards are fitted to a DALLIS in a similar manner to fitting modules to the Core:

1. Right-click on a card slot and select a drop-down option:

The available options depend on the DALLIS Masterboard, the selected slot and the capacity of the DALLIS; you
cannot configure an illegal option.

2. Right-click on PSU 2 to add or remove a redundant power supply:

You can check how many audio channels are left by looking in the title bar of the DALLIS frame.

The DALLIS master board type cannot be altered (as this is configured automatically when you define the
Core's I/O Port).

Warning

Take care to fit each card so that it matches the exact slot position, and part number, of your physical
installation. Otherwise, the card may not operate correctly.
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Copy, Cut & Paste

If you are fitting several components of the same type, then you can use copy, cut and paste.

For example, you may be fitting several MIC cards to a DALLIS, or connecting several DALLIS (with the same I/O
configuration) to the Nova73. Or, you may need to move a DALLIS card from one slot position to another.

Note that all sub components and parameters are copied. Therefore, you may wish to configure the DALLIS or
card completely (including any parameters), before using copy, cut and paste.

Copy & Paste from the 'Hardware Panel'

1. Right-click on the source DALLIS card and select Copy:

The card is copied to AdminHD's clipboard; the address is shown in the status bar at the bottom of the display:

2. Then right-click on the destination card slot and select Paste:

The card, and all of its parameters, are pasted into the configuration.

3. Repeat step 2 to quickly assign the same card to a number of slots.

4. Select Cut (in step 1) to move a card to a different slot.

Note that Paste is only available if you select a valid destination. For example, if the DALLIS runs out of
audio channels, then you will not be able to select Paste.



mc²56 MKII Technical Manual V5.10.2/1 149

Chapter 3: AdminHD
Core Configuration: Defining the System

Copy & Paste from the 'Core Browser'

1. Right-click on the source component - for example, a complete DALLIS - and select Copy:

The device is copied to AdminHD's clipboard; the address is shown in the status bar at the bottom of the
display:

2. Then right-click on the destination Port and select Paste:

The DALLIS, including all of its cards and parameters, are pasted into the configuration.

3. Repeat step 2 to paste the same DALLIS configuration to multiple ports.

4. Select Cut (in step 1) to move a DALLIS to a different port.

Note that Paste is only available if you select a valid destination. For example, you can only paste a MADI
DALLIS to another MADI port.
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Deleting Components

Depending on the component, it can be deleted either from the ‘Core Browser’ or ‘Hardware Panel’, see Defining
the Core and Fitting Modules to the Core.

Warning

Deleting a component, removes it and all of its sub components, from the configuration. Therefore, if you
wish to keep parts of an existing configuration, use Copy, Cut & Paste.
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Port Redundancy

For crucial interconnections between say a DALLIS and mc2/Nova I/O Module, you can specify link & port
redundancy. 

To configure port redundancy, two master boards are fitted to each DALLIS. Each connects to a different

mc2/Nova port (preferably on a different module). AdminHD can select which I/O port is used for the redundant
connection as follows.

Note that to support this feature, your system must be fitted with two master boards per DALLIS, plus

enough spare I/O ports in the mc2/Nova to support the connections.

From Version 5.10.0, this feature can be selected for devices connected via MADI, RAVENNA Link or
RAVENNA Net.

Let’s take an example, where the main connection to the DALLIS is from Module 4 Port 1. We have a spare port
on Module 8 Port 1 which we want to use for the redundant connection:

1. Select Module 4 Port 1 and double-click to open its ‘Parameter Box’.

2. Tick the Is redundant option.

The following pop-up appears:

3. Select the redundant port – in our example, Module 8 Port 1 and click OK.
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The ports are now linked as indicated in the ‘Core Browser’:

And the ‘Parameter Box’ for Module 4 Port 1 shows the address of the linked port within the Corresponding
port box. This is described as a system address:

4. If you now select the DALLIS and look at its ‘Hardware Panel’, you will see that a redundant master board
has been fitted:

5. Right-click on the redundant master board slot and select (or unselect) available to add (or remove) the
link to the redundant port.
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DSP Resources

Core Resources (8*8 Summing Matrices)

From Version 5.4 onwards, the Router MKII module supports 8 summing matrices which appear in the System
tree as Resources within the Core:

Port Resources

Similarly, whenever you define a MADI Tie-line or DALLIS which is 60-channels or less, you automatically
configure an amount of DSP resource. This appears in the System tree as Resources within the MADI module's
Port. The amount of DSP resource is defined when you configure each MADI Port - for example, defining a 52-
channel DALLIS leaves 12 free channels to support one 4x4 plus one 8x8 DSP resource:
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Configuring the Resources

Both types of resource can be used for console monitoring, downmix matrices or other customer-specific
summing functions:

1. Right-click on the Resources in the 'Core Browser' - a drop-down menu appears listing the available
options. The options vary depending on the channels available:

Core Resources (8*8 Matrices) MADI Port Resources (4 channels) MADI Port Resources (8 channels)

2. Select an option to configure the resource application:

· Listen stereo or Listen surround – configures matrices for the console's stereo and surround
monitoring.

· Matrix (4 * 4) or Matrix (8 * 8) – creates a summing matrix. These can be used for customer-specific
summing applications. Note that you will need a Matrix (8 * 8) to define a downmix matrix.

3. To define a Matrix (8 * 8) as a downmix matrix, double-click to open its 'Parameter Box', and tick the
Downmix matrix option:

Once the configuration is uploaded to the system, you will be able to control the surround downmix from the GUI's
Downmix display.

To access the inputs and outputs of a matrix, the signals must be added to the Signal List configuration
(gui_config.tcl) using the 'Signal List Editor'.
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Core Configuration: Editing Parameters

This section looks at editing the system-wide and signal parameters stored within the Core configuration.

To add or remove a hardware component, see Defining the System.

Whether you want to change a system or signal parameter, the operation is essentially the same, see Operating
Principles: 'Parameter Box'.

For details on all options, see the Parameters reference section. Here we will cover some of the most common
editing tasks:

· Signal names and labels

· Device names (Alias names)

· Control system IP address

· Multi-channel sync

· Operating levels

· Maximum sample rate

· Mapping Tables
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Signal Names and Labels

For each individual signal, you can edit the Name and default Label. These appear in the GUI's Signal List
display.

mc2 Signal List display

The signal Name is stored only by the Core configuration, and cannot be edited from the console GUI. It should
be used to provide a "fixed" signal name relevant to the installation.

The signal Label is the label which the system resets to after a cold start. Users can change labels later from the
GUI's Signal List display.

Both the Name and Label are limited to a maximum of 8 characters.

Ø  To edit an individual name (or label):

1. Open the branches of the ‘Core Browser’ to reveal the signal you wish to edit.

2. Double-click on the signal – for example, Signal In 1 - the 'Parameter Box' opens:

3. Click in the Signal name (or Signal label) field, and type in the new name - you can enter up to 8
characters.

4. Press Enter to confirm the name.
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Ø  To edit a range of names (or labels):

Once you have selected the text in the Signal name (or Signal label) field, you can use the PAGE UP or
PAGE DOWN keys (on your computer keyboard) to navigate up or down the system tree while retaining the
selected field. 

This short cut can be applied to any "name" field - for example, the Group name, Super-device alias
name, etc.

You can also press CTRL + C to copy, and CTRL + V to paste text between fields.

Alternatively, if you want to name a range of signals with an incremental suffix or alternating L/R suffix, then you
can use the Comfort text edit mode or Stereo text edit mode:

1. Select the Extras -> Parameter Box main menu and enable the desired mode - for example, Comfort
text edit mode:

2. Name the first signal and leave your cursor in the field you wish to carry forward:

3. Now press CTRL + SHIFT + PAGE DOWN.

AdminHD steps down to the next signal in the system tree, and carries forward the text entry - if there is a
number at the end of the name, then the value is incremented:

4. Continue pressing CTRL + SHIFT + PAGE DOWN to name all the signals in your range.

If you wish to add an alternating L/R suffix, return to the Extras -> Parameter Box main menu and select Stereo
text edit mode. Then add an L to the end of the first name field:



mc²56 MKII Technical ManualV5.10.2/1158

Chapter 3: AdminHD
Core Configuration: Editing Parameters

This time when you press CTRL + SHIFT + PAGE DOWN, AdminHD increments both the numerical value AND
applies an R to the next signal name field. Continue pressing CTRL + SHIFT + PAGE DOWN to name all the
signals in your stereo range:
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Device Names (Alias Names)

For each component you can enter an alias name to help identify components in AdminHD.

The names are used only within AdminHD, and are not transferred to the remote control system.

You can display the alias names in the 'Core Browser' by enabling the Alias button on the toolbar:

Alias off Alias on

The alias names are also used by the 'Signal List Editor' (within the Hardware Tree), and if you use the
Generate Automatic Signal List button.

To enter an alias name:

1. Double-click on the component - e.g. the Core - within the 'Core Browser', and select the Data tab in the
'Parameter Box':

2. Enter a name into the Core alias field.

If the field is left empty, then a default system name is used to describe each component.
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Control System IP Address

These parameters set the TCP/IP address of the control system (for the Lawo system network port - Ethernet B).

Ø  To edit the system's IP Address:

1. Double-click on the Core within the 'Core Browser', and select the Connection tab in the 'Parameter
Box':

2. If a single Router Module is fitted to the Nova73, then enter the main Remote IP address only.

3. If main and redundant Router Modules are fitted, then also tick Remote IP redundant enable. This
enables the redundant Router Module and automatically sets the Remote IP address redundant - always 1
above the Remote IP address.

We recommend keeping the default IP address, where possible, as this will simplify remote maintenance.
However, if your mc²56 MKII is part of a larger network, then it will need a unique IP.
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Multi-channel Sync

mc2 and Nova systems offer a fully redundant clock source structure, including the ability to lock to sync from an
incoming multi-channel signal.

Ø  To define the multi-channel sync source:

1. Double-click on the Core within the 'Core Browser', and select the Data tab in the 'Parameter Box':

2. Click on the Enable sync port box. A pop-up appears where you can select the multi-channel sync
source:

3. Select the source – for example, Module 4 Port 1 MADI - and click on OK. The multi-channel sync
source is displayed as a system address – for example:
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Ø  PTP Sync Port for RAVENNA

In a RAVENNA streaming network (IP Layer 3), the mc2/Nova Core can operate either as a PTP Master or Slave

(as explained in the "RAVENNA for mc2/Nova User Guide").

In both cases, you should use AdminHD to turn on the Enable sync port option, and define the RAVENNA PTP
sync port:

· If operating as a PTP Master, then this is the port that will transmit PTP sync to the rest of the network.

· If operating as a PTP Slave, then this port will "listen" for PTP coming from the network.



mc²56 MKII Technical Manual V5.10.2/1 163

Chapter 3: AdminHD
Core Configuration: Editing Parameters

Operating Levels

These parameters specify the operating levels which the system resets to after a cold start. Users can change
the levels later from the console GUI's System Settings display.

There are three level settings which interact to define the internal and analogue-to-digital operating levels of the
system:

· Maximum Analogue Level = Reference Level + Headroom

The system supports a maximum analogue level = +24dB, and a minimum analogue level = +12dBu.

Warning

Changing the Reference Level or Headroom options move the internal 0dB operating point for the system
and therefore will change the behaviour of any level dependent settings such as dynamics processing and
metering. Therefore, it is not advisable to alter these levels once dynamics processing has been set.

For systems fitted with fixed level analogue I/O cards:

· The Headroom and Reference Level cannot be altered independently. For example, with a
+15dBu fixed analogue I/O card and +9dB Headroom, the Reference Level must be +6dBu.

· The Maximum Analogue Level of the whole system is defined by the DALLIS card with the lowest
GDA (General Device Address) - this is the card with the lowest address fitted to the DALLIS frame
connected to the lowest port number of the first Nova73. (If a different fixed level analogue card is
fitted elsewhere within the system, then a warning appears in the log file; however, the card with the
lowest GDA still wins.)

Ø  To set the levels:

1. Double-click on the Core within the 'Core Browser', and select the System settings tab in the 'Parameter
Box':

2. Select the Analog full-scale level from the drop-down menu options.

3. Then set the Reference level by clicking on the up and down arrows - the resultant Headroom is
calculated automatically.
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Internal Sampling Rate

This parameter specifies the internal sampling frequency which the system resets to after a cold start. Users can
change the sample rate later from the console GUI's System Settings display.

Note that the maximum sample rate (96kHz or 48kHz) is defined when you select the type of Core.

Ø  To set the internal sampling rate:

1. Double-click on the Core within the 'Core Browser', and select the System settings tab in the 'Parameter
Box':

2. Select the Sampling frequency from the drop-down menu option. The available options are defined by
your choice of Core.

If your system includes RAVENNA Net devices, such as Lawo's A__line, then the sample rate of these devices

must be changed manually using the RAVENNA Web GUI. Please refer to the "RAVENNA for mc2/Nova User
Guide" for details.
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Mapping Tables

Lawo’s Remote MNOPL protocol is a freely available Ethernet (TCP/IP) protocol providing control of virtually any
system parameter from an external device. 

A typical application is to provide third-party matrix control so that crosspoints within the mc²56 MKII’s routing
matrix can be controlled by external control systems such as VSM, Evertz, Quartz, BFE, Pharos and others. (If
your preferred supplier does not support the protocol, then please ask them to contact Lawo for further details):

Within your AdminHD configuration, each signal can be given a mapping address. Up to 16 different mapping
tables can be defined so that different control systems can be supported simultaneously.

Ø  To configure the mapping tables:

1. Double-click on the Core within the 'Core Browser', and select the Map tab in the 'Parameter Box':

2. For your chosen mapping table (01 to 16), enter the signal addresses which will be submitted to the
external control system:

· unknown signal - submitted when an undefined source is connected to a defined destination.

· no signal address - submitted when a signal is disconnected.

Please refer to your external control system’s documentation for details on which addresses to enter. Our
example shows the addresses for a Lawo zirkon control system.

3. Now select the first signal you wish to map to the controller, and select the Map tab.
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4. For your chosen mapping table (01 to 16), assign the Mapping table address:

The format of the address will be specified by your external control system.

5. Repeat for all the signals you wish to control from your external device.

6. You can get an overview of the assignments by selecting Extras -> Show Mapping Table from the main
menus. 

In our example, Mapping table 1 assigns signals to a Lawo zirkon system:
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Signal List Configuration

This section deals with how to edit and update a Signal List.

Signal Lists are created by the ‘Signal List Editor‘ and stored as separate .slx files to the Core configuration (.csv
file).

The 'Signal List Editor‘ produces the cold start file (gui_config.tcl) to modify the console GUI's Signal List
display.

The gui_config.tcl can ONLY be uploaded to the remote system's cold start data. This means that you
MUST be prepared to restart the mc²56 MKII in order to change its Signal List configuration.

The principles are similar to editing the Core configuration (config.tcl); the best approach is as follows: 

1. AdminHD must have a Core configuration with some relevant signals. Therefore, first download or open a
Core configuration as described earlier.

2. Open the 'Signal List Editor' sub window.

3. If possible, download the existing Signal List configuration from the mc²56 MKII control system.

Alternatively, if you can't connect to the  mc²56 MKII, open an existing signallist.slx file. This can be a file
which you saved earlier or requested from your configuration engineer.

If you have neither a network connection or an existing signallist.slx file, then you will need to create a new
Signal List and build a configuration.

4. Save the configuration as a signallist.slx file - this allows you to open it later, or move it to another
AdminHD computer.

5. Edit the Signal List.

6. Backup the system's existing cold start files.

7. Export the Signal List configuration as a gui_config.tcl file - this puts the data into a format which can
be read by the control system.

8. Upload the gui_config.tcl file from your computer to the mc²56 MKII control system.

6. Cold start the mc²56 MKII to see your changes take affect.

Workflow Suggestion:

If you are making changes to both the Core and Signal List configurations, then download and save both sets of
data (config.csv and signallist.slx) while you are connected to the control system. Once editing is complete,
export both cold start files (config.tcl and gui_config.tcl), and upload them to the control system. You can then
perform a single cold start to action all your changes.
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The 'Signal List Editor'

The ‘Signal List Editor’ is used to download, create, edit and upload the Signal List configuration used in the
console GUI’s Signal List display.

1. Click on  from the main toolbar to show the ‘Signal List Editor’.

Or select Window -> Signal list editor (from the main menus) or press CTRL + SHIFT + S (on your computer
keyboard).

AdminHD analyses its Core configuration and opens the ‘Signal List Editor’ window:

AdminHD creates a new ‘empty’ Signal List each time you open the ‘Signal List Editor’. If you wish to edit an
existing Signal List, then either download the Signal List configuration from the mc²56 MKII control system, or
open an existing signallist.slx file.

The ‘Signal List Editor’ is divided into two pages – Source and Destination.

2. Click on the Source and Destination page tabs to change between pages.
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Each page has three columns:

Directories & signals

This column displays the configured Signal List. 

Signals are organised into directories and subdirectories which can be added and renamed as you wish. Use the
+ and – signs to open and close branches of the Directories & signals column to interrogate the configured
signal list.

Hardware Tree

This column lists all the signals within the Core configuration. The list uses the alias names (if entered).
Otherwise,  default system names are used to describe each component – for example, MO4PO1DAL60:

· MO4 – indicates the Nova73 Module (e.g. Module 4).

· PO1 – indicates the port on the Module (e.g. Port 1).

· DAL60 - indicates the device on the port (e.g. a DALLIS Device with 60 audio channels).

Use the + and – signs to open and close branches of the Hardware Tree. Click on an individual signal, or a
card, and the signal(s) appears in the third column - Selected signals.

Selected signals

This column is used to build a list of signals, which you can add to the selected subdirectory using the 
button. Signals in red are already used somewhere within the configuration; those in black are not.

For more details, see Editing a Signal List.
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The Signal List Editor Toolbar

The toolbar, at the top of the 'Signal List Editor', is used to action most of the editor's functions. 

Note that buttons are "greyed out" if they are unavailble - for example, you cannot Add a new directory (12) if
you have a signal selected in the Directories & signals column.

1 New Creates a new signal list.

2 Open Opens an existing Signal List file (signallist.slx).

3 Save Saves the current Signal List configuration as a signallist.slx file.

4 Save as Saves the current configuration under a new filename.

5 Export Exports the current Signal List configuration as a cold start gui_config.tcl file.

6 Download Downloads the Signal List configuration from the mc²56 MKII control system into
AdminHD.

7 Copy Copies the selected signal or directory, from the Directories & signals column, to the
clipboard.

8 Cut Cuts the selected signal or directory from the Directories & signals column.

9 Paste Pastes the clipboard data to the selected directory in the Directories & signals
column.

10

11

Move up

Move down

Moves the position of a signal or directory in the Directories & signals column.

12 Add
directory/subdir
ectory

Adds a new directory to the Directories & signals column.

13 Delete Deletes the selected signal or directory from the Directories & signals column. 

14 Locate signal Select a signal within the Directories & signals column, and then click this button to
locate its position within the Hardware Tree.

15 Generate
automatic tree
view 

Adds the directories and signals from the Hardware Tree into the Directories &
signals column. Use this button to quickly generate a Signal List from your hardware
components.

16 Update
hardware
signal config

Updates the Hardware Tree column if you make changes to the Core configuration
while the ‘Signal List Editor’ is open.

17 Duplicate
directory
structure

Copies the directory structure, within the Directories & signals column, from the
Source to the Destination page (or vice versa).
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Downloading the Signal List

The best way to ensure that you are working with your system's latest data, is to download the Signal List
configuration, from the mc²56 MKII. To perform a successful download, you will need a valid network connection
between your computer and the control system.

Open the 'Remote Log' to monitor the progress of the download. 

1. Click on  (Download GUI signal list config) from the 'Signal List Editor' toolbar.

2. If you have made changes to the current Signal List, then the following dialogue box appears:

· Select Yes to save the configuration (as a .slx file) before proceeding.

· Select No to continue without saving.

AdminHD downloads the configuration data from the remote system; the 'Remote Log' shows the progress. When
the download is complete, the 'Signal List Editor' updates:

If there is a problem with the download, then:

· Check the network connection and TCP/IP settings of your computer's network interface card. 

· Check that AdminHD is compatible with the mc²56 MKII system.

· See the trouble-shooting tips.
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Opening a Saved Signal List

To open an existing signallist.slx file:

1. Click on  (Open signal list config) from the 'Signal List Editor' toolbar. (If you have made changes to
the current Signal List, then you will be asked if you wish to Save the changes first).

2. Select your file and click Open:

The file opens, and the path and file name appear at the top of the 'Signal List Editor' window:

If there is a problem opening the file, then check:

· Is the file an AdminHD .slx ?

· Was the file saved by a newer release of AdminHD?

Configurations saved by an earlier version of AdminHD can be opened in a later release. However,
configurations saved by a newer release are not backwards compatible.

· Does the file contain signals which are not supported by the current Core configuration? If so, then some
parts of the Signal List will not load.
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Creating a New Signal List

A new ‘empty’ Signal List is created each time you open the ‘Signal List Editor’. However, if you already have a
Signal List open, and wish to clear its data, create a new file as follows:

1. Click on  (New Signal List Config) from the 'Signal List Editor' toolbar.

A new list is created, in the Directories & signals column, which includes the system's default directories and
an unnamed entry (New_dir_001 and New subdir_001).

In the Hardware Tree column, you will see all the signals available within your Core configuration:

Use the Generate automatic tree view from config button to quickly generate a Signal List from your Core
configuration.
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Default Directories

For the mc2 mixing consoles, you will see some default Source and Destination directories which cannot be
edited or deleted. 

These provide access to the console's channel DSP resources (Input/Mon A+ B, Bus Out, Direct Out, Insert
Send/Return), and other options dependent on your Core configuration (mxDSP Signals and Plugin Server):

Source Page Destination Page

You can select whether the Input/Mon A + B directory appears from the Extras -> Preferences -> Signal
List Editor menu.

You will only see the mxDSP Signals directory if an mxDSP module has been added to the Core
configuration. 

Similarly, you will only see the Plugin Server directory if a MADI I/O Port has been defined for the Lawo
plugin server. (Note that the Waves Plug-in Server option, supported from V5.6.0 onwards, is defined using a
normal Tie-Line which can be named using custom directories).
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Saving the Signal List

Having downloaded, opened or created a new Signal List, it is a good idea to save the data as an AdminHD
signallist.slx file. This will allow you to open the file later or move it to another AdminHD computer.

1. Click on either  (Save) or  (Save as) from the 'Signal List Editor' toolbar:

· Save overwrites the current file name (if one exists).

· Save as asks for a new file name:

2. Select a path and enter a suitable file name. 

You can use any name as long as it keeps the .slx suffix. As the Signal List relates to the Core
configuration (.csv file), it is a good idea to store the two files in the same location. See Organising Your
Files.

3. Click Save to save the Signal List configuration onto your computer’s hard disk.

4. From here on, you can quickly update the file by clicking on  (Save).
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Editing a Signal List

The current Signal list configuration is shown in the Directories & signals column. Directories and subdirectories
can be added and named as you wish. Signals can then be added to subdirectories as follows:

Note that:

· The Signal List structure supports three levels: directories, subdirectories and signals; you cannot
configure additional levels or add signals directly to directory. These restrictions are required in order to
support the GUI's Signal List display.

· The 'Signal List Editor' can add, remove and rename directories and subdirectories, and organise signals
into subdirectories. To rename the signals themselves, use the 'Parameter Box' to edit the Signal name
field.

· You can add a signal to more than one subdirectory.

Some tips:

· Keep the 'Signal List Editor' open, while adding components to the Core configuration. Then use the
Update hardware signal config button to refresh the Hardware Tree.

· You can generate a signal list automatically from the Core configuration. This is a quick way of getting a
useful starting configuration.

· Use Copy, Cut and Paste to duplicate or move subdirectories.

· Use the duplicate directory structure function to copy the structure of your Source directories to the
Destination page, or vice versa.

· The context menu (available from a right-click in the Directories & signals column) offers a number of
keyboard shortcuts.
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Adding & Naming Directories & Subdirectories

Ø  To add a new directory, or subdirectory:

1. Select a position in the Directories & signals column.

2. Right-click and select Create new directory:

The new directory, or subdirectory, is added below your selection and given a default name.

Note that the Signal List structure supports three levels: directories, subdirectories and signals; you cannot
configure additional levels.

Ø  To rename a directory, or subdirectory:

1. Double-click on the existing name - the text is highlighted:

2. Type in the new name on your computer keyboard and press Enter - you can enter up to 16 characters. 

For easy operation from the GUI's Signal List display, try and keep the names as short as possible.
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Adding Signals to a Subdirectory

To add signals to a subdirectory:

1. First, use the Hardware Tree to build up a list of signals in the Selected signals column - you can

select single or multiple signals, and use the  button to edit the Selected signals list. See Selection tips.

2. Once you are happy with the Selected signals content, click on the  button to add all the Selected
signals to your subdirectory:

You can click the  button multiple times if you wish.

In the Selected signals column, signals in red are already used somewhere within the configuration; those in
black are not.
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Selection Tips and Tricks

When adding signals, you can use the following tips and tricks to edit the contents of the Selected signals
column.

(The same tips can be used when deleting signals, but you would make selections in the Directories & signals
column.)

· To select all the signals from a card, click on the card within the Hardware Tree  - all signals within the
card are added to the Selected signals list.

· To select a range of consecutive signals or cards, select the first signal or card; press and hold SHIFT
(on your computer keyboard), and then select the last signal or card - all signals within the range are
added to the Selected signals list:

· To select non-consecutive signals or cards, press and hold CTRL (on your computer keyboard) and then
click on the signals or cards. As long as you continue to hold the CTRL button, your selections
accumulate within the Selected signals list:

· To remove a signal, from the Selected signals column, select the signal and click on the  button.
Note that this function only edits what is in the Selected signals column. If you wish to remove a signal
from a subdirectory, then see deleting signals.
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Deleting Signals, Subdirectories & Directories

Ø  To delete signals from a subdirectory:

1. Select the signals, from the Directories & signals column, see Selection tips and tricks.

2. Right-click and select Delete:

3. Confirm by clicking Yes - the selected signals are deleted from the Signal List.

Ø  To delete directories or subdirectories:

1. Select the directory or subdirectory, from the Directories & signals column. You can make multiple
selections if you wish, see Selection tips and tricks.

2. Right-click and select Delete:

3. Confirm by clicking Yes.

Note that deleting a directory deletes all subdirectories and signals within it.
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Editing the Position of Signals, Subdirectories & Directories

Ø  To move the position of a signal, subdirectory or directory:

1. Select the signal, directory or subdirectory, from the Directories & signals column.

2. Right-click and select Move up or Move down:

Or, click on the  or   (Move node) buttons from the 'Signal List Editor' toolbar - the selection moves
accordingly.
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Copy, Cut and Paste

The Copy, Cut and Paste functions provide a quick way to edit your signal list. For example:

Ø  To cut a subdirectory from one directory to another:

1. Select the subdirectory you wish to copy from the Directories & signals column.

2. Right-click and select Cut:

Or, click on the   (Cut) button from the 'Signal List Editor' toolbar - the selected subdirectory is copied to the
'Signal List Editor' clipboard.

3. Now select the directory where you want to paste the selection.

4. Right-click and select Paste:

Or, click on the   (Paste) button from the 'Signal List Editor' toolbar - the selected subdirectory is pasted
accordingly, along with all of its contents.

Directories and subdirectories can be copied and pasted in a similar manner.
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Duplicating the Source/Destination Directory Structure

This function copies the structure of your Source directories to the Destination page, or vice versa. It can be very
useful if you wish to use similarly named directories and subdirectories in your Source and Destination lists.

1. First, edit either your Source (or Destination page):

2. Then click  on the   (Duplicate directory structure) button, from the 'Signal List Editor' toolbar, to
copy the directory structure to the alternate page:

Note that you can click the  button multiple times if you wish - the structure is duplicated multiple times.
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Updating the Hardware Tree

This function forces the 'Signal List Editor' to re-analyse the Core configuration and update the signals in the
Hardware Tree. 

You should use it if you have added components to the Core configuration, while the 'Signal List Editor' has been
open.

1. To perform the update, click on the  (Update hardware signal config) button from the 'Signal List
Editor' toolbar - the system analyses the Core configuration, and the Hardware Tree updates.
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Locating a Signal within the ‘Signal List Editor’

To quickly locate the hardware position of a signal:

1. Select the signal from the Directories & signals column.

2. Click on the  (Locate signal) button from the 'Signal List Editor' toolbar - the Hardware Tree opens
to show the location of the signal:
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Generating a Signal List from the Core Configuration

This operation adds all the directories and signals from the Hardware Tree into the Directories & signals
column, and can be used to quickly generate a Signal List from your hardware components.

It is a good idea to add this structure below your "user" directories, so that service technicians can easily
locate signals using the Hardware Tree naming structure.

1. Click on   (Generate automatic tree view from config) from the 'Signal List Editor' toolbar - all the
directories and signals from the Hardware Tree are added to the bottom of the Directories & signals column:

The structure uses the alias names (if entered). Otherwise, default system names are used to describe each
component – for example, MO4PO1DAL60:

· MO4 – indicates the Nova73 Module (e.g. Module 4).

· PO1 – indicates the port on the Module (e.g. Port 1).

· DAL60 - indicates the device on the port (e.g. a DALLIS Device with 60 audio 

2. The button can be selected multiple times to repeat the structure.

For example, you might add the structure twice; leave the lower structure unchanged (for your "service
view"), and then edit the upper structure to provide more "user friendly" directory and subdirectory names.
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Exporting the Cold Start gui_config.tcl

To update the Signal List configuration on a mc2 mixing console, you must export the 'Signal List Editor'
contents, as a gui_config.tcl file, in preparation for a cold start upload.

If you have also edited the Core configuration, then export and upload both cold start files (config.tcl and
gui_config.tcl).

1. Click on the   (Export to cold start config) button from the 'Signal List Editor' toolbar.

2. You are asked to specify a folder location for the file - in our example, we have chosen the Studio 2
folder created earlier, see Organising Your Files.

Do NOT rename the file; it must be named gui_config.tcl in order to be read by the control system.

You can specify a default directory for your Coldstart config files from the Extras -> Preferences ->
Directories menu.

3. Click Save - the configuration is exported from the 'Signal List Editor' and saved on your computer.



mc²56 MKII Technical ManualV5.10.2/1188

Chapter 3: AdminHD
Signal List Configuration

Uploading the Cold Start gui_config.tcl

Having exported the gui_config.tcl file, it can now be uploaded to the mc²56 MKII control system.

This operation is similar to uploading the cold start config.tcl file, except this time upload the GUI cold start
config (gui_config.tcl):

If you have edited both the Core and Signal list configurations, then you should export and upload both cold
start files (config.tcl and gui_config.tcl).

You will need to cold start the mc²56 MKII to see your changes take affect.
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Online Operation

You should switch AdminHD online, in order to:

· Monitor the status of your remote system.

· Update the online configuration (in memory) - available for the Core configuration only.

Note that you will need a valid network connection between your computer and the mc²56 MKII control system.

Ø  To switch between modes:

1. Click on  from the main toolbar (Online/Offline to remote system). Or select Remote ->
Online/Offline to remote system (from the main menus).

Once online, AdminHD connects to and synchronises with the system. The IP address of the connected host is
displayed in the Status bar and the 'Core Browser' and 'Hardware Panel' update:

If the connection fails, then the ‘Remote Log’ will report that the connection has timed out:

· Check the network connection and TCP/IP settings of your computer's network interface card. 

· Check that AdminHD is compatible with the mc²56 MKII system (the first three digits of the software
versions must match.)

· See also the trouble-shooting tips to resolve the problem.

2. Click on the same button , to switch offline.

3. Select Remote -> Reconnect mode (from the main menus), if you wish AdminHD to reconnect to the
remote control system if network communication is interrupted.
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System Diagnostics

Once AdminHD is running online, you can use the 'Core Browser' and 'Hardware Panel' to monitor the real-time
status of hardware components:

All components are monitored, including the status of the Core, DALLIS units and their PSUs.

Components which are operating normally are coloured green; faulty components are highlighted in red. In our
example above, one of the DALLIS plug-in cards is missing or faulty. Check the card's connections, and if
necessary replace the card.

In addition, the 'Remote Log' records all messages generated by AdminHD and the online system. You can save
the contents of the 'Remote Log' to help diagnose any errors.
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The System Message Log

The mesages logfile is generated and stored by the control system during operation. It can be downloaded from
remote system and saved on your computer using AdminHD.

Note that this is the one of the system logfiles which can also be copied to USB, from the console GUI, using the
File display, or monitored using the Web Browser Interface.

To download the logfile:

1. Select Remote -> Download file -> System log messages from the main menus:

A ‘Save As’ file selection box appears.

2. Select a folder location and enter a filename:

You can specify a default directory for your Core logfiles from the Extras -> Preferences -> Directories menu.

3. Click Save - AdminHD downloads the file.

The log is stored as a plain text file, and can be opened by any common text editor.
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Documenting the Configuration

AdminHD provides two tools to help document the system once you have programmed your configuration:

· Copy Image / Write Image to File

· Export a Component List
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Copy Image / Write Image to File

You can save the graphical images used within AdminHD to help document your system - for example, to save
the front panel configuration of your Nova73 and DALLIS.

Saving the 'Hardware Panel'

1. Open the 'Hardware Panel' and hover your mouse over the frame of the Core or DALLIS - the frame is
outlined in orange.

2. Right-click and select one of the drop-down options:

· copy image to clipboard - saves the graphic to your computer's clipboard. 

· write image to file - saves to graphic as a .png image file. You are asked for a folder location and
filename.

Saving the 'Console Panel'

This is similar to above, but saves the image of the console front panel. Note that the 'Console Panel' can only be

used to configure MKI mc266 systems, and does not represent your control surface configuration for the mc²56
MKII.
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Export a Component List

You can export a component parts list as a .csv file. This can be opened in a 3rd party editor, such as MS Excel.

To export the list:

1. Select File -> Export file -> Component list from the main menus:

2. Select a folder location and enter a filename:

3. Click Save - the component list is stored as a .csv file on your computer.
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Core Configuration: Parameters

This section covers all the Core configuration parameters for the mc²56 MKII system.

Please see First Steps, Defining the System and Editing Parameters for the operating principles.

Component and signal parameters are covered according to their hierarchical order within the 'Core Browser' 
System. For more details on functionality, please consult the relevant data sheet, available in the
"mc2_Nova73_documentation" guide.

In each case, you should open the 'Parameter Box', for the component or signal, to access its parameters:
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System

ID Usually all Lawo projects receive a project ID, made up of 6 integers. You can log your
project ID here; you can be asked for it when servicing your product. The field can be
left blank.

System alias Enter an alias name for the System.
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Core -> Connection

These parameters define the TCP/IP address of the mc²56 MKII control system. See Editing the IP Address for
details.
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Core -> Data

Core alias Enter an alias name for the Core.

Router module model
number

Router module type

These fields are for information purposes only and cannot be edited. They show the
serial number and type of Router Module. The type of Router Module is defined
when you add a Core to the System (in the 'Core Browser').

Router module This box should always remain ticked, as every Core requires at least one Router
Module.

Redundant router
module 

Tick this box to add a redundant Router Module to the Nova73.

Redundant PSU Tick this box to add a redundant PSU to the Nova73.

Black burst synchronised
switching

Tick this box to make matrix cross point switching synchronous to an external
Black Burst sync source.

Internal sync activates
alarm

Tick this box to activate the Global Alarm if the system switches to internal sync.

Enable sync port Tick this box to enable the multi-channel sync port. A pop-up appears asking you to
select the sync source, see Multi-channel Sync.

Multi-channel sync port This box displays the multi-channel sync port source as a system address (if
Enable sync port is active).
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Core -> System Settings

Analog full-scale level
(dBU)

This option sets the analogue level which corresponds to digital full scale level
(0dBFS). You can select 12, 15, 18, 21 or 24 dBu.

Reference Level (dBU) This field sets the internal reference level of the system. The maximum reference
level is 24dBu.

Headroom (dB) The resultant headroom is calculated from the first two options. See Operating
Levels for details.

Sampling Frequency This parameter sets the internal sampling frequency which the system resets to
after a cold start. See Internal Sampling Rate for details.

Disable Global Alarm Tick this box is you wish to disable the Global Alarm.



mc²56 MKII Technical ManualV5.10.2/1200

Chapter 3: AdminHD
Core Configuration: Parameters

Core -> Map

These parameters are used if you wish to control matrix crosspoints from an external device. See Mapping Tables
for details.
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Core -> External

These parameters are used to connect an external file server to the system. Once configured, the server is
available to users via the console GUI's File Import/Export page.
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Core -> Network

HLSD index This parameter is used if your Core is part of a larger network, in order to keep all
HLSD addresses unique. 

Once you have set the network index, you can use the Replace all default HLSD
classes with new Nework index option (in the Extras menu) to reset the HLSD
classes. For example, if the index = 2, then the resulting default HLSD classes (in/out)
= B2R and B2S.
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Core -> Plugin Server

IP Address Plug-in
Server

Enter the IP Address of the optional Plugin Server.

For the Waves SoundGrid system, enter the IP address of the MultiRack host PC.

Please see the "Waves Plug-in Server for mc2 User Guide" for details on the tickbox
options.

For the Lawo Plugin Server, the default IP address = 192.168.105.144

Remote Desktop
username, password
and color depth

These parameters configure the Remote Desktop connection to the Plugin Server host.

You should enter the username and password which matches the Windows user name
and password entered on the PC host.

For a Waves SoundGrid system, a color depth of 24 Bit is recommended.
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Modules

Parameters for a Module depend on the module type:

I/O, & Channel DSP Module Parameters Matrix DSP Module Parameters

Module alias Enter an alias name for the Module.

Slot number

Module model number

Module type

These fields are for information purposes only and cannot be edited. They show the 
Slot number used in the Core, and the serial number and type of module, see Nova73
Module Options.

Config-ID On the 983/03_007 mxDSP module, this parameter defines how the matrix DSP is
configured. See mxDSP configuration for details.

Backplane Hardware On the 981/02 and 981/04 AES3 modules, this parameter defines the rear connector
panel (either D-Sub or BNC).
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Ports

Parameters for a Port depend on the port type:

MADI & RAVENNA Port Parameters AES Port Parameters

Port Number

Interface type

These fields are for information purposes only and cannot be edited. They show the
logical port number, which is dependent on the module's slot position in the Core, and
the interface type (MADI, RAVENNA, etc.)

Is redundant Tick this box to enable port redundancy. You will be prompted to select the redundant
port.

Corresponding port Shows the system address of the linked port, if Is redundant is enabled.
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Super-Device

Super-Device is the generic term used to describe the I/O port's definition: DALLIS, Tie-Line, Compact I/O, etc.
The parameters depend on the device type and its connection.

General Parameters

Tie-Line DALLIS (connected via MADI)

Super-device alias Enter an alias name for the device.

Model number & Type These fields are for information purposes only and cannot be edited. They describe the
serial number (of a DALLIS frame) and the type of Super-device.

Redundant PSU Tick this box to add a redundant PSU to the DALLIS frame.

Audio channels IN left

Audio channels OUT
left

These two boxes cannot be edited and show the number of 'free' audio channels left in
the DALLIS frame. These are channels which could be used by fitting additional plug-in
cards.)

RAVENNA Net Devices Only

DALLIS (connected via RAVENNA Net) Virtual Device (A_mic8)

Role name Enter the RAVENNA Role name - this must match the Role name defined and stored 
on the connected device.

TX stream name

(RV DALLIS only)

Enter the RAVENNA Transmission stream name (required for IP-SHARETM Gain
Compensation).

Static routing IP

(Virtual Devices only)

Enter the IP address of the Virtual Device's streaming port. This must match the IP
address stored on the device itself (defined by the preconfig script).

Note that for other devices, the Static routing IP is entered under Masterboard.
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For more details on RAVENNA configuration, please see the separate "RAVENNA for mc2/Nova User Guide".
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DALLIS, Local IO or Compact IO Masterboard (RV)

When connecting a DALLIS, Local IO or Compact IO via RAVENNA Net (IP Layer 3), you will need to enter the IP
address of the device's streaming port into the Static routing IP field:

DALLIS Config (RV)

The settings must match those stored on the device itself (defined by the preconfig script).

For more details on RAVENNA configuration, please see the separate "RAVENNA for mc2/Nova User Guide".
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Cards

Parameters for the IO Cards depend on the card type. Below are two examples. See also SDI Parameters.

941/53 Mic Card Parameters 924/02 Line Card Parameters

Device alias Enter an alias name for the card.

Model number 

Typename

Slot number

Interface type

These fields are for information purposes only and cannot be edited. They show the
serial number and type of card, the slot position within the DALLIS frame, and the
interface type.

Monitoring device For 942/02 and 942/12 cards only.

Tick this box to release the card from the system reference level, if the card is to be
used for monitoring.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2_Nova73_documentation" guide.
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Signal In -> Signal

Signal In parameters depend on the type of signal (Mic, Line, AES, SDI, etc.). Below are two examples. See
also SDI Parameters.

Mic Signal In Parameters AES Signal In Parameters (with SRC)

HLSD High Level Signal Definition - this is the Lawo system address for the signal. It
MUST be unique, and normally you should not modify this address from its default
setting.

Signal name This is the system name of the signal. It can only be defined by AdminHD, and should
be used to provide a "fixed" signal name relevant to the installation.

Signal label This is the user label which the system resets to after a cold start. Users can change
labels later, from the console GUI's Signal List display.

Group This is the group name for the signal. It can be used when interfacing to an external
controller. Please refer to your external system’s documentation for details on how to
implement the group name.

SRC For AES cards with SRC only.

Tick this box to enable the sample rate converter. Users can change this parameter
later, from the console GUI's Signal Settings display.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2_Nova73_documentation" guide.

To make a digital path suitable for Dolby E operation, you should turn off the I/O DSP for both the input and
output, and disable any sample rate conversion.
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Signal Out -> Signal

Signal Out parameters depend on the type of signal (Line, AES, SDI, etc.). Below are two examples. See also
SDI Parameters.

Line Signal Out Parameters AES Signal Out Parameters (with SRC)

HLSD See Signal In: HLSD.

Signal name See Signal In: Name.

Signal label See Signal In: Label.

Group See Signal In: Group.

Sampling frequency

Word length

SRC

For AES cards with SRC only.

Sets the sample rate and word length for the output.

Note that the SRC field cannot be edited and shows the status of the sample rate
converter. To disable the SRC, you must set the Sampling frequency to System and
Word length to 24-bit. For all other combinations, SRC is always enabled.

Users can change these parameters later, from the console GUI's Signal Settings
display.

AES consumer format For AES cards released after 2006.

Sets the channel status of the AES output to either Consumer or Professional.
Please refer to the AES3 standard definition for details.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2_Nova73_documentation" guide.

To make a digital path suitable for Dolby E operation, you should turn off the I/O DSP for both the input and
output, and disable any sample rate conversion.
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Signal In/Out -> DSP

These parameters adjust the I/O DSP and Silence Detect alarms. Note that not all cards support these
parameters.

Signal In: I/O DSP

Gain Compensation Appears for inputs which support IP-SHARE. Tick the box to enable Gain
Compensation. 

Note that if Gain Compensation is enabled, then you cannot enable I/O DSP (as it is
this which handles the gain compensation).

I/O-DSP Tick this box to enable the I/O DSP. Once enabled, the following parameters become
active:

Offset (dB)

Digital gain (dB)

Enter an offset and/or digital gain value in dB. The resultant gain (Offset + Digital
gain) is applied to the signal within the I/O card, and therefore affects all destinations.

The two separate parameters (Offset and Digital gain) allow you to apply a
‘permanent’ and a ‘temporary’ gain change. For example, to compensate for a low level
line input, use the Offset parameter to apply a ‘permanent’ gain change. In addition, for
today’s production you can also need to compensate for a badly recorded signal; for
this ‘temporary’ adjustment, use the Digital gain. At the end of the production, you
can easily reset the Digital gain to 0 dB while keeping the Offset gain intact.
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Signal Out: I/O DSP 

Mono matrix Tick this box to enable the mono matrix settings and link the output signal to its
odd/even partner.

When the mono matrix is enabled, you can then adjust the following parameters:

Mono matrix mode The mode can be set to:

· Channel mix – sums the left and right inputs and routes the mono sum to both
left and right outputs. 

· Channel swap – routes the left input to the right output and vice versa.

· Left to both – routes the left input to both outputs.

· Right to both – routes the right input to both outputs.

Mono attenuation left
channel (dB)

When working in Channel mix mode, you can set attenuation (e.g. -3dB) to
compensate for the mono sum. This is applied to the left output signal.

To make a digital path suitable for Dolby E operation, you should turn off the I/O DSP for both the input and
output, and disable any sample rate conversion.
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Silence Detect Alarm

These parameters can be applied to inputs and/or outputs, to trigger an alarm state if signals fall below a certain
threshold level. The silence detect alarms can be output to an external control system, via Lawo’s Remote
MNOPL protocol, or monitoring using the Web Browser Interface.

Silence detect Tick this box to enable the Silence Detect alarm for the signal.

Stereo link for Silence
Detect

Tick this box to link the left and right sides of a stereo input or output for 'Silence
Detection'. When linked, the alarm is only issued if both signals fall below the 
Threshold level.

Only odd and even adjacent signals can be linked.

Threshold (dBFS) Set the threshold below which the Silence Detect alarm will be triggered. The level can
be adjusted in 0.25dB steps and is referenced to digital full scale level (dBFS).

Attack Time (sec) This sets the length of time for which the signal must fall below the Threshold level
before the Silence Detect alarm is activated. The time is set in steps of 1 second.

Release Time (sec) This sets the length of time for which the signal must remain below the Threshold level
before the Silence Detect alarm is cancelled. The time is set in steps of 1 second.
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Signal In/Out -> Map

These parameters set the signal’s address for each of the mapping tables 1 to 16. You should use these
parameters to map a signal to an external controller, see Mapping Tables.
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mxDSP Configuration

This section covers additional notes for the mxDSP module (983/03-007 or 983/04-007).

An mxDSP module provides a pool of DSP resource which can be applied to signal paths within the routing
matrix. For example, to apply fixed DSP settings to line arrays. 

Physically, each mxDSP module is identical to a normal channel DSP board and occupies one slot within the
Nova73. However, rather than DSP channels, which can be assigned to the console surface, the mxDSP provides
DSP “chains” which can be viewed and controlled from the mxDSP Settings display. 

Several configuration options are supported, providing up to 192 DSP chains plus a 64 x 64 mixing matrix per
module. The DSP chains are configured from various elements including level, mute, delay, EQ, etc. The number
of DSP chains, and their signal flow, is determined by the AdminHD configuration:

To configure a 983/03 or 983/04 DSP board for mxDSP operation, the following steps are required:

1. Edit the Core configuration using AdminHD.

2. Edit the Signal List configuration using AdminHD.

3. Update the cold start configuration (config.tcl and gui_config.tcl) using AdminHD.

4. Update the firmware on the mxDSP module via a Telnet session.

Note also that if you change the mxDSP operating mode (via the Config-ID), it is necessary to generate a new
"gui_config.tcl" in order to have the correct signals available in the Signal List.
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Editing the Core Configuration

1. Download the online Core configuration to make sure that you are editing the latest configuration data.

2. Select the slot and change the module type to mxDSP:

3. Open the module's ‘Parameters Box’ and select an option from the Config-ID menu:

These options determine the number, and signal flow, of the DSP chains, see Config-ID Options.
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Config-ID Options

The Config-ID defines the signal flow of the DSP chains, and whether the card supports the 64 x 64 mixing
matrix:

Ø  Standby

Select this option to run the mxDSP module in standby mode. Use this mode to configure a redundant mxDSP
module.

Ø  Playout (no PPM)

This option provides 184 channels of DSP only (no mixing matrix):
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Ø  Universal

This option provides 154 channels of DSP plus the 64 x 64 mixing matrix:

Ø  Universal (no PPM)

This option provides 154 channels of DSP plus the 64 x 64 mixing matrix:
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Ø  Line Control

This option provides 184 channels of DSP plus the 64 x 64 mixing matrix:

Ø  Line Control (no PPM)

This option provides 184 channels of DSP, as above, but with less system resources, similar to Universal (no
PPM).
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Editing the Signal List

In order for the DSP chains to appear within the console GUI's Signal List display, the mxDSP module must be
added to the Signal List configuration (gui_config.tcl).

Having added the mxDSP module to the AdminHD configuration or changed the Config-ID (which changes the
operating mode):

1. Download the existing Signal List to make sure that you are editing the latest configuration data.

2. Click on the Update hardware signal config button - the mxDSP signals from the newly configured card
are added to the existing Signal List:

3. You can organise the signals, and name and label them, in the usual manner See Editing a Signal List.
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Updating the Cold Start Configuration

1. Export and upload both of the cold start configuration files (config.tcl and gui_config.tcl), in the usual
manner.

2. Cold start the mc²56 MKII control system so that the new configuration data is active.

You can check the configuration by opening the console GUI's mxDSP Settings and Signal List displays.
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Updating the Firmware

Before the mxDSP module will operate correctly, its software must be updated:

1. Using a computer connected to the Lawo system network, open a telnet session to the mc²56 MKII
control system.

2. At the main control system prompt, type mcxsh and press Enter - this opens the mcx shell programme.

3. Then type the command mcx_software_auto_update and press Enter - the software on each card is
automatically updated according to the Core configuration:

The mxDSP module is now ready for operation.
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The Main Menus

AdminHD supports five main menus:

· File

· Remote

· Extras

· Window

· Info
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File

· New – creates a new AdminHD session.

· Open – opens an existing AdminHD file (config.csv).

· Open recent – opens a recent config.csv file.

· Close – closes the current AdminHD session. You will be prompted to save your configuration as a
config.csv file before closing.

· Save – saves the current AdminHD configuration as a config.csv file.

· Save As – saves the current configuration under a new filename.

· Export file - exports the following file types:

o Core cold start config (config.tcl) – the cold start Core configuration.

o Component List – a component parts list.

o BFE controller – a BFE controller file. For more details, please contact your local Lawo

representative or email support@lawo.com.

o Remote log - the contents of the ‘Remote Log’.

· Exit – click to close the AdminHD programme. You will be prompted to save your current configuration
before closing.

mailto:support@lawo.com
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Remote

· Online to remote system – enables (or disables) the online connection to the remote control system.

· Reconnect mode – when enabled, AdminHD attempts to reconnect to the remote control system if
network communication is interrupted.

· DSHS – access to dual self-healing star options. (Note that Nova73 DSHS is not supported from Version
5.6 onwards.)

· Upload all data to remote HD – uploads the AdminHD configuration to the online system (available in
online mode only).

· Upload file - uploads the following configuration files from your computer to the remote control system:

o Core cold start config (config.tcl) – the cold start Core configuration.

o GUI cold start config (gui_config.tcl) – the cold start Signal List configuration.

o RAVENNA config archive (ravenna_config.zip) - the RAVENNA configuration, including new

RAVENNA interface assignments, RAVENNA role names (and, for virtual devices, the RAVENNA
streaming port IP addresses).

· Download all data from remote HD – downloads configuration data from the online control system into
AdminHD.

· Download file – downloads the following file types from the remote control system to your computer:

o Core cold start config (config.tcl) – the cold start Core configuration.

o GUI cold start config (gui_config.tcl) – the cold start Signal List configuration.

o System log messages - the control system log file.

· Reset system (cold send) – cold starts the remote control system (available in online mode only).
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Extras

· Lock config - enable this option to lock the configuration and prevent accidental changes.

· Parameter Box -> Comfort text edit mode or Stereo text edit mode - enable either of these modes
to use the naming short cut in the Signal 'Parameter Box'.

· Parameter Box -> Replace all signal labels with default name - use this option to replace all Signal
Label fields with the defaults.

· Parameter Box -> Replace all default HLSD classes with new Nework index - use this option to
reset the HLSD classes to the system network index (in a multi-system network). For example, if the
index = 2, then the resulting default HLSD classes (in/out) = B2R and B2S.

· Show mapping table – opens an overview of the mapping tables 1 to 16.

· Check configuration – checks the AdminHD configuration for programming errors.

· Preferences – opens the AdminHD Preferences.
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Window

Shows or hides the sub windows.
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Info

Information about the AdminHD software version, license and operating system.
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Preferences

1. Select Extras -> Preferences from the main menus, or press CTRL + P, to open the 'Preferences' pop-
up window:

2. Use the tabs to select a page.

3. Select or unselect a preference.

4. Click OK to save your changes.

5. Restart AdminHD or re-open the relevant window for the changes to take affect.

Your preferences are stored in the setup files for the software. Therefore, they will remain as you last left
them each time you start the programme.

Preferences -> Common

· Disable graphic frame pop-up after creating new hardware – tick this box if you wish to stop
AdminHD automatically displaying the ‘Hardware Panel’ when new hardware is added to the configuration.

· Display large graphics (for extended screens) – select this option if you are working with a larger
screen (e.g. 21”). The graphics are doubled in size.

· Disable auto reconnect – tick this box to prevent AdminHD automatically reconnecting to the online
system if network communication is interrupted.

Preferences -> Startup

The start-up options apply when you open or create a new configuration. 

· Hide Core Browser – tick this box if you do NOT want the ‘Core Browser’ to appear automatically. 

· Show remote log – tick this box if you DO want the ‘Remote log’ to appear automatically.
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Preferences -> Directories

From here, you can specify the default directory paths which will be used each time you save, open, export or
download a file:

1. Click on the folder button next to the entry you want to specify – e.g. beside Config files. A file dialogue
box appears.

2. Select the folder where you usually want to save your files and click on Open. The file dialogue closes
and the path is displayed in the Preferences field.

3. Repeat for all the AdminHD file types:

· Config files – AdminHD configuration files (config.csv).

· Remote logfiles – ‘Remote log’ text files.

· Coldstart config files – config.tcl and gui_config.tcl files.

· Core log message files – System log text files.
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Preferences -> Signal List Editor

These preferences affect how the ‘Signal List Editor’ creates new signal lists.

The first two options affect mc2 mixing console systems only:

· Enable physical Inputs/Monitors in DSP profile – tick this option to add the physical inputs of the mc2

input and monitor channel DSP channel to the default directories of the Destination page.

· Disable A/B of Inputs/Monitors in DSP profile - untick this option if you do NOT wish to add the mc2

input and monitor channel DSP signals to the default directories of the Destination page.

Enable physical Inputs/Monitors in DSP profile (ticked) Disable A/B of Inputs/Monitor in DSP profile (ticked)

The second two options affect all Nova systems:

· Show foreign signals if already in matrix list – affects networked systems. For further advice, please
contact your local Lawo representative or email support@lawo.com.

· Skip using device alias for directory auto creation - tick this option if you do NOT want to use the
Super-device alias names when directories are automatically added to the signal list.

mailto:support@lawo.com
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Chapter 4: Service/Maintenance

This chapter covers service and maintenance, including software diagnostics and hardware procedures.

See also trouble-shooting for a list of example problems and fault-finding tips.

For further assistance, contact your local Lawo representative or email support@lawo.com.

Topics include:

· Software Versions & Updates

· System Shutdown and Restart

· Restarting a Bay Server

· System Logfiles

· GUI Diagnostics

· AdminHD Diagnostics

· Web Browser Interface

· Telnet Sessions

· File Transfer via FTP

· Nova73

· DALLIS Unit(s)

· Control Surface

mailto:support@lawo.com
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Software Versions

Compatibility

From Version 4.0.2.2 onwards, all Lawo products have adopted a consistent software release numbering system
to indicate compatibility. This affects system networking, mxGUI and AdminHD. In each case, the first three
digits of the software version must match.

Checking the Software Version

You can check the software version of your mc2 system from the Global Options in the System Settings display.

Software Updates

Please register at www.lawo.com (click on Login) and go to the Download-Center to download the latest
software and documentation for your product.

Information about each software release can be found in the "Release_Notes_X.xx".

From Version 5.8.2, the mxUpdater utility (included with mxGUI) can be used to update the system from an
mxGUI computer. 

Once running Version 5.8 (or later), there can be a mismatch in your configuration if you install an earlier
release than 5.8. Therefore, please contact the Lawo service department if you wish to downgrade your
software version to a release < Version 5.8.

Changing Firmware Revisions

From Version 5.6, all Nova73 IO modules will automatically update to the required firmware (according to their 
AdminHD configuration) once they are plugged into the Nova73 frame. This makes it easier than ever to
reconfigure a system, and prevents any mismatch between Control System and IO software revisions.

http://www.lawo.com
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Shutdown and Restart

Shutdown

The console should be shut down by powering off the control surface (mains connections at rear) and Nova73
(mains connections at front).

Note that the control system is located on the Router Module MKII within the Nova. Therefore, it is here where
your user data is stored. 

Following switch-off, power is provided to the control system for a further 18 seconds. During this time, all current
settings are saved to flash memory; this is known as the warm start data. You will hear several tones signalling
that the shut down operation has been successfully completed. The system is shut down when the blue LED of
the trackball is off.

you can switch off the power to other system components (e.g. DALLIS units) at any time. 

Starting the System (Warm Start)

To start the system, turn on the power to the control surface (mains connections at rear) and Nova (mains
connections at front). The components can be powered in any order, but note that the control system resides
within the Nova73. Therefore, the system boots when you turn on power to the Nova73.

you can switch on the power to other system components (e.g. DALLIS units) at any time. 

The control system boots in a few seconds; during this time the Central GUI reports back on the boot-up
progress.

By default, the warm start data is loaded at the end of boot-up. This means that the system comes back exactly
as it was when you last shut down, ensuring fast recovery of all previous settings following a loss of power.

Depending on who was last using the console, you can be sat in front of a fully configured control surface with
DSP settings or a series of blank fader strips! In either case, the fastest way to reset the console is to load a
production.

The control surface and Nova can be booted before DALLIS units. This enables you to prepare settings,
including signal routing, before remote DALLIS stageboxes are connected or have received power.

Starting the System (Cold Start)

Alternatively, the system can be set to cold start, following the next reboot, using the Prepare Coldstart option in
the System Settings display. Or, the Prepare Coldstart button on the front of the Router Module (MKII).

Select the Prepare Coldstart option, and then force a restart by powering off, and then on, the Nova.

A cold start boots without loading any warm start data. You should perform a cold start only if there is a problem
with the warm start data, or if you wish to clear all warm start data from the system.

The best way to reset the console for a new job or show is to load a production. (A cold start resets the
system back to its cold start data and factory default settings.)
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Warm Start & Cold Start Data

Warm Start Data

The following settings are stored in the warm start data, and are recalled following a warm start:

· Matrix crosspoints.

· The DSP configuration.

· The console’s complete settings (control surface layout, etc.)

· All DSP parameters (EQ, Dynamics, etc.).

· All I/O parameters (Mic preamp gain, SRC on/off, etc.)

· Any Core configuration settings changed by an online AdminHD computer.

Cold Start Data

Following a cold start:

· All matrix connections are cleared, unless protected by a factory configuration (.tcl) file.

· The default DSP configuration is loaded. This can be defined from the Custom Functions display.

· The control surface will appear blank (no fader strip assignments).

· All DSP parameters are set to factory default values.

· All I/O parameters are set to factory default values

· All configuration files return to their cold start defaults (config.tcl, gui_config.tcl, etc.)
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Restarting a Bay Server

Each TFT display on the mc²56 MKII has its own Ethernet Bay Server which can be restarted from the front panel.
You should perform this procedure, rather than a system restart, if:

· the graphics on an individual display freeze or look odd. 

· the controls on a panel are not responding; indicators not updating.

These symptoms can sometimes occur if a Bay Server looses its Ethernet connection to the control system.

1. Using a pointed object, press the recessed button on the top of the display:

The Bay Server restarts. Once the restart is complete, communication with the control system is re-established,
and the selected display reinstated.
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System Logfiles

During operation, the system generates and stores logfiles on the control system. This allows you to export the
files to assist Lawo service with fault-finding.

There are 4 principle logfiles:

· alarm.log - global alarm errors (the last 5000).

· alarm.log.old - archived global alarm errors (the previous alarm.log file).

· messages - messaging errors generated by the control system (the last 5000).

· messages.old - archived messaging errors (the previous messages file).

Logfiles can be copied to USB, from the console GUI, using the File display, see the "mc²56 MKII Operators
Manual":

Alternatively, you can monitor the contents of a log file, remotely from your computer, using the Web Browser
Interface.

Ø  Timestamping a logfile

From V4.24 software onwards, two enhancements have been made:

· Timestamping - click on the LAWO logo, from the Central GUI's title bar, to create a time stamp in the
messages file. This marks the logfile at a moment in time, and can assist Lawo's service department
when diagnosing system behaviour.

· DSP change - whenever the DSP configuration changes (by loading a production, changing the DSP
configuration or switching to a redundant DSP card), information about every DSP card is printed in the
alarm.log. The information is formatted as follows:

New DSP card role for {HDCore 0, Slot 14}: active (role index 1)

New DSP card role for {HDCore 0, Slot 12}: active (role index 2)

New DSP card role for {HDCore 0, Slot 10}: active (role index 3)

Ø  Reading a logfile

From V5.0 software onwards, each line within the messages file is formatted in three sections:

<Software Module> <Error Type> <Details>

The <Error Type> indicates the severity of the error as follows:

· DEBUG - information for developers, not usually seen once a release is issued.

· INFO - general information, not a real error. 

· WARNING - an error with low impact.

· ERROR - an error with moderate impact. 

· FATAL - a serious error which could lead to system crashes.

By searching the messages file for the appropriate text - e.g. FATAL - you can quickly identify the relevant
information.

mailto:service@lawo.com
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GUI Diagnostics

The console's Central GUI, or an mxGUI computer running online, provides the following system diagnostics:

Nova73/DALLIS Status

If a Nova73 or DALLIS component fails, or a connection is lost, then a hazard warning flag appears in the title bar
of the console GUI. Use the Signal Settings display to interrogate the source of the problem. This display
monitors all the Nova73 and DALLIS components which are defined in the Core configuration.

Control Surface Connection

If a redundant Router Module and Ethernet connection to the control surface are installed, then the operator is
presented with an error message should the active connection fail. They can then decide to force a takeover or
investigate the cause of the problem.

Control Surface Power 

On the right of status bar, the console GUI offers status monitoring for all power supplies. You will see a red circle
with an exclamation mark if a supply has failed.

Redundant Control System Takeover

If a redundant Router Module MKII is fitted to the Nova73, then you can force a manual takeover to the redundant
control system, either from the System Settings display or by pressing the recessed button on the front of the
Router Module.

Prepare Cold Start

The system can be set to cold start, following the next reboot, using the Prepare Coldstart option in the System
Settings display.

Bulb Test, Fader Calibrate, OLED Saver Enable

These options, in the System Settings display, can be used to test the control surface illumination, calibrate the
faders or enable the OLED display saver (recommended to prolong their lifespan). See the "mc²56 MKII Operators
Manual" for details.
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AdminHD Diagnostics

An AdminHD computer running online provides the following system diagnostics:

Nova73/DALLIS Status Monitoring

Once AdminHD is running online, you can use the 'Core Browser' and 'Hardware Panel' to monitor the real-time
status of hardware components.

In addition, the 'Remote Log' records all messages generated by AdminHD and the online system. You can save
the contents of the 'Remote Log' to help diagnose any errors.
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Web Browser Interface

The control system includes an integrated web server. This allows status information to be monitored from a
remote computer, via any normal* web browser.

* To ensure all graphics are correctly displayed, we recommend the following minimum browser requirements:
Internet Explorer 10 or Edge 12; current Versions of Firefox, Safari or Chrome.

1. Connect your computer to the Lawo system network.

2. Configure the TCP/IP settings on your computer's network interface card.

3. Open your browser software, and enter the IP address of the mc²56 MKII control system into the URL
field.

You can check the IP address of your control system from the console GUI (using the System Settings display,
see IP Address Primary). See also TCP/IP Addresses for a list of the default IP addresses for different Lawo
products.

The System Overview page opens within the browser:

If the page does not open, then see the trouble-shooting tips.

4. To automatically refresh any page turn on the Auto Refresh option at the top right of the screen.

5. Use the menu bar at the top of the page to access the different pages.
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System Overview

The main System Overview provides information on system software versions, Network Configuration (of the
main and redundant Control Systems) and Device Information (Image Versions) for any connected RAVENNA
Link ports:

System Overview -> Netlink Usage

Select this page for information about the "netlink" connections in a DSN networked system.
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System Overview -> Network Information

This page provides more information about RAVENNA Link control ports and their partnering connections:
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System Overview -> GPIO States

Select this page for an overview of the High/Low status of GPIOs:
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Alarm Management

Alarm Management -> System Alarm

This page lists the last 5000 errors which have triggered the Global Alarm. Every error has an explicit ID,
description and time stamp for an easy overview of the alarm events. The errors are stored within the system
logfile: alarm.log.

Alarm Management -> Alarm Backlog

Select this page to view archived errors (the previous alarm.log file). These errors are stored within the system
logfile: alarm.log.old.
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Device Information

Device Information -> Device Availability

The Device Availability page provides information about system components - for example, the Micro Core or
HD Core. Here you will find detailed information, including feedback on the sync source, alarm statuses, slot
status, etc. 
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Device Information -> Silence Detects

This page lists any silence detect errors generated during operation:

Device Information -> DSP Usage

Select this page to view the DSP card usage of the system:
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System Log Files

This page provides access to all logfiles stored on the control system, allowing you to view system log files
(messages) or alarm log errors. Select an option to view the contents of the file.
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Telnet Sessions

Many parameters on the mc²56 MKII can be adjusted by opening a telnet session to the device's control system.

Warning

Adjusting parameters via telnet will make low level changes to your system. Therefore, these procedures
should only be performed by a fully trained member of staff.

To open a telnet session:

1. Install a telnet client on your computer. We recommend using Tera Term Pro Web 3.1.3, a free telnet
client for Windows, which can be downloaded from www.ayera.com/teraterm/

2. Connect your computer to the device, via either the control system network or service port (in the case of
an individual component).

3. Configure the TCP/IP settings on your computer's network interface card.

4. Open the Tera Term Pro Telnet client.

5. Select TCP/IP from the Setup menu, and add the TCP/IP address of your device to the host list:

6. Now open a new Telnet connection using File -> New connection:

http://www.ayera.com/teraterm/
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7. Choose the TCP/IP Host address of your control system:

Default IP Address of mc266 shown:

8. When prompted, enter the login name: root  and the password: hong

The session opens, and you will see the command prompt for the control system:

9. Now follow the specific instructions for the task you wish to perform.

Some parameters are not saved on the main control system, and therefore you can need to remotely login to
another part of the system.

You can reboot the control system from the telnet client by typing reboot and Enter.
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Logging in to a Remote Control System

To remotely login to another control system (for example, the GUI_0 Bay Server):

1. At the main control system prompt, type ipinfo and press Enter - a list of all system IP addresses is
displayed:

Telnet Session to mc256 shown:

For our example, the IP address we require is 192.168.105.100 (thaddeus_GUI_0).

2. Type telnet xxx.xxx.xxx.xx (where xx.. is the IP address of the remote control system) and press
Enter.

3. When prompted, enter the login name: root  and the password: hong - the session opens, and you will
see the command prompt for the remote control system:

4. Now follow the specific instructions for the task you wish to perform.

5. Once you have finished, return to the main control system by typing quit.
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File Transfer via FTP

All files stored on the control system can be accessed by a suitable FTP client. 

You will need this tool to transfer files, such as system software or factory configuration (.tcl) files, which are
"hidden" from normal console GUI, mxGUI and AdminHD operation.

Warning

File transfer via FTP will make low level changes to your system. Therefore, these procedures should only be
performed by a fully trained member of staff.

To perform a file transfer:

1. Install a suitable FTP client on your computer. We recommend using Filezilla, a free FTP client for all
platforms, which can be downloaded from www.filezilla-project.org

2. Connect your computer to the Lawo system network.

3. Configure the TCP/IP settings on your computer's network interface card.

4. Open the Filezilla FTP client, and enter the following information: 

· Host = the IP address of your control system

· Username = root

· Password = hong

Default IP address of mc256 shown:

5. Click on Quickconnect to make the connection.

The session opens, and you will see the filing system of the control system on the right (under Remote Site):

http://filezilla-project.org/
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6. BEFORE transferring files, check that the Transfer Type is set to Binary:

Warning

It is VERY important that file transfers use "Binary" mode, and not "ASCII".

7. You can now transfer files from the control system (Remote site) to your computer (Local site), or vice
versa:

· Use the upper areas to navigate through the filing structure - the contents of the selected folder are
displayed beneath (under Filename).

· Right-click on a filename and select Upload or Download - the file is transferred to/from the selected
folder.

Further information on system files can be found in the relevant technical documentation.
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Nova73

This section covers hardware servicing for both the Nova73 HD and Nova73 Compact core:

· Replacing the Fans

· Replacing a Power Supply Unit

· Router Module MKII: LEDs & Switches

· Replacing a Router Module

· Replacing a System or User Data Flashcard

· Updating Configuration and Software in a Redundant System

· I/O & DSP Modules: LEDs & Switches

· Replacing an I/O or DSP Module
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Replacing the Fans

Each of the cooling fans can be replaced individually while the Nova73 is running:

Nova73 HD rear view

Nova73 Compact rear view

1. Unplug the 4-pin connector from the rear of the frame as shown above.

2. Loosen the screws and remove the fan from the frame.

3. Insert the replacement and fasten the screws to secure.

4. Plug the 4-pin connector into the coupler of the frame.
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Replacing a Power Supply Unit

Each of the PSUs are individually hot pluggable. 

To operate the Nova73, one PSU is sufficient. Therefore, when two supplies are fitted, you can replace a PSU
without affecting the operation of the system.

Warning

If only one PSU is operational, then powering off will shutdown the system.

The replacement PSU must be of the same type; you cannot mix PSU types.

Nova73 HD front view

Nova73 Compact front view



mc²56 MKII Technical Manual V5.10.2/1 257

Chapter 4: Service/Maintenance
Nova73

1. Switch off the PSU you wish to replace from the front of the frame as shown above.

2. Disconnect the mains from either the PSU 1 or PSU 2 IEC mains connector as appropriate.

3. Unfasten the four screws and, using the handle provided, pull out the PSU.

4. Before fitting the replacement PSU make sure that it is switched off.

5. Insert the new PSU and slide it into position until it locks into place.

6. Secure the unit by fastening the four screws.

7. Re-apply the mains to the PSU IEC mains connector and switch on!

Warning

For air conditioning reasons, both PSU slots MUST be occupied when the Nova73 is operational:

· Nova73 HD: if only one PSU is installed, then please fill the empty slot with a dummy plate (Type
980/21). 

· Nova73 Compact: leave both PSUs in the frame until a replacement can be fitted.
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Router Module MKII: LEDs & Switches

The Router Module MKII (980/33) provides the following front panel connections, LEDs and switches:

ACTIVE LED Flashes green when the control system is booted and running.

The ACTIVE LED on each Nova73 module, or DALLIS card,
should blink in time with all other ACTIVE LEDs (at 1Hz). This
shows that the card is synchronous to the rest of the system. If
an LED is out of sync, then check that the card is fitted
correctly, and if the symptom persists, replace the card.

STANDBY LED Illuminates in yellow if the module is in standby. 

If you have a main and redundant Router Module fitted to the
Nova73, then one module will be ACTIVE while the other is in
STANDBY.

CHARGE LED Illuminates when the backup power unit is charging. 

Off = unit is fully charged.

ALARM LED Illuminates in red when the global alarm is active.

SYNC LEDs These four LEDs indicate the system's sync source:

Flashing green = current sync reference.

Solid green = available redundant sync reference.

PREPARE
COLDSTART

Press this button (the LED illuminates) to prepare a cold start.
The system will then cold start following the next power cycle /
system reboot.

LAMP TEST Press this button to test all the LED lamps within the Nova73
plug-in modules.

MODULE
TAKEOVER 

If you have a main and redundant Router Module fitted to the
Nova73, then press this button to force a takeover to the
redundant control system.

After a few seconds, the ACTIVE and STANDBY LEDs on the
two modules update accordingly.

ETHERNET A

ETHERNET B

Connects to the control surface.

Connects to the Lawo system network.

Both connections are RJ45. The ACTIVITY LEDs flash in green
when data is being transferred.

POWER Button This recessed button will power cycle the Router Module. It
should only be used as a last resort if all other restart methods
fail.

Silk Screen Shows the part number of the module.

Further information can be found in the data sheet, available in the "mc2_Nova73_documentation" guide.



mc²56 MKII Technical Manual V5.10.2/1 259

Chapter 4: Service/Maintenance
Nova73

Replacing a Router Module

Router modules are individually hot-pluggable.

If main and redundant Router Modules are fitted to the Nova73, then you can replace the redundant module (in
STANDBY) without affecting the operation of the system.

Warning

If only one Router Module is fitted, then replacing the module will shut down the system!

See Installation: Mounting the Nova73 Modules for instructions. 
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Replacing a System or User Data Flashcard

A backup image copy of the System Flashcard and/or Data Flashcard can be created and stored, so that it can
be replaced if necessary.

From Version 5.8.2 software, the CF Card Creator utility can be used to create the image copies. This utility can
be launched from mxGUI (as described in the "mc²56 MKII Operators Manual").

Once you have the new CF card, it can be replaced as follows.

You must power off the Nova73, thereby shutting down the system, in order to replace a CF card.

If main and redundant Router Modules are fitted to the Nova73, then please see the additional instructions on
updating data in a redundant system.

Both CF cards are located on the Router Module MKII (980/33) within the Nova73:

1. Power off the Nova73 (both PSUs if fitted) and remove the Router Module.

You will see the System and Data CF cards slotted into the Control System; each should be clearly labelled:
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2. Remove the appropriate card and slide in your replacement.

3. Replace the Router Module and power on.

The control system boots and reads the new data.
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Updating Configuration and Software in a Redundant System

For redundancy to work, both main and redundant control systems must hold identical information and mirror
each other. 

User data (productions and warm start data) is mirrored at all times. However, the cold start configuration and
system software are only synchronised when the control system boots up. This has implications if you wish to
upload a new AdminHD configuration or update system software.

Let’s take an example where your main control system is called A and the redundant control system is called B.
If you upload your new configuration or software to control system A and then perform a cold start, the following
will occur:

· The system responds to the cold start of the main control system (A) by automatically switching to the
redundant control system (B).

· At the end of the cold start, data from the active control system (B) is copied back to the redundant
control system (A). In other words, your new data is overwritten!

To avoid this, and upload a new configuration or update software successfully:

1. Disable the redundant control system.

This can be achieved by releasing the locking catches, fitted to the top and bottom of the redundant Router
Module (in STANDBY):

This unlocks the module from the Nova73 and automatically disables it; the module's LEDs should be off. Note
that it is not necessary to pull out or remove the module.

2. Now upload your new AdminHD configuration, or upload the new software, and cold start - the system
restarts using the new configuration files or software.

3. Once the control system is running (ACTIVE LED flashing), lock the redundant Router Module back into
place to reactivate it - the redundant Router Module boots up, and all data from the main control system is
copied across.

4. Cold start the system once more to confirm that step 3 was successful.
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I/O & DSP Modules: LEDs & Switches

The front of each I/O and DSP module provides some useful LEDs:

· ACTIVE LED – shows that the module’s internal control system is booted and running.

The ACTIVE LED on each Nova73 module, or DALLIS card, should blink in time with all other ACTIVE LEDs (at
1Hz). This shows that the card is synchronous to the rest of the system. If an LED is out of sync, then check that
the card is fitted correctly, and if the symptom persists, replace the card.

· Other LEDs & Switches – some modules include additional status LEDs and switches. For details,
please consult the relevant data sheet, available in the "mc2_Nova73_documentation" guide.

· Silk Screen – shows the part number of the module.
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Replacing an I/O or DSP Module

All I/O and DSP modules are individually hot-pluggable enabling modules to be replaced without affecting the rest
of the system.

See Installation: Mounting the Nova73 Modules for instructions.
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DALLIS Unit(s)

This section covers servicing the DALLIS hardware:

· Replacing a Power Supply Unit

· Master Board: LEDs & Switches

· Replacing a Master Board

· Replacing the Lithium Battery

· I/O Cards: LEDs & Switches

· Replacing an I/O Card
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Replacing a Power Supply Unit

Each of the PSUs are individually hot pluggable. 

To operate the DALLIS, one PSU is sufficient. Therefore, when two supplies are fitted, you can replace a PSU
without affecting the operation.

Warning

If only one PSU is fitted, then powering off will cause an interruption in audio from the DALLIS unit!

The replacement PSU must be of the same type; you cannot mix PSU types.

1. On the rear of the DALLIS frame, disconnect the mains from either the PSU 1 or PSU 2 IEC mains
connector as appropriate.

2. Unfasten the two screws on the right hand side of the hinged PSU cage door (marked by the arrows
below). 

3. And pull the door open to access the PSU docking bays:

Unfasten these screws: Pull door open to reveal PSUs:

4. Unfasten the metal catch which holds the PSUs in place by pushing on the catch as shown:

5. Remove the relevant power supply unit and replace with the spare.

6. Fasten the catch back into place.

7. Replace the cage door and fasten the two screws.

8. Re-apply the mains to the PSU IEC mains connector and switch on!
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Master Board: LEDs & Switches

A choice of DALLIS master boards support different connections to/from the Nova73. All versions provide similar
front panel functions:

ACTIVE LED Flashes green when the card’s internal control system is
booted and running.

The ACTIVE LED on each Nova73 module, or DALLIS card,
should blink in time with all other ACTIVE LEDs (at 1Hz).
This shows that the card is synchronous to the rest of the
system. If an LED is out of sync, then check that the card is
fitted correctly, and if the symptom persists, replace the card.

 

WCLK OK
LED

Illuminates in green when the DALLIS is receiving a valid sync
signal.

POWER OK
LED

Illuminates in solid green when the DALLIS PSUs are running
normally. 

If the LED flashes, then there is a PSU error.

ALARM LED Illuminates in red when the local DALLIS alarm is active.

WCLK Port The DALLIS can be synchronised to an external sync
reference connected to this BNC.

I/O Ports See DALLIS master boards for details on the different I/O
connections.

On some boards, LEDs show the status of the signals
arriving at the connection.

CTRL Port This port can be used to connect a local computer to update
firmware or provide diagnostics.

Silk Screen Shows the part number of the master board.

Further information can be found in the data sheet, available in the "mc2_Nova73_documentation" guide.
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Replacing a Master Board

Master boards are individually hot-pluggable.

If main and redundant master boards are fitted to the DALLIS, then you can replace the redundant board without
affecting the operation.

Warning

If only one master board is fitted, then its replacement will cause an interruption in audio from the DALLIS
unit!

See Installation: Mounting the DALLIS Cards for instructions.
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Replacing the Lithium Battery

The DALLIS master board is fitted with a lithium battery. This battery guarantees that user data remains saved
when the system is powered off. As a precaution we recommend that the battery is replaced after about eight
years of operation. Please send the master board to your local Lawo service representative to perform this
procedure.

Only Lawo service staff are permitted to replace batteries.
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I/O Cards: LEDs & Switches

The front of each I/O card provides some useful LEDs:

· ACTIVE LED – shows that the module’s internal control system is booted and running.

The ACTIVE LED on each Nova73 module, or DALLIS card, should blink in time with all other ACTIVE LEDs (at
1Hz). This shows that the card is synchronous to the rest of the system. If an LED is out of sync, then check that
the card is fitted correctly, and if the symptom persists, replace the card.

· Other LEDs & Switches – some cards include additional status LEDs and switches. For details, please
consult the relevant data sheet, available in the "mc2_Nova73_documentation" guide.

· Silk Screen – shows the part number of the card.
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Replacing an I/O Card

With the exception of the Phantom Power card, all cards are individually hot-pluggable enabling cards to be
replaced without affecting other aspects of the system.

See Installation: Mounting the DALLIS Cards for instructions.
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Control Surface

This section covers servicing the control surface hardware:

· Replacing a Panel

· Using the Hood Fastener

· Replacing a Fader

· Calibrating a Touch-screen

· Replacing a TFT Display

· Bay Server Rotary Switch Settings

· Replacing a Power Supply Unit

· Replacing the Local I/O Board

· Adjusting the Local I/O Jumper Switch Positions

If the graphics on an individual display freeze, or the controls on a panel are not responding, then try 
restarting the Bay Server.
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Replacing a Panel

Each control surface panel is individually hot-pluggable enabling panels to be replaced without affecting the rest of
the system.

Channel bays are fitted with one 16-fader panel per bay. The centre section is fitted with one central panel
connecting to two circuit boards.

Ø  To replace a panel:

1. Remove the panel screws (along the front buffer) using a T20 Torx driver:

You should remove the screws completely and place them carefully to one side, so that they do not fall into the
frame when the panel is lifted. The springs beneath the panel will raise it slightly from the frame.

2. Gently lift the panel using your fingers:

If you are lifting the central panel to gain access to the components beneath, then use the Hood Fastener to
keep the panel in place while you work.
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3. Remove the USB and power connectors taking notes on where each one should be fitted:

Fader panels have one USB and one power connector. From the central panel, there are two USB and two
power connectors.

Channel Bay: Centre Section:

4. Carefully remove the panel by lifting it out of the frame.

5. Check that the rotary switch settings on your replacement panel are correct - they should both be set to
0, irrespective of the frame position. For details, please check the panel's data sheet, available in the
"mc2_Nova73_documentation" guide.

6. Insert and reconnect the replacement panel, and fasten the screws back into place.

 If the control surface is powered, the panel will boot within a couple of seconds.
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Hood Fastener

The Hood Fastener can be used to keep the central panel in place while you work inside the console. This avoids
having to disconnect cables, and remove the panel, when you need access to other components.

1. Follow the previous section's steps to lift the panel - you will see the Hood Fastener, stowed safely along
the front buffer:

Central Panel lifted: Hood Fastener Stowed:

2. Release the fastener from its catch, and position it against the metal plate (to the left of the trackball) as
shown:

3. When you have completed your service procedure, replace the fastener safely back into its catch, before
lowering the central panel.
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Replacing a Fader

An individual fader unit can be replaced by removing the panel from the console. In our example, it is the left-hand
fader with the panel face-up (Fader Number 1), which is being replaced:

Panel Face-up Panel Face-down

1. Remove the panel from the console frame (see Replacing a Panel), and lay it it face-down on a piece of
foam, or similar ESD-proof protective material, away from the console. Take care not to touch the flat foil
cables.

2. Using a small flat-blade screwdriver, release the catches to disconnect the fader unit cables - there are
two cables to release:

3. Turn the panel face-up and remove the fader cap.

4. Remove the two screws holding the fader unit in place (using a T10 Torx driver):
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5. Turn the panel face-down and remove the fader unit. Note that the unit will be loose, and so it helps to
support it from behind as you turn the panel.

You are now ready to fit the replacement.

6. Insert the new fader unit into position.

7. Carefully lift the panel onto its side, supporting the fader from behind, and replace the two front panel
screws:

8. Turn the panel face-down once more and reconnect the two fader unit cables (see step 2).

9. Fit the panel back into the console frame (see Replacing a Panel), and test the functionality - if the
control surface is powered, the panel will boot within a couple of seconds.



mc²56 MKII Technical ManualV5.10.2/1278

Chapter 4: Service/Maintenance
Control Surface

Calibrating a Touch-screen

The Channel and Central touch-screen displays can be calibrated as follows:

1. Select the GUI's System Settings menu, GUI topic and Calibrate Touchscreens:

Touch-screen calibration is activated across all displays.

2. Follow the on-screen instructions to calibrate the first display. You will be prompted to touch various
points on the screen. 

When the last point is touched, calibration is complete, and all displays revert to their normal operation.

3. Repeat steps 1 and 2 to calibrate a different touch-screen.
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Replacing a TFT Display

Each of the touch-screen displays is individually hot-pluggable, enabling you to replace a display without affecting
any other bay within the console. (Note that you will lose control from panels within the bay, as the Ethernet Bay
Server is mounted behind the TFT display.)

If you need to replace the centre section display, then connect an mxGUI computer so that it can run online
and provide continued access to central GUI operations.

Ø  To replace a display:

1. Unfasten the three screws at the top of the display using a long T20 Torx driver, and gently tilt the unit
forwards:

Warning

The Torx driver shaft MUST be long enough to turn the countersunk screws without scratching the front
panel. If you attempt to use a short driver, or driver attachment, damage can occur.
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2. Lift the display unit out of the frame and lay it carefully face-down on a piece of foam, or similar protective
material, on top of the control surface:

3. Remove the LVDS, USB and power connectors taking notes on where each one should be fitted.

4. Check that the Bay Server's rotary switch settings on your replacement panel are correct.

5. Fit the replacement in the reverse manner.

If the control surface is powered, the display will refresh within a couple of seconds.
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Bay Server Rotary Switch Settings

Each channel and central bay is supported by an Ethernet Bay Server, mounted behind its TFT display. The Bay
Server has a rotary switch with two settings:

· Function - determines whether the Bay Server supports a channel or central GUI bay.

· Address – determines the Bay Server index, counted from left to right across the frame starting at 0. 

You may need to adjust these settings if you are replacing a TFT display or adding an extender. 

The settings also determine how the Bay Server control system is named; this will help locate its IP address
should you need to perform a remote login. 

Bay Server
Location Function

Address Control System Naming

Central GUI 8 0 "nickname"_GUI_0

Channel Bay 0 0, 2, 4, etc. "nickname"_BAY_0, BAY_1, etc.

Note that for channel bays, address 0 is the left-most bay.

The example below shows the settings for a 32+16C+16 frame:

Adding an Extender Bay

If an extender is added to the left of the main frame, then the addresses of each main frame bay must be shifted
upwards. 

If the extender is added to the right, then its address can be counted upwards from the main frame.
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To Adjust a Bay Server's Rotary Switch Settings

1. Remove the TFT display from the bay you wish to adjust. If you lay the display on top of the control
surface panel, you do not need to disconnect any cables.

2. Locate the two rotary switches on the Bay Server control board. This is the board mounted at the top of
the display unit (closest to you in the pictures below):

3. Adjust the Function and/or Address settings.

4. Replace the TFT display.
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Replacing a Power Supply Unit

Depending on the frame size, either one or two PSU blocks are fitted to each control surface frame. To replace
one you will need to disconnect the PSU block from its distribution board (located beneath the control surface
panel), and remove the TFT display (to access the PSU block).

There is always one PSU block fitted to the central bay:

For larger frames, the second PSU block is fitted to the left-most channel bay:

Extenders are also fitted with their own PSU block:
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Ø  To replace a PSU block:

1. Turn off the power to the control surface by disconnecting ALL MAINS connectors - press the red button
on the IEC connector to release the plug.

Warning

DO NOT attempt to access the power supply unit without disconnecting the mains.

You must remove the MAINS connectors from the frame, rather than from the wall, as the IEC sockets form
part of the PSU module. If you do not, then the PSU module will get stuck during step 7.

2. Lift the control surface panel in the PSU bay, to gain access to the distribution board. In the central bay,
the distribution board is located on the right below the Overbridge:

3. Using a T20 Torx driver, disconnect the PSU block from the distribution board by removing the 4 wires
shown below:

Warning

Do NOT disconnect any wires other than those shown.

4. Lower the control surface panel back into place, but do not fasten the panel screws as access will be
required again in step 11.
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5. Now remove the TFT display within the PSU bay. If you lay the display on top of the control surface
panel, you will not need to disconnect any cables.

You will see the power supply block mounted at the rear of the frame:

6. Using a 7mm hex socket, remove the two screws holding the power supply block in place, followed by
the single screw attaching the protective earth:

Warning

Take care NOT to drop any nuts or washers into the desk.

7. Remove the PSU block from the frame, taking care to extract the distribution and protective earth cables
along with the unit.

8. Now fit the replacement block (which comes with its own 4-wire distribution and protective earth cabling).
The 4-wire distribution cables should be fed down the distribution board area.

9. Screw the protective earth to the frame, and replace the two securing screws (see step 6).

10. Then replace the TFT display (see step 5).

11. Lift the control surface panel once more, and connect the PSU block to the distribution board (see step
3).

12. Replace the control surface panel, and fasten into place.

13. When everything is back in place, re-connect the rear mains IEC power connectors, and power on.
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Replacing the Local I/O Board

The local I/O board is mounted inside the control surface beneath the central panel. It can be replaced as follows.
The instructions apply to both local I/O board types - 958/55 (MADI) and 958/50 (RAVENNA).

Central Panel Lifted (no local I/O fitted) Local I/O Carrier Unit (disconnected)

Ø  To replace the Local I/O:

1. Turn off the power to the control surface by disconnecting ALL MAINS connectors - press the red button
on the IEC connector to release the plug.

Warning

DO NOT attempt to access the local I/O board without disconnecting the mains.

2. Lift the central panel to gain access to the local I/O (on the left hand side), and use the Hood Fastener to
keep the panel in place while you work:
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3. Remove all of the connectors from the local I/O carrier, in the order described below, taking notes on
where each one should be fitted:

Local I/O (side view)

a. Disconnect the power connector from the backplane, and open the clamp to release the cable.

b. Disconnect the master connector - either MADI (optical SC) or RAVENNA (CAT5 RJ45). The connector
type depends on the version of your local I/O board.

Note that on the 958/55 MADI board, the 9-pin D-Sub and BNC are unused. On the 958/50 RAVENNA board,
the master cable connects to the left-hand RJ45 socket, while the right hand RJ45, BNC and SFP cage are
unused. 

958/55 MADI 958/50 RAVENNA

c. Disconnect all of the I/O cables by unlocking and removing each D-Sub connector. The numbers beside
the connectors correspond to the ribbon cable labelling. The following reference diagram can be found on the
cable duct to the right of the local I/O:

Start with the two upper 37-pin D-Subs (2 & 3); then the two lower 37-pin D-Subs (1 & 4); then the 50-pin GPIO
D-Sub (6); the four 15-pin D-Subs (1, 2, 5 & 3); and finally the 37-pin PHONES D-Sub (no number, it is the only
rounded connector).
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Some D-Subs are unlocked by loosening the two connector screws. Others unlock by moving the sliding lock
mechanism (use a small flat-bladed screwdriver to slide the mechanism carefully to the left or right).

D-Sub Unlocked/Locked by Screws D-Sub Sliding Lock Mechanism

There are two versions of the I/O carrier in the field, using different directions for the sliding lock mechanism. 
You can verify the direction by looking at the position of the screws; when open, the screws are not covered by
the sliding part:

Version 1: To open, slide to the right Version 2: To open, slide to the left

4. Once all the cables have been disconnected and carefully stowed, loosen the local I/O carrier from the
console frame. There are two nuts, one at the front (near the console arm rest), and one at the rear (below the
Overbridge).

The front nut should be removed completely and placed to one side. The front of the carrier unit can now be
lifted over the bolt, and if the rear nut is loose, the unit will slide forwards.

If the rear nut has been tightened, then you may need to loosen it by opening the Overbridge (see Replacing a
TFT display for how to gain access).

Front Nut Rear Nut
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5. Carefully remove the carrier by sliding it forwards and out of the console frame. Take care that the frame
does not scrape the unit, and that the cables do not get caught:

You are now ready to fit the replacement.

6. Check the replacement unit - all D-Sub connectors should be in their open position, and the DIP switches
set to ON (to enable remote control of headphone volume):

7. Slide the unit into the console frame (see step 5), taking care not to scratch the unit or get any cables
caught underneath. The unit should slide underneath the rear nut; fit and tighten the front nut to secure (see
step 4).

In mobile installations, such as an OB van or fly-away kit, the rear nut should also be tightened. To access
to the nut, you will need to open the Overbridge (see Replacing a TFT display).

8. Replace the I/O, master and power connectors (see step 3), making sure that you lock each of the D-Sub
connectors.

9. Replace the central panel, and fasten into place (see step 2).

10. If not already connected, replace the Nova73 connection (MADI or RAVENNA) and audio connections on
the rear panel of the console.

11. When everything is back in place, re-connect the rear mains IEC power connectors, and power on. Then
check the functionality of the local I/O.
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Adjusting the Local I/O Jumper Switch Positions

The local I/O connector board includes four adjustable jumper switches (JP 1,2 and JP 3,4) which determine two
settings: the choice of "internal talkback mic source" and the connection to Line input 16. See Jumper Switch
Positions for an overview.

To adjust the switch positions:

1. Remove the Central GUI's TFT display to gain access to the local I/O connector board:

The following reference diagram can be found on the cable duct to the right of the local I/O board (beneath the
central panel):

2. Locate the correct pair of jumper switches: either 3 & 4 (JP 3,4) or 1 & 2 (JP 1,2) - the locations and
default positions are shown above and below:

Jumpers 3 & 4 (adjust Line In 16) Jumpers 1 & 2 (adjust the TBK source)
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3. In each case, take care to move BOTH jumpers to change a setting:

· Jumpers 3 & 4 = position 1, 2: Line input 16 comes from the talkback source (the default setting).

· Jumpers 3 & 4 = position 2, 3: Line input 16 comes the LINE IN 9-16 connector.

· Jumpers 1 & 2 = position 1, 2: Internal talkback comes from the standard talkback mic preamp. 

· Jumpers 1 & 2 = position 2, 3: Internal talkback comes from the optional 962/16 talkback mic preamp.

For more details on the options and signal flow, see Local I/O Wiring.
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Chapter 5: mcx System Update

This chapter describes how to update a mc2/Nova system.

Topics include:

· Introduction

· Backup of User Data

· Updating the System

· System Configuration Modifications

· Additional Notes
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Introduction

Please follow all the topics starting from the beginning, and check the Additional Notes for any special hints
relating to the current release.

If Compact Flash cards need to be changed, please consider strict ESD protection procedures when touching the
electronic components.

Any loudspeakers and headphones must be disconnected or turned off before starting the update procedure as
noise or other distortion may occur. 

Before updating any mxGUI applications, please refer to the mxGUI chapter of your Operators Manual.

Please note that support for systems using a Lawo 980/31 or 980/32 audio router card has been discontinued
from Release 5-0-0-0.

There are some update procedures which are necessary for mc2 systems only. These will be marked with the tag
[mc² series only]. Please skip these instructions when updating a Nova system.

In some instances, there will be a choice of procedures depending on the current and intended versions. These
are explained in each topic.

As a first step, we recommend backing up all user data (including configuration files, productions, snapshots
etc.). This can be done using either mxUpdater (included with mxGUI) or an FTP client (FileZilla, WS-FTP etc.).
These procedures are described in the next topic.

During the update, we recommend that you power cycle the updated components. This means that components
cannot be updated while running "hot" as there will be a noticeable disruption to audio.

Once running Version 5.8 (or later), there can be a mismatch in your configuration if you install an earlier release
than 5.8. Therefore, please contact the Lawo service department if you wish to downgrade your software version to
a release < Version 5.8.
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Backup of User Data

Prerequisites

To create a backup of the system’s user data, you will need:

· A PC or laptop. We recommend using a Microsoft Windows operating system, but any other OS with the
necessary client software (FTP, telnet, etc.) will do.

· A network connection to the Lawo system network (Ethernet). Remember to setup an unused IP address
when connecting the PC to the network.

· Either mxGUI or an FTP client.

Backup using mxUpdater (included with mxGUI)

From Version 5.8.2 software onwards, the mxUpdater utility can be used to backup and restore all user data on
the data CF card. Note that you must have the mxGUI shared folders configured to use this method.

· Start mxGUI and at the launch window select mxUpdater. The program opens.

· Under "1 - Select Remote System", enter the IP address of the primary control system and click on 
Connect. After a successful connection, you will see some information about the system.

· Under "2 - Backup Data", select Backup. Enter a file name and then start the backup by clicking on
Save.

· Once the backup is complete, you will see the line DETAIL: Backup operation done in the "Log" area.
The backup file is stored on the mxgui computer in the mxgui_config_share -> mxupdater -> backup
folder:

For more details, please see the mxUpdater topic in the mxGUI chapter of your Operators Manual.

Backup using an FTP Client

This method can be used to backup user data from a system running any software version.

· Start your favourite FTP application. FileZilla is included in the Lawo software update bundle.

· IMPORTANT: please make sure that the file transfer type is set to binary in your FTP application. If this
is accidentally set to ASCII, or if the auto detection fails, then production data will be destroyed. 

· Open an FTP connection to the IP address of the primary control system:

o Host = the IP address of the primary control system

o Username = root

o Password = hong

· Make a backup of all the contents of the /data partition (which can be found under /data or /media/sdb1/
in the remote file system). Save the data to a local folder on your PC.

For more details, see File Transfer via FTP.
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Updating the System

Prerequisites

To update the system, you will need:

· A PC or laptop. We recommend using a Microsoft Windows operating system, but any other OS with the
necessary client software (FTP, telnet, etc.) will do.

· A network connection to the Lawo system network (Ethernet). Remember to setup an unused IP address
when connecting the PC to the network.

· Either mxGUI or an FTP client plus the software update bundle (ISO image and/or ZIP file). The latest
mxGUI and system software releases can be downloaded from the Lawo website at www.lawo.com (after
Login).

· [optional] - if the current software version is earlier than 5.4, then you will need some additional items to
create the CF cards (see the next topic).

If you are using mxUpdater, then you only need to download and install mxGUI (as the correct system
software image files are included in the mxGUI bundle).

Possible Methods

Depending on your current and intended software versions, you will need to use one of the following methods to
update the system:

· mxUpdater (recommended) - from Version 5.8.2 software onwards, the mxUpdater utility can be used
to update the system from an mxGUI computer.

· Online Update (from V5.4 onwards) - from Version 5.4 onwards, you can start a system update by
opening a telnet or ssh session to the control system.

· New CF Cards (< V5.4) - if the current version is earlier than 5.4, then you MUST update the system by
creating new CF cards. Note that this is not necessary once your system is running V5.4 or later.

The methods will now be described in more detail, in reverse order.

http://www.lawo.com
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Creating and Replacing New CF Cards

From Version 5.4 onwards, all Lawo mc2 and Nova systems run a unified system image, and the system CF card

specifies the type of system (mc256 / mc266 / Nova73 / etc). This means that a new system CF card must be
created from scratch IF the current software version is prior to Version 5.4. If the current software version is
already Version 5.4 or later, then the system supports online updates and you can skip straight to the next topic. 

Requirements

You will need:

· A USB CF card reader.

· New CF cards (please use original Lawo CF cards only).

· A virtual machine host for VirtualBox.

· The mxGUI virtual appliance (OVA) from the Lawo software bundle.

Creating New CF Cards

The upgrade software bundle provides an OVA mxGUI image that can be imported into a VirtualBox environment:

· Double click on the OVA to import it into the VirtualBox environment

· Connect the CF card reader to the PC.

· Insert the CF card to be created into the CF card reader. Please note that all data on the CF card will be
lost when overwriting the card with the new content.

· Boot the newly created virtual machine and connect the CF card reader to it (using the software USB
rerouting feature of the virtual machine host).

· Once booted, the virtual PC shows a menu with different choices. Please select Utility Programs and
choose the corresponding entr: CFCard Creator or Bayserver CFCardCreator. Once started, the CF
card creator application shows a text based menu offering a choice of products. Please follow the menu
to locate your product and select it by pressing the ENTER key.

· When creating a system CF card, the appropriate system type has to be chosen from the menu. Take
care to select the correct system, as choosing the wrong type will lead to unexpected behaviour!

· When creating a data CF card, the system asks for the IP address configuration. Please enter the
system’s IP address, netmask and gateway (optional). Please note that a data CF card for a redundant
audio router module starts with the same IP settings as the primary module. The necessary IP address
offset (+1 for the right-hand module) will be applied automatically when the system boots.

· [mc2 series only] [optional] - the Bayserver CFCard Creator addresses products where bayserver
PCs need a CF card to boot. The bayserver is a small PC unit that is mounted behind the TFT displays. It
is responsible for transmitting the console panel data to the control system as well as for driving the
graphical application (GUI, Channel display). The software for the bayserver will be queried from the
control system when booting the bayserver PC. The bayserver also uses a CF card containing a
bootloader. This CF card can be created using the creator tool and selecting the appropriate menu item.

· [mc2 series only] [optional] - in some mc2 products, external bayservers are available. These are 19”
PC units with a DVI interface and USB interfaces to connect a display and input units like keyboard or
mouse. The main difference to the bayservers described above is that external bayservers do not include
a rotary switch to determine their function and address in the system. Therefore, this has to be configured
when creating new CF cards for external bayservers. The CF card creator application will ask for the
type/address combination before writing this information to the CF card.

· The CF card creator will ask for your confirmation before starting to write data to the flash disk.

Replacing the CF Cards

After creating the new CF cards, they must be inserted into the Router Modules as follows:

· Power down the Nova73 frame.

· Remove the Router Modules MKII and remove the CF cards to be replaced. See Replacing a System or
User Data Flashcard for images.
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· Insert the new cards. Please take care when inserting the cards to the corresponding card slots. They will
only fit in one direction. Do not force them in, they should fit smoothly.

· When all cards are installed, the Router Modules MKII can be re-inserted into the Nova73 frame.

· [mc² series only] Power down the console control surface.

· Power up the Nova73 frame.

· [mc² series only] Power up the console control surface.

· The system will cold-start and load a default user configuration. The user data must be restored from the
backup to establish normal system operation (see below).

· [mc² series only] [optional] When updating from older versions, sometimes the bayservers need an
update of the bootloader. A special information screen will appear during the boot-up is this is required.
Please follow the instructions on the screen.

· [mc² series only] [optional] The console control surface will check for new fader software at the end of
the boot-up. If a change applies, then the software update starts automatically. During this procedure, the
faders and joysticks will move to check the physical boundaries. Please do not obstruct the movement or
touch the faders and joysticks during the calibration.

· Restore your user data, either by using mxUpdater (via a correctly installed version of mxGUI) or FTP
client. The procedure is similar to the backup described earlier, except for the direction of transfer.

· To read the new configuration (loaded from the user data restore), you must perform another cold start.
Please use mxGUI to set the Prepare Coldstart option in the System Settings display. Or, use the
Prepare Coldstart button on the front of the Router Module (MKII). Then switch the Nova73 frame off and
on.

· As soon as the system has restarted and the configuration has been read correctly, please continue with
the Nova73 IO card update.

A telnet or ssh session to the control system can also be used to force a system cold-start: open a telnet or
ssh session to the control system IP address, and login with the username root and password hong. In the
command line interface, enter startSystemCold. 



mc²56 MKII Technical ManualV5.10.2/1298

Chapter 5: mcx System Update
Updating the System

mxUpdater & Online Update

If the current software version is already Version 5.4 or later, then the system can be updated without replacing
the CF cards. There are two possible options:

mxUpdater (included with mxGUI)

From Version 5.8.2 software onwards, the mxUpdater utility can be used to update the system from an mxGUI
computer. 

Note that this utility contains only the software version which is concurrent with the mxGUI release. Therefore, it
is only possible to update to this version. If you wish to update to a different version or downgrade the system,
then you must use the online update method described below.

To perform the update:

· Install the "new" mxGUI version on your computer. (Note that the correct system software image files are
included in the mxGUI bundle.)

· Start mxGUI and at the launch window select mxUpdater. The program opens.

· Under "1 - Select Remote System", enter the IP address of the primary control system and click on 
Connect. After a successful connection, you will see some information about the system.

· Under "3 - Update System", select Update. Confirm the update by clicking on OK. You will now see the
progress of the upload, update and validation steps in the "Log" area. Once the update is complete, a
system reboot is triggered.

· Note that the last few "Log" lines, including ERROR: Could not connect and ERROR: Update failed,
remote aborted, are a result of the reboot. These lines are normal and can be ignored.

· After the reboot, the software update is complete.

· Continue on to the Nova73 IO card update.

For more details, please see the mxUpdater topic in the mxGUI chapter of your Operators Manual.

Online Update

From Version 5.4 software onwards, you can start a system update by opening a telnet or ssh session to the
control system. This method can be used to downgrade the version or perform an update if mxUpdater is not
available. 

Note that you cannot use this method IF the current version is earlier than 5.4, as you must create new CF cards
instead.

To perform an online update:

· Download the software update bundle (ISO image and/or ZIP file) from the Lawo website at www.lawo.com
(after Login).

· Remove the redundant Router Module MKII (980/33) if one is fitted. This is the module on the right-hand
side, looking from the front.

· Locate the system CF card image (.tar.gz) in the software update bundle. It can be found in the
Software Release -> CF Card sub folder. Using your FTP client, transfer this file to the system. Please
select the /data/update folder as the target location. (Remember to check that the file transfer type is
set to binary in your FTP application.)

· Now open a telnet or ssh connection to the system IP address, and login with the username = root and
password = hong

· In the command line interface, enter updateSystem

· The system will present a choice of files (if multiple update files are found in the /data/update location).
Please select the file for the update. The system will ask for your confirmation before starting the update.

· The system will automatically reboot and perform a cold-start when the update has finished.

· [mc² series only] [optional] When updating from older versions, sometimes the bayservers need an
update of the bootloader. A special information screen will appear during the boot-up is this is required.
Please follow the instructions on the screen.

http://www.lawo.com
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· [mc² series only] [optional] The console control surface will check for new fader software at the end of
the boot-up. If a change applies, then the software update starts automatically. During this procedure, the
faders and joysticks will move to check the physical boundaries. Please do not obstruct the movement or
touch the faders and joysticks during the calibration.

· As soon as the primary Router Module MKII has restarted correctly, re-insert the redundant Router
Module MKII. The redundant module will synchronize and reboot automatically.

· Continue on to the Nova73 IO card update.
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Updating Nova73 IO Cards

From Version 5.6.0 onwards, all Nova73 IO cards will update to the corresponding firmware versions
automatically. Depending on the system configuration, this can take a while (10-15 minutes), and so now might
be good time to have a coffee!

· During the update, the card LEDs will flash quickly. As soon as they return to their normal blink
frequency, the update is finished. 

· [981/61 devices] The automatic update does not apply to RAVENNA-aware IO cards installed before
Version 5.4. See Updating RAVENNA-based nodes.

· Please wait for all Nova73 IO cards to blink synchronously (ACTIVE LED).

· Then continue on to the DALLIS IO update.
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Updating DALLIS IO Cards

The method which can be used to update a DALLIS depends on its connection type:

RAVENNA DALLIS (Automatic Updates)

From Version 5.6.0.0 onwards, all RAVENNA Net and RAVENNA Link DALLIS will update to the corresponding
firmware versions automatically. 

In this instance, the system checks the installed and "new" firmware versions at start up. If there is a mismatch,
then the update starts automatically. The DALLIS master card is updated first, followed by each IO card. 

Note that the network connections must be made correctly for automatic updates to complete successfully. See 
Automatic Update for details.

ATM or MADI DALLIS (Auto Update Script)

For ATM or MADI DALLIS (including the 947/22 in MADI mode), then you will need to start the auto update using
the following script:

· In the Nova73 frame, locate the active Router Module MKII (980/33) - if two modules are fitted, then this is
the one with the blinking "ACTIVE" LED; the passive module will have a blinking "STANDBY" LED.

· Open a telnet or ssh connection to the active Router Module's IP address, and login with the username = 
root and password = hong

· In the command line interface, enter mcxsh

· The command line prompt will change to mcxsh> as soon as the connection is established. Note that if
you try to start the mcxsh application on a passive Router Module, then an error message will occur.

· Start a complete update of the DALLIS IO by entering the command mcx_dallis_software_autoupdate
0

· Depending on the system configuration, this can take a while, and so now is a good time for a second
coffee!

· The display will show the progress of any updates and the results will be printed. At the end, you will see
a summary “Automatic update(s) finished” and any errors which have occurred. Please check that there
are 0 errors. If the system has detected any errors, then try starting the update again.

· After the updates are complete, power-cycle each DALLIS frame and make sure that all cards are
blinking synchronously (ACTIVE LED).

· Verify the DALLIS card states using the console GUI's Signal Settings page, AdminHD or the Web
Browser Interface.

Please note:

mcxsh is a command line application interface for the Lawo control system. Only a single instance of this
interface connect to the system, so remember to close the interface with the exit command, or CTRL+C, after the
update.

The "0" at the end of the command line is mandatory and will update all available DALLIS cards in the
configuration starting from the root point. If you wish to narrow the device configuration scan, then addresses can
be appended to the command using their 0-based slot/port numbers - for example: 

· mcx_dallis_software_autoupdate 0 9 will scan all DALLIS ports connected to Nova73 IO Module slot
10.

· mcx_dallis_software_autoupdate 0 9 2 will scan the DALLIS connected to port 3 of Nova73 IO Module
slot 10.

If your system uses both RAVENNA and MADI / ATM DALLIS, then wait for the automatic updates to the
RAVENNA DALLIS to complete before starting the auto update script 
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Updating RAVENNA-based Nodes

From Version 5.6.0 onwards, all RAVENNA DALLIS nodes can be configured either as RAVENNA Link or
RAVENNA Net.

Note that a change of configuration from RAVENNA Link to RAVENNA Net will require the installation of
additional hardware (e.g. PTP master clock, RAVENNA-compliant network switch, etc.) as well as a change in
the network topology. This requires proper planning and on-site commissioning, and you should refer to the

"RAVENNA for mc2 User Guide" for more information.

The update method which can be used for RAVENNA-based nodes depends on the currently installed firmware
version. The table below summarises the possibilites:

Original Version

Target Version and Component

5.10 Nova73 RAVENNA Link 5.10 DALLIS + Local IO

(mc56) RAVENNA Link

5.10 Compact IO + Local IO

(mc36)

4.18 – 4.22 manual + barebox manual + barebox N/A

4.24 manual + barebox manual N/A

5.0 manual + barebox manual N/A

5.2 (mc36) automatic manual script based

5.4 automatic manual script based

5.6 automatic automatic automatic

5.8 automatic automatic automatic

· A__line and LCU RAVENNA nodes (supported from 5.8 onwards) will be updated automatically if their
initial version is at least 7.0.0.x.

· Neumann DMI-8 nodes cannot be updated automatically. The minimum required software version is 1-0-
0-0 or later. This software is part of the LAWOs release bundle.

When updating a RAVENNA node to 7.0.0.x or later, any user configuration of PTP settings will be deleted
due to a syntax change in the configuration file. Therefore, you will need to reinstate the appropriate settings
manually via the RAVENNA Web GUI.

The topics which follow describe each method.
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Automatic Update

An automatic update will be started on the startup of each node. In this instance, the system checks the installed
and "new" firmware versions. If there is a mismatch, then the update starts automatically.

Please note, that an automatic update cannot be run in double frequency mode (i.e. 88.2 kHz or 96 kHz). If you
use a double frequency setup, please switch to 44.1 kHz or 48 kHz temporarily to perform the updates.

The figure below shows the network topology required to support automatic updates and for RAVENNA Net
operation of the Nova73 IO Module(s). Note that this topology is also required to update any DALLIS RAVENNA
nodes, as the network path from the Nova73 Router Module MKII (which works as an update server) is made via
the individual IO Modules.

Network Topology

As you can see in the drawing, the blue and the green clouds (Control System Network and Service Network) run
together on the second NIC of the Nova73 Router Module. This means that they have to be connected to the
same Ethernet switch network in order to work properly. 

Currently, it is not possible to use separate VLANs for the respective networks.
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Script-based Update

Updating the mc236 Local IO or Compact IO devices can require a script-based approach which has to be used
once – after the update to 5.6, all further updates will be automatic. 

For the script-based update please follow the steps below:

· Open a telnet or ssh connection to the mc236 control system IP address, and login with username = root
and password = hong

· In the command line interface, enter updateImxIos LocalIO to update the internal Local IO device.

· If a Compact IO device is attached to one of the external RAVENNA ports,then use the following syntax:

o updateImxIos CompactIO 6 1 if the Compact IO is attached to RAVENNA port 1

o updateImxIos CompactIO 6 2 if the Compact IO is attached to RAVENNA port 2

o updateImxIos CompactIO 6 3 if the Compact IO is attached to RAVENNA port 3
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Manual Update

To perform a manual update, please follow the steps below:

· If the table points out that a manual update is needed, usually the network topology is not yet ready for
automatic updates. If so, please update the components manually first, then change the topology to
prepare for future automatic updates.

· RAVENNA-based nodes usually provide a control port which will be used for the software update of the
RAVENNA subsystem. This control port might already be connected to a network switch in order to
create a service port network. For future use, such a dedicated service port network is not necessary
anymore as the service network will be routed automatically through the Nova73 I/O cards. Anyway, it is
still possible to use a dedicated service port network if it is connected to the Router card’s second NIC as
depicted in the Network Topology figure.

· The IP address of the control port is listed in the system’s http service site http://<system IP
address>/content/ networkinfo.shtml

· If the control port is accessible via a separate network, select an appropriate (unused) IP address for your
PC’s network interface, connect the PC to this network, open a telnet connection to the control port’s IP
address, login with username root and password hong

· If the control port is not accessible via network, the PC has to be connected directly to the control port. 

· The software update image can be found in the directory /device_os on the system CF card of the Nova73
Router module. Currently the following variants are available

Card Variant Update Path Subfolder

936/35 LocalIO /device_os/936_35_Local_IO

947/21 RAVENNA Mastercard /device_os/947_21_DALLIS_Mastercard

947/22 RAVENNA & MADI Mastercard /device_os/947_22_DALLIS_Mastercard

981/61 RAVENNA /device_os/981_61_Nova73_RAVENNA_IO_Card

985/50 CompactIO /device_os/985_50_Compact_IO

· Please download the appropriate.tar.gz file for the RAVENNA node to be upgraded

· Please start your FTP client software and connect to the control port’s IP address using username root
and password hong

· Please upload the .tar.gz image file to the /data/update subfolder of the RAVENNA aware device.

· In the telnet command line interface, enter updateSystem

· If multiple software archives are found in /data/update, the system asks for a file to use. Please select the
correct update file and follow the instructions on the screen.

· In the unlikely case of a currently installed software version that is too old to support upgrades with the
provided images, the system will print an error message complaining about a missing ubifs image. Please
contact the Lawo service department in this instance.

· The device will be updated and rebooted automatically.
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Power-cycle All Updated Components

If not done already, now is the time to power-cycle all updated components to make sure that the system works
correctly after a power-cycle.

· Please load your favourite snapshot or production and check the audio functionality.

· Do a power-cycle and check the audio functionality again.

· Enjoy the new release!
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System Configuration Modifications

File Structure Changes as of Release 5.4

Due to major changes in the system images to achieve unified system upgrades, some modifications of the file
structure have been necessary. This also implies that former configurations have to be transferred in order to
make them work again. The configuration files at the new locations will be created automatically (if not yet
available) with default settings that are commented out and have to be adjusted appropriately.

NTP Configuration

The NTP server configuration in /data/config/ntp-config has been moved to /data/config/sysconfig/time-config.
Additionally, a TIMEZONE parameter can be specified as of Release 5.4. If there is an NTP configuration for your
system, please edit the server settings in the new location.

SNMP Configuration

The SNMP server configuration in /data/config/snmpd.conf has been moved to /data/config/sysconfig/snmpd.conf.
Please transfer your settings to the new location.

 Syslog Configuration

The configuration file for the syslog process in /data/config/logfile has been moved
to /data/config/sysconfig/syslog. As of Release 5.4 it is possible to define a syslog server with the configuration
option LOGSERVER_IP=<IP>.

pre_config.tcl, post_config.tcl

The post_config.tcl file will be created with default (commented out) contents if not already existing. All entries
that were formerly specified in pre_config.tcl can now be moved to post_config.tcl. pre_config.tcl will be
discontinued in future releases.

File Structure Changes as of Release 5.6

Service Network Configuration

The system’s service network which defaults to 192.168.110.0/24 will be configured in /data/config/sysconfig/ip-
address as of Release 5.6. If you open the ip-address file in a text editor, you will find a template for the service
network configuration where the comment marker (#) has to be removed in order to enable the configuration. This
is needed only if the default cannot be used for some reason (e.g. in DSN setups). The former configuration in
post_config.tcl (if any) has to be removed and is not evaluated anymore. 
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Additional Notes

Updating RAVENNA Aware Nodes Not Supporting UBIFS Images

If the installed version of the RAVENNA software bundle is too old to support UBIFS update images, the update
process has to be done in two separate steps:

1. Install the so-called “barebox” image which supports UBIFS updates (the image can be found in the same
directory as the standard update image). The card will reboot.

2. Install the standard update image from the release bundle.

Note: The control port will keep its former IP address settings when installing the barebox image. 
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Chapter 6: Trouble-shooting

This chapter includes a series of example problems and tips to help you fault find the mc²56 MKII system.

For further assistance, please contact your local Lawo representative or email support@lawo.com.

· The system will not boot or does not boot correctly

· The system boots up but I have no audio

· The complete control surface is not responding

· One of the control surface panels is not working

· The graphics on the TFT displays freeze temporarily

· The graphics on one of the displays freezes or looks odd

· The network connection between my computer and the control system is not working

· Running a PING test (to check network communcation)

· mxGUI is not booting up

mailto:support@lawo.com
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The system will not boot or does not boot correctly

1. Power off the Nova73 and wait for the system to shutdown.

The system has completed its shutdown when the blue LED of the trackball is off.

2. Power on to try a warm start.

3. If this is unsuccessful perform a cold start.

If the system now boots correctly, then your warm start user data is corrupt. Check your production data by
loading a production. If this is the cause of the problem, perform another cold start and try a different production. If
there is a problem with all production data, then you can need to replace the Data Flashcard.

4. If this is still unsuccessful, then you should try replacing the System Flashcard with a backup copy.
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The system boots up but I have no audio

1. Check the System Settings display to see if there any reported errors.

If a Nova73 module or DALLIS I/O card is shown in red, then there is a problem with the connection or
module/card.

2. Check the connections between the Nova73 I/O module and any DALLIS units.

Are the fibres reversed?

3. Check that all the ACTIVE LEDs on modules within the Nova73, and cards within the DALLIS, are green
and flashing synchronously. 

The ACTIVE LED on each Nova73 module, or DALLIS card, should blink in time with all other ACTIVE LEDs (at
1Hz). This shows that the card is synchronous to the rest of the system. If an LED is out of sync, then check that
the card is fitted correctly, and if the symptom persists, replace the card.

4. If everything still looks ok, then try reloading the DSP configuration from the DSP Configurations display.
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The complete control surface is not responding

1. Check the Ethernet A connections between the control surface and Nova73 Router Module.

2. If main and redundant Router Modules are fitted to the Nova73, try forcing a manual takeover to the
redundant control system.

3. If not, power off the Nova73 and wait for the system to shutdown. And power on to try a warm start.
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One of the control surface panels is not working

1. Try restarting the Ethernet Bay Server.

2. Carefully remove the panel, and check the connections.

3. Try disconnecting and reconnecting the USB and power connectors to the panel.

Try this a few times to see if the panel will boot. If not, then the panel may be faulty so please contact your local
Lawo representative or email support@lawo.com.

mailto:support@lawo.com
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The graphics on the TFT displays freeze temporarily

This can occur if the load on the CPU exceeds 95% - for example, during a production load. Audio processing is
unaffected, and therefore the behaviour should be ignored. Once the production has loaded, and the CPU returns
to normal levels of operation, all graphics should update correctly.
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The graphics on one of the displays freezes or looks odd

This can occur if a Bay Server looses its Ethernet connection to the Control System. 

1. Try restarting the Ethernet Bay Server.

If the problem persists, then the display or Bay Server may be faulty so please contact your local Lawo
representative or email support@lawo.com.

mailto:support@lawo.com
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The network connection to the control system is not working

If you cannot establish network communication between your computer and the control system:

1. Check the network connection and TCP/IP settings of your computer's network interface card.

2. If applicable, check that the software you are running is compatible with the mc2 system. When
connecting from mxGUI or AdminHD, the first three digits of the software versions must match.

3. Try a PING command to test whether you have a valid network connection:

· If the ping test fails, then there is something wrong with your network configuration.

· If the ping test is successful, then this confirms that the network communication is working. If you still
cannot connect to the mc²56 MKII control system, then something on your computer is blocking the
network connection. Try disabling any firewall and/or antivirus software.
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Running a PING test

The PING command is a built-in Windows and Mac function, that allows you to test whether you have a valid
network connection to and from any networked device.

1. Make sure that your computer is connected to the correct network port, and that you have configured the
TCP/IP settings of your computer's network interface card.

2. On a Windows 7 PC, type cmd into the "Search programs and files" field under the Start menu and
press Enter.

This opens the DOS command prompt window:

Alternatively, on a Mac, open the Terminal program (found in the Applications -> Utilities folder).

3. On both platforms, perform the ping test as follows:

Type ping xxx.xxx.xxx.xx (where xx.. is the IP address of the device you are trying to connect to) and press
Enter.

For example, to test the connection to a mc256 control system (using its default IP address), you would type:

ping 192.168.102.56

Your computer will now try to establish communication...
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Ø  Ping Test Fail

If the ping test fails, then the request will time out, and you will not receive any successful packets:

 

There is something wrong with your network configuration, so check the network connections, and TCP/IP
settings again. Or contact your network administrator.

Ø  Ping Test Success

If the ping test is successful, then the result will show that the Sent packets have been successfully Received:

This confirms that the network communication is working. If you still cannot connect, then something on your
computer is blocking the network connection. Try disabling any firewall and/or antivirus software.

See TCP/IP Addresses for a list of the default control system IP addresses for different Lawo products. Or, you
can check the IP address of your control system from the console GUI (using the System Settings display, see
IP Address Primary). 
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mxGUI is not booting up

If, when you start mxGUI, you see only a black screen and not the trackball shown below, then you should check
the BIOS setup of your PC.

1. Enter the BIOS system of your computer - the exact method varies depending on the PC manufacturer,
so please refer to your computer's manual for details.

2. Search for a checkbox called "VTX" or "Virtual Technology" - on most computers, it can be found under
security or something similar. This option MUST be enabled.

3. Then restart mxGUI, and you should see the blue trackball screen appear:
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Chapter 7: Appendices

This chapter includes the following appendices:

· System Part Numbers

· Control Surface Options

· Installing a Mirror Desk

· Nova73 Compact

· Nova73 Module Options

· DALLIS Interface Options

· DALLIS IO Card Compatibility

· SFP Modules & Installation

· Local I/O Wiring

· DSP Configurations

· SDI Parameters

· GNU Public License

· Control System Locations

· Lawo Default TCP/IP Addresses
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System Part Numbers

The following part numbers will help you locate data sheets for the principle system components:

System Component Part Number

mc256 MKII Frame: 16C 959-09

16 + 16C 959-10

16 + 16C + 16 959-11

32 + 16C + 16 959-12

32 + 16C + 32 959-13

Extender (16-fader) 959-22

Control Surface Modules: Fader Panel 958-10

Fader Panel (dual faders) 958-11

Fader Panel 4FC (extra Free Controls) 958-12

Central Panel 958-20

Channel Display                   958-13

DALLIS Unit Frames: 3RU DALLIS Frame 940-30

6RU DALLIS Frame 940-60

Compact I/O Stagebox 5RU Compact I/O (fully fitted) 985-50

Nova73 HD Frame 10RU Nova73 HD Frame 980-02

Nova73 Compact Frame 7RU Nova73 Compact Frame 980-06

See also Control Surface Options, Nova73 Module Options and DALLIS Interface Options.
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Control Surface Options

This section summarises the main control surface options. For more details, please refer to the relevant data
sheet, available in the "mc2_Nova73_documentation" guide.

See also Installing the Control Surface and Service/Maintenance: Control Surface.

Note:

· Monitoring, Headphones, External Metering & Talkback - the local I/O, integrated within the control
surface, provides audio connections for monitoring, headphones, external metering and talkback.
Therefore, there is no need to specify these as additional options. See Local I/O Wiring for details.

· 19" Integration/User Panels - there are no 19" or USER panels (other than those permitted in the
Overbridge).

· Power Cables - country-specific power cables are supplied for all system components.



mc²56 MKII Technical Manual V5.10.2/1 323

Chapter 7: Appendices
Control Surface Options

Frame Layouts

The mc256 control surface comes in a range of predetermined frame sizes. Any frame can be expanded by fitting
stand-alone extenders:

Frame Layout Part Number

16C 959-09

16+16C 959-10

16+16C+16 959-11

32+16C+16 959-12

32+16C+32 959-13

16 Fader Extender 959-22

Ethernet and PSU connecting cables are available in a variety of lengths and must be ordered separately.
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By default, frames come fully-fitted with the appropriate control surface panels:

Control Surface Panel Part Number

Fader Panel (1 per 16-fader decentral bay) 958-10

Central Panel (1 per console) 958-20

Channel display (1 per bay) 958-13

You can fit dummy panels within a frame, to reduce the initial cost of the system, and allow for future expansion.
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Frame Version

Two different frame versions are available, designed for either studio or OB van installation.

The version affects the side panels fitted to the console. You should specify the OB version for narrow side panels
and a reduced console width:

Option Part Number

Studio Side Panels 959-30

OB Van Side Panels 959-31

Please see Dimensions and Weight for details.
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Stand

Optionally, the console can be delivered with a stand:

Option Part Number

Console Stand 959-32
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Overbridge Options

Space is available in the Overbridge to fit either RTW metering (shown above) and/or a Lawo User Panel. 

The permitted variations are:

Part Number RTW User Panel Fitted

958/90 No No Blank Panel

958/91 Yes No TM 9 (shown above)

958/92 Yes Yes TM 7 + User Panel

958/93 No Yes Blank Panel + User Panel

When the RTW TM 7 or TM 9 are fitted, they connect to the AES3 in/out 5-8 of the local I/O.

The default configuration usually sets the RTW to automatically follow the CRM 1 monitor source selector.
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The Overbridge User Panel options are:

Part Number User Panel Description

962/29 REVEAL FADER 5 dedicated faders for revealing surround slaves.

962/14 USER KEYS 40 user buttons configured from the Custom Functions display.

962/16 INTERCOM integrated loudspeaker and internal talkback microphone, see Local
I/O Wiring.

962/18 AUTOMATION timecode automation controls.

962/15 USER CONTROLS 8 rotary controls defined by the factory configuration.

REVEAL FADER USER KEYS

INTERCOM AUTOMATION

USER CONTROLS
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Local I/O Connection

The local I/O board, integrated within the control surface, is available in two versions; the version determines the
connection to/from the Nova73:

Option Part Number

Local I/O (MADI) 958-55

Local I/O (RAVENNA) 958-50

You will need to reserve one MADI, or one RAVENNA, port within the Nova73 for this connection, see Nova73
Module Options.
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Console Keyboard

The console keyboard is available in English or German:

Option Part Number

English Keyboard 956-23

German Keyboard 956-24

The correct layout (English or German) is selected from the System Settings display (via the Global -> System
options).
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Script Tray

Optionally, one or more removable script trays can be fitted:

Option Part Number

Removable Script Tray 959-41
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Recording Com Kit

The optional Recording Com Kit provides Sony 9pin (P2), LTC and MIDI connections to an external playback
device.

Option Part Number

Recording Com Kit (P2, LTC, MIDI) 958-80

Machine control functions can be mapped onto user buttons from the console's Custom Functions display, or
handled from the optional machine control panel, mounted externally from the console.

For more details, please see the "Technical Documentation: Recording Com Kit", available from the Download-
Center at www.lawo.com (after Login).

From Version 5.4, the consoles support native RTP MIDI (MIDI over Ethernet). Thus, control of up to 32 channels
(four conventional MIDI devices) can be achieved using an Ethernet connection to the Lawo network. RTP MIDI
support is native within MAC computers and can be achieved on PCs using dedicated software tools. Note that
the Recording Com Kit is still required for Sony 9pin and LTC connections.

http://www.lawo.com
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Installing a Mirror Desk

From Version 5.4 onwards, two identical control surfaces can connect to the same Nova73 in order to mirror each
other. For example, in a theatre you can install one surface in the auditorium and the other in a separate control
room to facilitate mixing from two different locations. 

Prerequisites

· The two control surfaces MUST be from the same console family, so either 2 x mc256 OR 2 x mc266.

· Different frame sizes are possible, but the position of the "main faders" must be identical in both surfaces.

· The Bay Server Rotary Switches for the Channel and Central GUI of the "mirror" desk must be properly
configured - see next page.

· The SCREEN CONTROL panel soft keys will not work on the "mirror" desk.

· Windows Remote Desktop connections will only appear on the main desk. Therefore, it is recommended
to use a VNC remote connection instead.

Installation

The two control surfaces should be installed in the usual manner. 

To cable the surfaces, connect the main desk to the Ethernet A port(s) of the Nova73 Router Module, and the
mirror desk to the EXT port of the main desk as shown below:
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Bay Server Rotary Switches 

Each channel and central GUI bay is supported by an Ethernet Bay Server, mounted behind its TFT display. The
Bay Server has a rotary switch with two settings:

· Function - determines whether the Bay Server supports a channel or central GUI bay.

· Address – determines the Bay Server index, counted from left to right across the frame starting at 0. 

On the mirror desk, the Function must be increased by a value of 4, and so you should set the switches as
follows:

Bay Server Location Function (Main Desk) Function (Mirror Desk) Address

Central GUI 8 C 0

Channel Bay 0 4 0, 2, 4, etc.

Note that for channel bays, address 0 is the left-most bay.

For details on how to change the settings, please see Adjusting a Bay Server's Rotary Switches.
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Nova73 Compact Core

The Nova73 Compact offers an alternative to the Nova73 HD for space-restricted installations:

Nova73 HD (10RU) Nova73 Compact (7RU)

Operationally, the two cores are identical, and share the same Router, DSP and I/O Modules. A second Router
Module can be fitted for redundancy. Either core can operate stand-alone or within a larger networked system.

The key features and differences are:

Nova73 HD Nova73 Compact

Width 19”

483mm (front plate)

440mm (chassis)

Height 10RU 7RU

Weight 16.25 Kg (one PSU fitted) 14.5 Kg (two PSUs fitted)

Depth 510mm 489mm

Max. number of DSP + I/O Modules 16

(8k2 capacity router at 48kHz)

10

(5k2 capacity router at 48kHz)

Max. number of DSP Modules 8 5

Max. number of AES Modules 8 2 (fitted in slots 2 and 6)

Redundant Power Supplies optional standard

Redundant Router Module MKII optional optional

Configured using AdminHD Yes Yes

To achieve its smaller footprint, the Nova73 Compact utilises a different frame (980/06), with front-mounted plug-
in power supply modules (980/27) and rear-mounted fan units (980/28). The frame comes fitted with rear
connector panels for any front-mounted AES modules (in slots 2 and 6). 
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Nova73 Module Options

The following tables summarise the Nova73 modules supported in this release of software. For more details,
please refer to the relevant data sheet, available in the "mc2_Nova73_documentation" guide. See also Installing
the Nova73 Plug-in Modules and Service/Maintenance: Nova73.

Nova73 Plug-in Module Options

Not every I/O or DSP module can be used in every slot so it is best to check your configuration within 
AdminHD before fitting the physical modules.
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Central Router Modules

980/33 ROUTER MKII Routing matrix (8k² at 48kHz, or 4k² at 96kHz) and integrated control system.

I/O Modules

981/02 AES3 + MADI 32 inputs and 32 outputs AES/EBU (via D-Sub or BNC rear connector panel);

1 port MADI (optical, multi-mode fibre)

981/04 AES3 + MADI 32 inputs and 32 outputs AES/EBU (via D-Sub or BNC rear connector panel);

4 ports MADI (via SFP transceivers)

981/14 MADI 4 ports MADI (via SFP transceivers)

981/18 MADI 8 ports MADI (via SFP transceivers)

981/31 MADI 2 ports MADI (optical, multi-mode fibre)

981/38 MADI 8 ports MADI (optical, multi-mode fibre)

981/32 MADI 2 double ports MADI, redundant fibre (optical, multi-mode fibre)

981/36 MADI 6 double ports MADI, redundant fibre (optical, multi-mode fibre)

981/41 MADI 2 ports MADI (optical, single-mode fibre)

981/61 RAVENNA 4 ports RAVENNA (CAT 5 Ethernet and SFP option for single or multi-mode optical
fibre); the port configuration and redundancy are configured by AdminHD. See 
RAVENNA Interfaces.

981/65 DANTE 4 ports DANTE (CAT 5 Ethernet); each port provides 64 bi-directional tie lines (defined
by AdminHD). Please refer to the DANTE specification for more details.

DSP Modules

983/03 DSP 48/24 *

983/04 DSP 48/24 *

48/24 DSP channels for the mc2 series mixing consoles: 48 channels at 48kHz; 24
channels at 96kHz. 

The 983/04 is a later revision of the 983/03 supporting identical features.

983/06 DSP IOSONO For project-specific applications, please check your system specification.

* The 983/03 (or 04) DSP module can be configured for different applications by changing the AdminHD
configuration and updating the module’s firmware:

· 983/03 DSP 48/24 - DSP channels for the mc2 series mixing consoles, see DSP Configurations.

· 983/03-077 mxDSP - DSP paths for the routing matrix, see mxDSP Configuration.

· 983/03-060 DSP WFS (mix), 983/03-061 DSP WFS (filter) and 983/03-062 DSP spatial mixer - for
project-specific applications, please check your system specification.
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Nova73 Rear Connector Panels

The Nova73 HD supports two types of AES3 rear connector panel: the 980/14 (D-Sub) and 980/15 (BNC).

Pin-outs for the Nova73 Compact AES3 rear connectors are identical to the 980/14.

980/14 Connector Panel D-Sub

· Outputs: 4 plugs D-Sub 25-pin, each with 8 balanced contacts 110 Ω

· Inputs: 4 plug sockets D-Sub 25-pin, each with 8 balanced contacts 110 Ω
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980/15 Connector Panel BNC

· Outputs: 32 BNC connector, unbalanced contacts 75 Ω

· Inputs: 32 BNC connector, unbalanced contacts 75 Ω
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DALLIS Interface Options

The following tables summarise the DALLIS interfaces supported in this release of software. For more details,
please refer to the relevant data sheet, available in the "mc2_Nova73_documentation" guide. 

See also Installing the DALLIS Plug-in Cards and Service/Maintenance: DALLIS.

 3RU DALLIS (example configuration)

Not every interface card can be used in every slot. As a general rule, if an interface card is permitted within 
AdminHD, then it can be fitted to your system. Please also refer to the DALLIS I/O Card Compatibility table.

The type of DALLIS master board, and hence the connection, determines the maximum number of audio
channels to/from the Nova: up to 60 (MADI) or 128 (RAVENNA).

The Maximum Analogue Level of the whole system is defined by the DALLIS card with the lowest GDA
(General Device Address) - this is the card with the lowest address fitted to the DALLIS frame connected to
the lowest port number of the first Nova73. (If a different fixed level analogue card is fitted elsewhere within
the system, then a warning appears in the log file; however, the card with the lowest GDA still wins.)

DALLIS Master Boards Connects to:

947/05 MADI 1 port MADI (optical, multi-mode fibre) 981/02, 04, 14,
18, 31, 38

947/07 MADI 2 double ports MADI, redundant fibre (optical, multi-mode fibre) 981/32, 36

947/15 MADI 1 port MADI (optical, single-mode fibre) 981/41

947/21 RAVENNA 1 port RAVENNA (GB Ethernet Cat5/6/7 and SFP option for single or
multi-mode optical fibre). See RAVENNA Interfaces.

981/61

947/22
MADI/RAVENNA

1 port RAVENNA (GB Ethernet Cat5/6/7 and SFP option for single or
multi-mode optical fibre)

1 port MADI (SFP option for single or multi-mode optical fibre)

981/61

981/31, 32, 36,
38, 41
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DALLIS I/O Cards Part Number & Connector Type

 Inputs  OutputsAnalogue D-Sub XLR BNC

Mic/Line (trafo-balanced) 941/52 941/62 - 4 mono -

Line in (trafo-balanced) 941/02, 04, 06 941/12, 14, 16 - 4 mono -

Line out (trafo-balanced) 942/02, 04, 06 942/12, 14, 16 - - 4 mono

Mic/Line (elect-balanced) 941/51, 53, 55 - - 8 mono -

Line in (elect-balanced) 941/84, 86 - - 8 mono -

Line in/out (elect-balanced) 941/83, 85 - - 8 mono 8 mono

Line out (elect-balanced) 942/84, 86 - - - 8 mono

DALLIS I/O Cards Part Number & Connector Type

 Inputs  OutputsAES3 D-Sub XLR BNC

AES3 in (SRC) 943/02, 03 943/12, 13 - 4 stereo -

AES3 in (SRC) Hi-Z/Thru 943/01, 84, 85 - - 4 stereo 4 thru

AES3 in/out (SRC in) 943/52, 53 - 943/72, 73 4 stereo 4 stereo

AES3 in/out (SRC in/out) 943/54, 55 - 943/74, 75 4 stereo 4 stereo

AES3 out 944/01, 02 944/11, 12 - - 4 stereo

DALLIS I/O Cards

Part Number Description Connector TypeSpecial

Headphones 942/61 4 stereo headphone outputs 1 x D-Sub

Intercom (Riedel interface) 943/81, 82 4 AES3 in/out 4 x BNC (bi-directional)

Optical Switch 945/61 Optical to BNC change-over
switch for MADI.

2 x BNC: 1 in, 1 out

3 x MT-RJ

ADAT in/out 946/31 8 channel ADAT interface 2 x ADAT: 1 in, 1 out

RAVENNA (Audio over IP) 946/41 8 channel RAVENNA interface. 1 x RJ45 (Ethernet)

1 x SFP (optical fibre)

RAVENNA (Audio over IP) &
MADI

946/42 8 channel RAVENNA interface
plus

64 channel MADI

1 x RJ45 (Ethernet)

1 x SFP (optical fibre)

Phantom Power 947/10 48 V supply for transformer-
balanced Mic/Line cards

n/a

DALLIS I/O Cards

Part Number Description  Connector TypeGPI

GPI/Opto Relays 945/01 8 opto-coupler in; 8 relay out 1 x D-Sub

GPI/Opto/VCA Relays 945/05 8 opto-coupler in; 8 relay out; 4
VCA in

1 x D-Sub
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DALLIS I/O Cards

Part Number Audio de-embedder /
embedder

Connector Type
SDI

3G/HD/SD SDI 946/17 up to 8 AES3 in/out (stereo) 4 x BNC: in, thru, 2 out

2 x D-Sub: metadata

HD/SD SDI

SD SDI

946/13

946/09

up to 4 AES3 in/out (stereo) 4 x BNC: in, thru, 2 out

HD/SD SDI

SDI SDI

946/05

946/01

up to 4 AES3 in/out (stereo) 3 x BNC: in, thru, out

DALLIS I/O Cards

Part Number Description Connector TypeDSP

Summing matrix 947/41, 42 8 in/out internal summing matrix
with signal generator

n/a

DALLIS I/O Cards

Part Number Description Connector TypeData

RS422 945/21 4 bi-directional data ports for
RS422 

4 x RJ45

Serial Data 945/22 4 bi-directional data ports for
RS232, RS422 or MIDI

4 x RJ45
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DALLIS IO Card Compatibility

The following table shows which DALLIS I/O Cards are supported by the 947/21 and 947/22 DALLIS master
boards.

Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

DALLISSLOTTYPE_941_02 // Analog in 4 Mono traf.sym. SubD

15dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_04 // Analog in 4 Mono traf.sym. SubD

24dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_06 // Analog in 4 Mono traf.sym. SubD

18dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_12 // Analog in 4 Mono traf.sym. XLR 

15dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_14 // Analog in 4 Mono traf.sym. XLR 

24dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_16 // Analog in 4 Mono traf.sym. XLR 

18dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_51 // MicLine in 8 Mono elec.sym. SubD

15dBu->0dB FS

x x x x x

DALLISSLOTTYPE_941_52 // MicLine in 4 Mono traf.sym. SubD

15dBu->0dB FS

x x x x x

DALLISSLOTTYPE_941_53 // MicLine in 8 Mono traf.sym. SubD

variabel

x x x x x

DALLISSLOTTYPE_941_55 // new  941_51 MicLine in 8 Mono

elec.sym. SubD 15dBu->0dB FS

x x x x x

DALLISSLOTTYPE_941_62 // MicLine in 4 Mono elec.sym. XLR 

15dBu->0dB FS

x x x x x

DALLISSLOTTYPE_941_83 // Analog in/out 2*8 Mono elec.sym.

SubD variable

x - x x -

DALLISSLOTTYPE_941_84 // Analog in/--- 1*8 Mono elec.sym.

SubD variable

x - x x -

DALLISSLOTTYPE_941_85 // Analog in/out 2*8Mono elec.sym.

SubD variable, Replacement for 941_83

x x x x x

DALLISSLOTTYPE_941_86 // Analog in/--- 1*8Mono elec.sym.

SubD variable, Replacement for 941_84

x x x x x

DALLISSLOTTYPE_942_02 // Analog out 4 Mono traf.sym. SubD

15dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_04 // Analog out 4 Mono traf.sym. SubD

24dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_06 // Analog out 4 Mono traf.sym. SubD

18dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_12 // Analog out 4 Mono traf.sym. XLR 

15dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_14 // Analog out 4 Mono traf.sym. XLR 

24dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_16 // Analog out 4 Mono traf.sym. XLR 

18dBu->0dB FS

x - x x -
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Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

DALLISSLOTTYPE_942_61 // Monitor out 4 Stereo asym.  SubD

HeadphoneAmp. integrated VCA

x x x x x

DALLISSLOTTYPE_942_61_Ext // Monitor out 4 Stereo asym.SubD

HeadphoneAmp. w ith Extender

x x x x x

DALLISSLOTTYPE_942_84 // Analog --/out 1*8Mono elec.sym.

SubD variable

x - x x -

DALLISSLOTTYPE_942_86 // Analog --/out 1*8Mono elec.sym.

SubD variable, Replacement for 942_84

x x x x x

DALLISSLOTTYPE_943_01 // AES  in 4 Stereo in SRC SubD

HighZ/Thru, Replacement for 943_84

- - - - -

DALLISSLOTTYPE_943_02 // AES in 4 Stereo in SRC SubD - - - - -

DALLISSLOTTYPE_943_03 // AES in 4 Stereo in SRC SubD,

Replacement for 943_02

x x x x x

DALLISSLOTTYPE_943_12 // AES in 4 Stereo in SRC XLR - - - - -

DALLISSLOTTYPE_943_13 // AES in 4 Stereo in SRC XLR,

Replacement for 943_12

x - x x -

DALLISSLOTTYPE_943_52 // AES in/out 4 Stereo only In SRC SubD - x - - x

DALLISSLOTTYPE_943_53 // AES in/out 4 Stereo only In SRC

SubD, Replacement for 943_52

x x x x x

DALLISSLOTTYPE_943_54 // AES in/out 4 Stereo in/out SRC

44.1/48/96 kHz SubD

- x - - x

DALLISSLOTTYPE_943_55 // AES in/out 4 Stereo in/out SRC

SubD, Replacement for 943_54

x x x x x

DALLISSLOTTYPE_943_72 // AES in/out 4 Stereo in SRC BNC - - - - -

DALLISSLOTTYPE_943_73 // AES in/out 4 Stereo in SRC BNC,

Replacement for 943_72

x x x x x

DALLISSLOTTYPE_943_74 // AES in/out 4 Stereo in/out SRC BNC - - - - -

DALLISSLOTTYPE_943_75 // AES in/out 4 Stereo in/out SRC BNC,

Replacement for 943_74

x x x x x

DALLISSLOTTYPE_943_81 // DALLIS_INTERCOM, no SRC x x x x x

DALLISSLOTTYPE_943_82 // DALLIS_INTERCOM, no SRC,

Replacement for 943_81

x x x x x

DALLISSLOTTYPE_943_84 // AES  in 4 Stereo in SRC SubD

HighZ/Thru

- - - - -

DALLISSLOTTYPE_943_85 // AES  in 4 Stereo in SRC SubD

HighZ/Thru, Replacement for 943_84

x - x x -

DALLISSLOTTYPE_944_01 // AES out 4 Stereo no SRC SubD - - - - -

DALLISSLOTTYPE_944_02 // AES out 4 Stereo no SRC SubD,

Replacement for 944_01

x x x x x

DALLISSLOTTYPE_944_11 // AES out 4 Stereo no SRC XLR - - - - -

DALLISSLOTTYPE_944_12 // AES out 4 Stereo no SRC XLR,

Replacement for 944_11

x - x x -
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Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

DALLISSLOTTYPE_945_01 // GPIO InOptos OutRelais SubD x x x x x

DALLISSLOTTYPE_945_05 // GPIO InOptos OutOptos VCA SubD x x x x x

DALLISSLOTTYPE_945_05_Ext // GPIO InOptos OutOptos VCA

SubD m w ith Extender

x x x x x

DALLISSLOTTYPE_945_21 // Serial Routing 4*RS422 RJ45 - - - - -

DALLISSLOTTYPE_945_22 // Serial Routing x x x x x

DALLISSLOTTYPE_945_61 // Opto-Sw itch / BNC-Converter x x x x x

DALLISSLOTTYPE_946_01 // SDI SD Embedder/De-Embedder 4

Stereo In 4 Stereo Out (non-existing, w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_02 // SDI SD Embedder/De-Embedder 2

Stereo In 2 Stereo Out (non-existing, w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_03 // SDI SD Embedder/De-Embedder 4

Stereo In 0 Stereo Out (non-existing, w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_04 // SDI SD Embedder/De-Embedder 0

Stereo In 4 Stereo Out (non-existing, w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_05 // SDI HD Embedder/De-Embedder 4

Stereo In 4 Stereo Out (w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_06 // SDI HD Embedder/De-Embedder 2

Stereo In 2 Stereo Out (w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_07 // SDI HD Embedder/De-Embedder 4

Stereo In 0 Stereo Out (w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_08 // SDI HD Embedder/De-Embedder 0

Stereo In 4 Stereo Out (w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_09 // SDI SD Embedder/De-Embedder 4

Stereo In 4 Stereo Out (w ith    Video Generator)

- - - - -

DALLISSLOTTYPE_946_10 // SDI SD Embedder/De-Embedder 2

Stereo In 2 Stereo Out (w ith    Video Generator)

- - - - -

DALLISSLOTTYPE_946_11 // SDI SD Embedder/De-Embedder 4

Stereo In 0 Stereo Out (w ith    Video Generator)

- - - - -

DALLISSLOTTYPE_946_12 // SDI SD Embedder/De-Embedder 0

Stereo In 4 Stereo Out (w ith    Video Generator)

- - - - -

DALLISSLOTTYPE_946_13 // SDI HD Embedder/De-Embedder 4

Stereo In 4 Stereo Out (w ith Video Generator)

x - x x -

DALLISSLOTTYPE_946_14 // SDI HD Embedder/De-Embedder 2

Stereo In 2 Stereo Out (w ith Video Generator)

x - x x -

DALLISSLOTTYPE_946_15 // SDI HD Embedder/De-Embedder 4

Stereo In 0 Stereo Out (w ith Video Generator)

- - - - -

DALLISSLOTTYPE_946_16 // SDI HD Embedder/De-Embedder 0

Stereo In 4 Stereo Out (w ith Video Generator)

x - x x -

DALLISSLOTTYPE_946_17 // 946/17 3G SDI Inserter (16 channels) x - x x -

DALLISSLOTTYPE_946_18 // 946/17 3G SDI Inserter (8 channels) x - x x -
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Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

DALLISSLOTTYPE_946_19 // 946/17 3G SDI De-Embedder (16

channels)

x - x x -

DALLISSLOTTYPE_946_20 // 946/17 3G SDI De-Embedder (8

channels)

x - x x -

DALLISSLOTTYPE_946_21 // 946/17 3G SDI Embedder (16

channels)

x - x x -

DALLISSLOTTYPE_946_22 // 946/17 3G SDI Embedder (8

channels)

x - x x -

DALLISSLOTTYPE_946_31_8_8 // ADAT De-/Encoder  8 In, 8 Out x - x x -

DALLISSLOTTYPE_946_31_4_4 // ADAT De-/Encoder  4 In, 4 Out x - x x -

DALLISSLOTTYPE_946_34 // Dallis IP Codec x - x x -

DALLISSLOTTYPE_946_41 // 946/41 Ravenna Evalboard (8

channels)

x x x x x

DALLISSLOTTYPE_946_42 // 946/42 Ravenna (64 channels) x x x x x

DALLISSLOTTYPE_947_10 // Phantom Pow er card x x x x x

DALLISSLOTTYPE_947_41 // SumMx fixed - - - - -

DALLISSLOTTYPE_947_42 // SumMx Matrix - - - - -

DALLISSLOTTYPE_947_42G // Sum Matrix, 6 SumOutputs und 2

Generators

- - - - -

DALLISMASTERTYPE_947_05 // Mastercard MADI f ibre - - - -

DALLISMASTERTYPE_947_07 // Mastercard MADI f ibre +

redundant f ibre

- - - -

DALLISMASTERTYPE_947_15 // Mastercard MADI SMF - - - -

DALLISMASTERTYPE_947_21 // Mastercard Ravenna x x x -

DALLISMASTERTYPE_947_22 // Mastercard MADI, based on

947_21

- - x x

LOCALIOMASTERTYPE_958_68 // Mastercard RAVENNA (Identical

to 947_21)

x x - - -

LOCALIOMASTERTYPE_958_67 MADI // Mastercard MADI f ibre

(Identical to 947_22)

- - x - -

LOCALIOMASTERTYPE_958_67 RA-Link // Mastercard MADI f ibre

(Identical to 947_22)

- - - x -

LOCALIOMASTERTYPE_958_67 RAV-net // Mastercard MADI f ibre

(Identical to 947_22)

- - - - x
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Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

LOCALIOSLOTTYPE_958_60 // Monitor out 4 Stereo asym.  SubD

HeadphoneAmp. integrated VCA (Identical to 941_85)

x x x x x

LOCALIOSLOTTYPE_958_60B // Monitor out 4 Stereo asym.  XLR 

HeadphoneAmp. integrated VCA (Identical to 941_85)

x x x x x

LOCALIOSLOTTYPE_958_61 // AES in/out 4 Stereo only InSRC

44.1/48/96 kHz SubD (Identical to 943_53)

x x x x x

LOCALIOSLOTTYPE_958_61B // AES in/out 4 Stereo only InSRC

44.1/48/96 kHz XLR (Identical to 943_53)

x x x x x

LOCALIOSLOTTYPE_958_62 // Monitor out 4 Stereo asym.  SubD

HeadphoneAmp. integrated VCA (Identical to 942_61)

x x x x x

LOCALIOSLOTTYPE_958_63 // GPIO InOptos OutRelais SubD

(Identical to 945_01)

x x x x x
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SFP Modules & Installation

The following SFP transceivers are available for the relevant MADI and RAVENNA ports. Note that all transceivers
must be Lawo-certified (as listed below).

MADI Ports

Options include multi-mode and single-mode fibre, and standard coaxial cable. For more details, please refer to
the module's data sheet.

SFP Module Description Part Number

MADI, multi-mode fibre 981/60-80

MADI, single-mode fibre 981/60-81

MADI, coaxial/electrical 981/60-82

RAVENNA Ports

Options include multi-mode and single-mode fibre. For more details, please refer to the module's data sheet.

SFP Module Description Part Number

1000 BASE SX: 850nm, -7dBm, multi-mode fibre, 550m 981/60-10

1000 BASE LX: 1310nm, -3dBm, single-mode fibre, 10km 981/60-20

1000 BASE ZX: 1550nm, 0dBm, single-mode fibre, 80km 981/60-30

CWDM: 1270-1610nm, single-mode fibre; up to 40km 981/60-40 to 981/60-57

Installing the SFPs

If fitting transceivers to both the MADI and RAVENNA, take care not to mix up the SFP module types.

The SFP transceivers are hot-pluggable. To install, remove the dust caps from both the port and SFP module.
Then, push the module into the rectangular slot. Press gently and firmly until the module locks into position.

Warning

CAUTION: Please unlock the transceiver before removing to avoid mechanical damage to the slot.

If the transceiver is removed, please refit the port's dust cap to protect the internal components.

Make sure you use the correct fibre type for your device. Using the wrong fibre type or exceeding the
maximum optical input power can result in malfunction of, or damage to, the optical device.
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Local I/O Wiring

The following diagrams illustrate the wiring, pin-outs and default jumper switch positions for the local I/O.

Note that AES IN 5-8 and AES OUT 5-8 connect to the RTW meter if either of the TM 7 or TM 9 Overbridge
options are fitted.
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Local I/O Jumper Switch Positions

There are four jumper switches on the local I/O connector board, which control two settings:

· JP 3,4 - set the connection to the Line input 16 A-D converter. This can be taken from:

o an "internal talkback mic preamp" (set by JP 1,2).

o the LINE IN 16 connection from the rear panel. 

· JP 1,2 - set the "internal talkback mic preamp" to:

o the integrated talkback mic preamp (fitted as standard).

o the talkback mic preamp fitted to the optional 962/16 INTERCOM user panel.

Note that the JP 1,2 switch positions affect both the connection to the Line input 16 A-D converter, and the line
level talkback output available via the TBK connector.

The factory default positions, shown above, support talkback via the integrated talkback mic preamp.

you can need to adjust the jumper switches if:

· the 962/16 INTERCOM user panel is fitted. Move JP 1,2 to connect talkback from the INTERCOM panel's
talkback mic preamp.

· you are using an external talkback source, and wish to "free up" Line input 16 for another application.
Move JP 3,4 to connect Line input 16 from the LINE IN 9-16 connector.

Please see Adjusting the Local I/O Jumper Switch Positions for details. 

For more details on the 962/16 INTERCOM user panel, please refer to the relevant data sheet.
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DSP Configurations

DSP resources are allocated using DSP configurations.

Please note:

· The variation with 1 DSP board includes: 1 x stereo PFL; 1 x  stereo AFL. All other variations include: 2 x
stereo PFL; 1 x  stereo AFL; 1 x surround AFL (7.1).

· Higher sample rates use twice as much DSP resource as lower sample rates.

· More channels, from the same DSP resource, become available if you use Broadcast channels.

· Up to 128 auxes are supported by some Recording channel DSP configurations.

For further details on the variations available, we recommend installing mxGUI and viewing the DSP Configurations
display.
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SDI Parameters

AdminHD can define a number of parameters for the SDI Card, SDI Signal In and SDI Signal Out. The parameters
are what the system resets to after a cold start. Users can change these parameters later from the GUI.

The parameters are similar to those on the mc2 GUI's Signal settings display, and vary depending on the type
card:

· SDI Parameters (3G SDI Card)

· SDI Parameters (non 3G SDI Cards)
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SDI Parameters (3G SDI Card)

The DALLIS 3G/HD/SD SDI card (946/17) is a multi-rate SDI card with BNC input, thru and two outputs. It
contains an audio embedder and de-embedder for up to 16 audio channels, and a VANC embedder and de-
embedder for two independent Dolby E Metadata streams. There is onboard video and audio delay, and an
integrated sample rate converter. It occupies two DALLIS card slots and can be configured to run in a number of
different modes using AdminHD. 

Further information can be found in the data sheet, available in the "mc2_Nova73_documentation" guide.

Note that SDI signals have parameters for both the signal and the card. The SDI parameters are adjusted by
selecting the card:

1. Select the 946/17 card from the System tree.

2. Then select one of the four parameter tabs:

Note that SDI card parameters can be adjusted whether the card is local to the system, or fitted to a remote
network partner.

Note that SDI parameters are never stored by snapshots. From Version 4.8.0.2 onwards, they are stored and
recalled by productions. You can use the Global isolate of SDI parameters custom function to isolate SDI
parameters so that settings are not affected by a production load.
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3G SDI

· SRC – check this option to enable sample rate conversion. Note that SRC is applied to all channels on
the card. Normally, SRC should be enabled. If SRC is off (unchecked), then the system must be clocked
to the same reference as the sending device.

· Enable video delay & Video delay (frames) – this option applies a delay to the SDI data from the de-
embedder to embedder. Video and audio containted in the stream are delayed by the same amount. Set
the amount of Video delay in steps of 1 video frame.

· Video generator mode, format & test pattern – the SDI card is equipped with a free-running video test
pattern generator. Set the mode to either:

o Auto – if the input is locked to an incoming video signal, then the output will automatically track the

format of the input. If the input fails, then the video test pattern generator transmits the last received
video format. When the SDI module is part of a SDI chain, this option is recommended.

o Force On – in this mode it is assumed that the card is used as a video master and that no SDI input

signal is applied. The test pattern generator is forced on all the time. Use the Video generator
format and Generator test pattern options to define the video signal. In this mode the embedder
sample rate is derived from the generator, and the SDI receiver is switched off. Note that the de-
embedder cannot be used.
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Embedder

· Clean – check this option to set the embedder mode to “Clean”. In this mode the incoming audio stream
is deleted and a new data structure generated according to your embedder settings. Note that if you
select this mode any existing audio data will be lost.

· Embedder Group Enable – audio is embedded in groups of four channels into SDI. There is a total of
four groups per SDI, resulting in 16 audio channels. For each group, this checkbox determines whether
the incoming SDI stream is replaced:

o Enable the checkbox to replace the audio group content.

o Disable the checkbox to leave the audio group untouched.

If there is no audio at the SDI input, then a new audio group will be generated. 

Note that in AdminHD modes 16/0 and 8/0, all embedder group enables are turned off as the whole embedder
section is bypassed.

· Embedder source 1 to 16 – use these options to define the source for each embedder.



mc²56 MKII Technical Manual V5.10.2/1 359

Chapter 7: Appendices
SDI Parameters

De-Embedder

· DALLIS signal in source 1 to 16 – use these options to define the source for each de-embedder.
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Metadata

The SDI module offers 2 metadata ports according to SMPTE RDD-2008. This allows embedding, de-embedding
and transport of two independent Dolby metadata streams alongside with the video. The streams can be
accessed via two D-Sub connectors at the front panel.

· Metadata de-emb. & emb. to port 1, 2 - use these options to define the streams for the Metadata
ports.

· Metadata embedder mode & line – set the mode to Auto to track the input, or select Pre-selected
line and define a Metdata embedder line.
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SDI Parameters (non 3G SDI Cards)

The DALLIS HD or SD SDI cards (946/13, 09, 05, 01) provide the ability to route a maximum of 8 channels to/from
the SDI stream. Sample rate conversion can be applied to the whole card (all 8 channels), and delay can be
applied to either the embedded or de-embedded signals.

Further information can be found in the data sheet, available in the "mc2_Nova73_documentation" guide.

SDI parameters can be adjusted for the card and for individual input and output signals.

Note that SDI parameters are never stored by snapshots. From Version 4.8.0.2 onwards, they are stored and
recalled by productions. You can use the Global isolate of SDI parameters custom function to isolate SDI
parameters so that settings are not affected by a production load.
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SDI Card

Select an SDI card from the System tree, and click on SDI to adjust the following card parameters:

· SRC – check this option to enable sample rate conversion. Note that SRC is applied to all 8 channels on
the card. Normally, SRC should be enabled. If SRC is off (unchecked), then the system must be clocked
to the same reference as the sending device.

· Delay – select whether delay is enabled for the Embedded (SDI output) or De-embedded (SDI input)
signals; delay cannot be applied to both.

· Generator signal, mode and format – defines the output generator signal for the SDI stream.

· Embedder mode – select from:

o On – audio channels will be replaced within the existing SDI data structure according to your SDI

output group selections.

o Off – no audio replacement; the SDI stream remains unaltered.

o Clean – deletes the incoming audio stream and generates a new data structure according to your

embedder settings. Note that if you select this mode any existing audio data will be lost. 
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SDI Inputs

Select an SDI input signal from the System tree, and click on SDI to adjust the following signal parameters:

· Group select – this field defines which pair of SDI channels will map to the selected SDI card input. In
our example, Group 2 Channels 3&4 from the SDI stream will be de-embedded to SDI Signal In 1 and
2. 

· Delay time & Delay – check the Delay option to enable delay for the stereo input, and set the delay
time in ms. Delay time can be adjusted from 0 to 240ms.

Delay is only applied to SDI inputs if the SDI card Delay parameter is set to De-embedder.
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SDI Outputs

Select an SDI output signal from the System tree, and click on SDI to adjust the following parameters:

· Group select – this field defines which pair of SDI channels will map to the selected SDI card output. In
our example, Group 1 Channels 1&2 from the SDI stream will be embedded to SDI Signal Out 1 and 2.
 

 The assignment is only active if the SDI card Embedder mode is set to On or Clean.

· Delay time & Delay – check the Delay option to enable delay for the stereo output, and set the delay
time in ms.

 Delay is only applied to SDI outputs if the SDI card Delay parameter is set to Embedder.

· Wordlength – choose from the available drop-down menu options.

 When 16 or 20-bit are selected, dither is automatically applied.
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GNU Public License

The following modules are used in the Nova73:

Box Nova 73

Linux Kernel 2.6 x

µ CLinux 2.4 x x

netsnmp x x

busy box x x

TCL x x

xFree86 x

The GPL source code contained in this product is available at Lawo service department. If you would like a copy
of the GPL source code in this product on a CD, please send €9,90 to Lawo for the cost of preparing and mailing
the CD to you.
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Control System Locations

The table below shows the location of the control system for different mc2 and Nova products. 

Note that the Router Module MKII (980/33) control system provides two network ports: ETHERNET A connects to

the mc2 control surface; ETHERNET B connects to the Lawo system network.

System Router Module Control System Location System Network Port

mc² 36 980/33 Intel control surface ETHERNET B

mc² 56 MKII 980/33 Intel Nova73 ETHERNET B

mc² 66 MKII 980/33 Intel Nova73 ETHERNET B

Nova73 HD MKII 980/33 Intel Nova73 ETHERNET B

Nova73 Compact MKII 980/33 Intel Nova73 ETHERNET B

mc² Micro Core 980/33 Intel Micro Core ETHERNET B

Nova37 980/33 Intel Nova37 ETHERNET B
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Lawo Default TCP/IP Addresses

Default IP Addresses

The default IP addresses, for different Lawo product control systems, are:

· mc236 = 192.168.102.36

· mc256 = 192.168.102.56

· mc266 = 192.168.102.65

· Nova73 (HD & Compact) = 192.168.102.1

· mc2 Micro Core = 192.168.102.136

· Nova37 = 192.168.102.137

· mxGUI (local control system) = 192.168.56.101

You can check the IP address of your control system from the GUI (by selecting System from the tree on the left-
hand side of the Signal Settings display).

Subnet Mask

For all products, the default Subnet Mask is 255.255.255.0.

Other IP Addresses

The table below lists the other IP addresses used within a mc²56 MKII installation:

Device Port IP Address Notes

Router Module Slot A ETHERNET A 192.168.105.1 Fixed address.

Router Module Slot A ETHERNET B 192.168.102.xxx Default address of the control system
(as listed above).

Router Module Slot B
(optional)

ETHERNET A 192.168.106.1 Fixed address.

Router Module Slot B
(optional)

ETHERNET B 192.168.102.xxx This address is always one digit higher
than that of the main control system.

Ethernet Switch (optional) - 192.168.102.250 Default address.

ISDN Dialup Router
(optional)

- 192.168.102.200 Default address.

We recommend keeping the default IP addresses, where possible, as this will simplify remote maintenance.

The control system address (ETHERNET B) can be changed in a file called "ip-address" located on the data
card (in the /data/config folder).
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48kHz or 44.1kHz See Sample Rate.

Access On mc2 consoles, much of the channel parameter operation is performed by
assigning a fader strip to the Central Control Section. This is otherwise known as
putting a source ‘in access’. 

AdminHD Lawo’s configuration and control software for Nova73 systems.

Attack Time In the context of dynamics processing (compressor, limiter, gate or expander), the
attack time defines the duration over which an input signal is measured. The longer
the attack time, the slower the processor will react. For example, when using a
gate, a fast attack time causes the gate to open quickly when signal exceeds the
gate threshold.

Aux Auxiliary

An Aux is a general purpose mono, stereo or multi-channel summing bus which
can be used for a variety of applications such as sending to outboard effects
devices.

Aux Send Auxiliary Send

Source channels feed onto each aux via their Aux Send. The aux send from each
channel can be either pre or post fader and has variable level control.

Aux Master Auxiliary Master

The Aux Master is a master source channel used to control the level and
processing of the Aux output. The direct output of the Aux Master is the signal
routed to the outboard effects send.

Aux Return Auxiliary Return

The Aux Return is the name given to the return channel from the outboard effects
device. This channel controls the level and processing of the effect as it is summed
into the rest of the mix. 

Band Pass Filter See Filters.

Balance Balance is applied to the input of a stereo channel and is the ratio between the left
and right input levels. When Balance is set to its default value, the level of left and
right inputs are equally weighted.

Bargraph An optical display instrument in the shape of a LED bar for displaying signal level.

Clean Feed See Mix Minus.

Compressor A dynamics processor used to smooth out uneven signal levels. For example,
when a presenter shouts and then whispers, they are producing sound which has a
wide dynamic range; one moment it is very loud and the next very quiet. This can
mean that if we listened to this signal on our radio without compression, we would
forever be turning the level up and down! A compressor smoothes the signal such
very loud audio is reduced in level and very quiet audio is increased in level. This
results in smaller dynamic range ideal for radio transmission. 

Configuration The system configuration is a file created by the AdminHD software. The file can
be exported and uploaded to the system’s cold start data where it will load
following a cold start. Or, the file can be uploaded to the system’s warm start data
where it is then loaded every time the system reboots or powers on. The
configuration defines key elements of the system such as the hardware
components, and default signal parameters.

ControlHD Lawo’s control software for Nova73 systems.

DALLIS Lawo’s modular I/O interfacing system based on 19” frames using plug-in cards for
different interfaces.
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dB deciBel 

A unit of transmission giving the ratio of two powers. 

The number of bels is the logarithm to the base 10 of the ratio of the two powers.
One decibel equals one tenth of a bel.

dBU dBU is used to describe levels within the analogue domain, and is a measure of
absolute voltage level based on 0dBU = 0.775 Volts (RMS). dBU is often used to
indicate nominal broadcast operating levels.

dBFS dB Full Scale

dBFS is used to describe levels within the digital domain. 0dBFS describes the
system’s internal clipping point; this is the maximum level which can be handled
by the system without signal distortion.

Delay The signal output from a delay module is x ms behind the signal input to the
module. Delay is often applied to audio sources whose video has undergone digital
video processing; delay is required such the audio remains in sync with the video.

Direct Out Direct Output

The direct output of a channel is the output of the individual source. Direct Outputs
are often used to provide a record or ‘snoop’ feed of a single source, and can be
taken from various points within signal flow: pre fader, post fader, etc.

Drop-out Interruption of the audio signal caused by an error in the signal transfer or
recording.

DSP Digital Signal Processing

Digital signal processing (DSP) is the study of signals in a digital representation
and the processing methods of these signals.

Within mc2 consoles and the Nova73, DSP is also used as the collective name
given to the processing cards, within the Nova73, which provide audio signal
processing such as equalization, dynamics and delay.

Dynamics Dynamics is the collective terms given to audio processing which responds to
changes in signal level. For example, a Compressor, Limiter, Gate or Expander.

EQ Equaliser.

An equaliser is a processor which changes the frequency characteristics of a
signal, for example to increase the amount of treble or bass components in the
signal.

Expander A dynamics processor used to magnify changes in the dynamic range of the input
signal. For example, to reduce noise in speech pauses. See also Compressor. 

Fader A potentiometer used to adjust the gain of a signal.

Filters Filters are equaliser sections which are used to cut out or reduce specific
frequency bands within the signal. For example, a Low Pass Filter cuts out high
frequencies so will result in less treble to the sound. A High Pass Filter cuts out
low frequencies, for example you can use this to remove unwanted low frequencies
like hum or rumble. A Band Pass Filter cuts out both high and low frequencies
allowing frequency components within the band to pass through the signal; for
example, you can use this type of filter to create a telephone effect on a normal
voice.

Gain Adjusting the gain of a signal results in a change in the perceived level or
amplitude. An increase in gain (positive values) results in amplification and a
reduction in gain (negative values) in attenuation.
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Gate A dynamics processor used to remove unwanted signals below a certain threshold
level. For example, if a gate is applied to a presenter’s microphone source, then
when they speak signal level exceeds the gate threshold and the gate opens, while
if they make a low level sound, like shuffling in their seat, the gate remains closed.
The result is that only the signal we want to hear is output from the source
channel!

GPI General Purpose Interface (IEEE488) is a standardised platform independent short-
range digital interface, to allow switching connections between broadcast
equipment from different manufacturers.

Headroom The amount of operating level which is in reserve between normal operating level
and 0dBFS.

High Pass Filter See Filters.

Insert Point A connection point within the source channel which interrupts the signal flow and
routes out to a piece of external equipment and returns back to the source
channel. 

Insert send = route out from the source channel to the external device.

Insert return = input to the source channel from the external device.

Limiter A dynamics processor used to stop signals exceeding a certain threshold level.
For example, you can place a limiter across the main output of the programme to
prevent a sudden increase in level exceeding the clipping point of your
transmission feed and causing signal distortion.

Low Pass Filter See Filters.

MADI Multi-channel Audio Interface; digital interface for combining audio signals of 56 or
64 channels.

Mix Minus Mix Minus, Clean Feed and N-1 are all terms used to describe a feed which is
created from a number of channels minus a particular channel or channels. For
example, to provide telephone hybrids with a feed of the programme minus the
incoming phone call.

Monitor Term used to describe the outputs and functionality of feeds to loudspeakers or
headphones for the purpose of listening to a mix.

ms milliseconds

Unit of time measurement.

M-S Middle and Side Stereo

Used to describe an arrangement of two coincident microphones, one pointing to
the front (Middle) and the other (bidirectional) at right angles providing a Side

signal. The mc2 consoles provide M-S to X-Y decoding to turn the Middle and Side
signal into normal Left and Right stereo. 

mxGUI Lawo’s control software for mc2 and Nova73 systems. The software runs GUI
displays from an external PC and can be used either online or offline.

Nova73 The heart of the mc2 system (includes the routing matrix, control system, I/O
modules and DSP). Can exist as a stand-alone routing matrix with networking
capabilities.

N-1 See Mix Minus.

On-Air Term used to indicate that a radio or TV programme is being broadcast.

Overload Occurs when the signal level is too large for the system, resulting in signal
distortion.
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Panning Used to control the left/right position of a mono source when routed to a stereo or
multi-channel output. For example, if a source is panned left, then you will all
signal from the source is routed to the left side of the summing bus. If a source is
panned centre, equal levels are applied to the left and right sides of the summing
bus, etc.

PFL Pre Fade Listen

Used to listen to signals before the application of fader level. Provides a way of
listening to a source when the fader is closed to check its signal before the fader is
opened to route it onto the programme output.

Phantom Power This is the power supply required when working with condenser microphones. The
console supplies 48V to the microphone via the audio connector.

Programme The main output of a live broadcast console. This is the mix which feeds the
transmission chain.

RAS Radio Automation System control protocol is Lawo’s universal protocol for
communication between a mixing console (MIXER) and a radio automation system
(RAS).

Ratio In the context of a compressor or expander, the ratio defines how much
compression or expansion is applied. For example, the higher the compressor
ratio, the more signal levels above the compressor threshold will be compressed.

Release Time In the context of dynamics processing (compressor, limiter, gate or expander), the
release time defines the time taken for the action of the processor to subside. For
example, when using a gate, a short release time will cause the gate to close
quickly after signal falls below the gate threshold.

Remote MNOPL The remote control protocol RemoteMNOPL is a LAN based client-server network
byte order protocol to enable third party systems to control Lawo’s digital mixing
consoles or standalone routers.

Roll-off Frequency See Shelving EQ.

Routing Signal Routing

Term used to describe the connection made between an input and output.

RS422 Type of serial interface used to communicate with external devices.

RU

Sample Rate The speed at which the internal processing of the system takes samples
respective to values from a continuous, analogue audio signal to make a discrete,
digital one. For example, when running at 48kHz, incoming analogue audio is
sampled at a rate of 48000 values per second.

Shelving EQ A shelving equaliser band is used to increase or decrease high or low frequency
components of a signal. The slope of the shelf defines how steeply the gain
increase/decrease is applied. The roll-off frequency defines the frequency at which
signal level is reduced by 3dB. 

Slope See Shelving EQ.

SMPTE Abbreviation for Society of Motion Picture and Television Engineers
Standardised protocol for the synchronisation of audio and video technology -
timecode.

SRC Sample Rate Converter.

Sum Summing Bus

The result of several audio signals mixed together within the console. 

Within mc2 consoles, the name given to the main output busses (programme
busses).
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Telephone Hybrid Device which deals with bi-directional signals to/from a 2-wire phone line. One line
provides an incoming feed from the phone line (e.g. the guests voice), and the other
sends signal back to the receiver (e.g. the mix minus feed).

Threshold In the context of dynamics processing (compressor, limiter, gate or expander), the
threshold defines the signal level at which the processor starts to act. For
example, the gate threshold sets the level at which the gate will open and then
close.
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